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Modular phones have been touted for ages, but what if you want to keep your iPhone? 
Nexpaq thinks it has the answer with its eponymously-named iPhone case, which lets you add 

different components depending on your needs. Currently there are 12 modules, including  
an SD card reader, extra battery power, storage expansion and even a breathalyser.  

You don’t need to restart your iPhone when you swap modules, and the case has 
a 1000mAh built-in battery to boost your iPhone and power all the modules.

 FROM £68  INCLUDES Nexpaq case (modules sold separately)   
 WEBSITE nexpaq.com  WORKS WITH iPhone 6s, 6s Plus, 6, 6 Plus

Nexpaq

 iOpener
Game-changing tech from the world of Apple and beyond

A modular expansion case for your iPhone
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 We all take pride in setting up 
our offices at home to make the 
perfect workspace, so why don’t 
we approach our desktops with 
the same gusto? Perhaps those 
customisations are considered 
too time-consuming or difficult 
to achieve. Well, help is at hand 
with our complete guide to OS X 
tweaks on page 30. There you’ll 
find dozens of tips for creating 
a great work environment and 

mastering useful shortcuts that will genuinely change the 
way you use your Mac.

This issue’s Apple Home will be music to your ears if 
you’ve been thinking about upgrading to a system like 
Sonos (which is now certified for Apple Music). Multiroom 
wireless audio is now established tech, and we show you how 
to get the right setup and what to invest your cash in.

If you’ve recently got a new iOS device, we’ll show you how 
to get off to the best start with our pick of the very best free 
apps for iPhone, iPod, iPad and Apple Watch – see page 82.

We hope you’re enjoying our new-look magazine, and 
we always look forward to your feedback. Themes that crop 
up time and time again are iCloud and iWork. This month we 
take a look at Family Sharing and version tracking of iWork 
documents on iOS – we know you’ll find this advice useful.

Finally, if iPhone battery life still grates with you, see 
page 95 for our head-to-head test of Mophie’s battery pack 
and the official iPhone 6s Smart Battery Case from Apple.
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EDITOR

editor@macformat.com

Alan Stonebridge
Production Editor 
 Alan has been busy making 

ringtones of dialogue from 
LucasArts’ classic Day of the 
Tentacle in anticipation of its 
March remastered release.

Alex Blake
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 Never mind that! Firewatch 

is the thing that’s got Alex’s 
pulse racing. Its February 
release is just around the 
corner.*heavy breathing*

Paul Blachford
Managing Art Editor 
 Having just survived 

an evening with broken 
broadband, Paul feels ready 
for anything the world can 
throw at him... maybe.

Seth Singh
Digital Art Editor 
 Seth is looking forward to 

it snowing at last, so he can 
break out his battery-heated 
gloves ready for some 
ferocious snowball fighting.
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and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

EDITED BY CHRISTIAN HALL 

APPLE RUMOUR

 Rumours over the absence of a physical 
headphone port on the next iPhone just won’t 
go away. Numerous reports point to Apple’s first 
ever mobile device without a headphone jack, 
in favour of Bluetooth connectivity, of course. 
It makes a lot of sense in an increasingly wireless 
world, and Apple’s EarPods desperately need an 
update (perhaps being bundled as a Lightning-
only version), but it won’t be enough to get us 
queueing outside an Apple Store.

For the first time in the iPhone’s history, 
sales have started to decline. Cupertino needs  
to pull out a few rabbits if it is to reverse that 
emerging trend. With its release pegged for the 
usual September slot, where will the iPhone 7 
really take the smartphone market? 

It’s highly likely the next iPhone will reverse 
the weight and width gain from the 6s (to make 
room for 3D Touch) and give us an even better 
camera and processor. Let’s take a closer look…
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LI-FI TECHNOLOGY 
 Highly unlikely for the next 

iPhones, but Apple looks 
to be exploring Li-Fi, a new 
tech that uses LED flashes 
to transmit data up to 100 
times faster than Wi-Fi.

DUAL iSIGHT CAMERA
 The ‘Plus’ iPhone always 

gets extra camera goodies, 
and the 7 Plus could get dual 
iSight cams for better zoom 
and a wider view.

1

A CENTRED CAMERA
 This is unlikely as Apple  
has ridgidly stuck to its  

left-hand placement of the 
rear camera and flash,  
but many people prefer 
a centred one. Expect a 
sensor resolution bump 

to 14MP, though. 

2

EVEN THINNER 
PROFILE

 We could see the iPhone go 
as thin as 6.1mm (perhaps 
6.5mm on the 7 Plus) due 
to a strengthened frame 

made from new compound 
materials that improve upon 

traditional aluminium.

3

EDGE-TO-EDGE 
SCREEN

 Additional screen space 
could be gained by a 

fractional widening of the 
exisiting Retina display. 

It may also be part of the 
water-resistant casing that’s 

been widely rumoured.

4

WIRELESS EARPODS
 We’re most likely to 

see Lightning-enabled 
EarPods in the box, but as 
an upgrade Apple is odds 
on to offer Bluetooth buds 
like these. Either way, say 

goodbye to the 3.5mm 
headphone jack of old!

THE POLL

 Hot on the heels of the 
tech giant’s latest moves…

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

WE ASKED… Which Apple 
product are you most 
looking forward to in 2016?

2

3

4

38%

37%

14%

9%

AIR 3 : SOUND 4
 The upcoming iPad Air 3 

may have the same four-
speaker audio found in the 
iPad Pro, according to a 
leaked Air 3 schematic.



CLASSIC 
APPLE
FACTS

APPLE CORE Apple News

A
mid all the headlines about Apple’s 
faltering performance after its 
recent earnings call, Tim Cook 

commented on a hot tech topic of 2016, 
from which the company is largely absent.

Asked if he considers virtual reality to be 
a geeky niche, or if the technology is ready to 
go mainstream, he responded: “No, I don’t 
think it’s a niche. It’s really cool and has some 
interesting applications.”

Of course, it’s too early to say that Apple is 
about to drop everything and spend billions 
on entering the VR market. But it’s the latest 
in a string of events that show the firm’s 
interest in virtual reality is expanding.

 In 2010, Apple 
surpassed Microsoft 
to become the most 
valuable technology 

company in the 
world. At that time, 

Microsoft was valued 
at $219.18 billion. 

In August 2011, Apple 
pushed past Exxon as 

the most valuable public 
company in the world.

APPLE’S 
VALUE WHEN IT 

BECAME NO.1

THE FOOTPRINT 
OF APPLE’S 

LARGEST STORE

THE ORIGINAL 
CODENAME FOR 

THE iPHONE

In 2015, it released 360° videos for U2, 
Muse, and The Weeknd. In January, it hired 
VR expert Doug Bowman, and it recently 
acquired a number of companies involved 
in VR research, covering areas such as facial 
recognition and augmented reality software.

The Cupertino-based company has also 
registered a couple of VR headset patents – 
though that’s no guarantee they’ll become 
a reality. Apple’s interest in VR is palpable. 
We’ll just have to see where it goes next.

W
e knew the iPad Pro was supposed 
to rival some desktops in terms of 
processing power, but now we 

have the in-depth real world tests to prove 
it – and the iPad Pro is certainly living up 
to its much-touted professional credentials.

In late January, tech testers AnandTech 
published a performance comparision 
between the iPad Pro’s dual-core A9X and 
Intel’s Core M line in various devices, such as 
the 12-inch MacBook’s low-end Core M and 
the higher ‘m3’ chip in an ASUS ZenBook.

What resulted was a resounding success 
for Apple’s custom ARM chips as the A9X 
matched, or even beat, the MacBook and 

ZenBook under various tests. “Apple still 
has a way to go”, says the report, but “it’s 
significant progress in a short period of time”. 
With all fingers pointing to Apple going it 
alone in processor tech, Intel bosses will be 
looking over their shoulders.

ARM-based Macs are surely an 
inevitability now, perhaps as little as two 
years away for low-end mobile models. That 
would mean Apple could finally break with 
the Intel-tied release cycle and create a Mac 
line that works better for Cupertino’s long-
term strategy. For more on Apple’s processor 
plans turn to page 14 for this month’s 
MacFormat Investigates…

 Situated inside Grand 
Central Terminal in 

Manhattan, the store 
opened in 2011, has 

two Genius Bars, and 
is passed by 750,000 

people per day.

 Apple started work on 
the mysterious M68 in 
2004. Former iOS chief 
Scott Forstall suggested 
the internal codename 

was simply ‘Purple’.

23,000 
SQUARE 

FEET

M68

$222.12 
BILLION

Several companies have virtual and 
augmented reality products on the way, 
including the Oculus Rift headset (pictured).

10 | MACFORMAT | MARCH 2016  macformat.com  @macformat

Revealed!  
The true 
power of  
the iPad Pro

Tim Cook 
opines on  
virtual reality

iPad sales might be falling again, but the A9X shows its true colours

Comment from Apple’s CEO 
suggests interest in VR tech



Apps & Games APPLE CORE

INTERACT
£3.99 

 The inability to 
organise contacts 
in iOS’s eponymous 

app bugs us. You can do it 
with this app though, and the 
groups you make here show 
up in Contacts. Interact does 
more than that; for example, 
it can pick details out of plain 
text to set up a new contact.
Why you need it: To focus 
your contact management.
What’s it best for: Sending 
group emails to contacts.

THE WESTPORT 
INDEPENDENT £3.99 

 This is a game 
about censorship, 
corruption and 

newspapers. Can you find the 
right balance between free 
speech and towing the new 
Loyalist Party line? Assign 
articles, edit the headlines 
and see how well your paper 
fares in a post-war world. 
Why you need it: A unique 
take on the strategy genre.
What’s it best for: Those who 
like adventure and tactics.

THE TRAVELLER 
(BAABA MAAL)

 The Traveller is the 
first studio album to 
come from world 

music pioneer Baaba Maal for 
seven years. There’s a distinct 
electronic vibe this time 
around, and Maal skilfully 
manages to weave a variety 
of musical styles into these 
accessible and timeless tunes.  
Why you need it: Just right 
for a Monday pick-me-up!
What’s it best for: Pulling in 
lots of different genres.

 As a Mac user you’ll know it’s 
the little things that can annoy 
the most. It’s a waste of time 
having to open up an app just to 

create a new document for example, so this 
tool gives you those options in Finder’s 
contextual menu instead.

New File Menu is implemented as a 
Finder extension (just turn it on in System 
Preferences), and every time you call upon 

[ M O V I E ]

THE MARTIAN 
£9.99
 Astronaut Mark 

Watney (Matt Damon) 
gets left behind on a 
mission to Mars. On a 
planet where nothing 
grows, can he survive?

[ A P P ]

500px FREE
 We like this because 

rather than being about 
viewing your photos, 
it lets you scour a 
themed online archive 
for matching images to 
view on your HDTV.

[ G A M E ]

SKY FORCE 
ANNIVERSARY 
£3.99
 An old-school scrolling 

shooter that’s ideal for 
the Siri Remote, with 
gorgeous graphics and 
excellent co-op play.

Finder’s contextual menu you’ll be able to 
make new files for various apps, including 
Apple’s iWork suite and Microsoft Office.

Custom templates are also supported, so 
you don’t just end up with a blank document. 
You could set up a letter template in Pages or 
Word and create files based on it from Finder. 
You can choose to open a newly created file 
automatically by enabling ‘Open file on 
creation finish’ in the extension’s preferences.
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New File Menu £1.49

APPLE 
TV
 Our top picks 

of what’s worth 
watching and 
playing this month

[ M A C  A P P ]

[ i O S  A P P ] [ A P P L E  M U S I C ][ i O S  G A M E ]

Quickly create new files from Finder’s contextual menu

APP OF THE MONTH



When Steve Jobs unveiled the original iMac in 1998 
he knew it was a very special product, but just how 
successful has it been over the last two decades?

APPLE CORE Facts & Figures

 macformat.com  @macformat

 1998’s original iMac weighed 
38.1 pounds (18.1kg), mainly  
because of its hefty CRT screen. 
Today’s 27-inch Retina display 
models weigh 9.54kg, 
so two original iMacs 
weigh just a kilogram 
more than one of today’s 
high-end powerhouse!
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The iMac

1

5

IN NUMBERS
 Apple’s bounceback profit was 

largely attributed to strong iMac 
sales. Steve Jobs completely 
turned Apple around in 1998 
following a whopping $878 
million loss in 1997 – ouch!

 The number of iMacs 
sold by Apple from 1998 
to 2004. After that, Apple 
merged iMac sales into 
‘Desktop’ alongside Mac Pros 
and Power Macs. iMac sales by 
2015 would be somewhere in the 
region of 50 million.

8,702,000 units

of the iMac to date

18 months

$414 million

 If you take all the off-the-shelf iMac 
configurations, you’ll find that Apple 

has now produced a century of 
iMacs. The top-end variant of 

Apple’s latest – the Late 2015 
update to the 5K Retina 

display model – became  
the 100th in the iMac family.

18.1 kilograms

100 models 

NEXT ISSUE  Find out some of the truly staggering facts 
charting the incredible rise of the App Store

4

2

3

 That’s the time it took Apple to 
perfect the patterns for the rather 

odd Blue Dalmatian and Flower 
Power models. The patterns 
were molded into the casings 
and hit the shops in 2001.
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APPLE CORE News Feature
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As they say, good things come in small packages

Cash in the chips: 
Apple’s processor plans

INVESTIGATES

One of the focusses of the A9 chip 
was a reduction in power wastage.

s we make our way into another 
new year, that can only mean 
one thing – the Apple rumours 
are flying. Everyone loves to 

speculate on what the world’s most profitable 
company may bring to the table next, but one 
area has really caught our eye: its processors.

They are what helps define every iPhone. 
Make the chip smaller and you get a thinner 
device. Make it more powerful and the iPhone 
pulls even further ahead of its rivals. So with 
that in mind, we decided to take a peep under 
the hood and examine what Apple may bring 
to the A10 processor.

Unlikely friends
Despite their bitter rivalry in the smartphone 
arena, Apple and Samsung are actually rather 
snug once you start talking components – 
Samsung is estimated to manufacture around 
60–70% of the A9 chips used in the iPhone 6s. 
However, rumours are afoot that Apple will 
switch entirely to its other chip manufacturer, 
TSMC, with the A10.

That decision probably isn’t motivated – 
at least not primarily – by a desire to undercut 
Samsung. Instead, it’s all about the tech 
inside; TSMC has developed a technology 
called integrated fan-out (InFO) packaging, 
which allows chips to be mounted directly 
on top of each other, without requiring a 
substrate. This takes up less space than the 

A9 chip, and so could lead to a thinner and 
lighter iPhone – the perpetual Apple dream.

Commenting on this possibility, analyst 
Bonil Koo explained: “With [TSMC’s] InFO 
technology, we expect Apple would benefit 
from better performance with smaller form 
factors. If so, we think [Samsung] would lose 
the IC [integrated circuit] substrates business 
for which it has been one of the suppliers, as 
InFO would not need IC substrates”.

However, market analysts KGI Securities 
see it differently – very differently. While 
it predicts that TSMC will indeed take over 
the production of the A10 chip for the next 
iPhone, it also argues that the A10X chip – for 
the next generation of iPads – will be solely 
manufactured by Samsung in a 10nm format 
(far smaller than the 16nm of the A9X).

Better together
Much has been made of Intel’s possible entry 
into Apple’s chip making plans. It already 
has 1,000 people working on getting its 7360 
LTE modem chip into the iPhone 7, according 
to VentureBeat, and may look to work with 
Apple on its iPhone processor as well.

Intel would make a ‘system-on-a-chip’ 
(SoC) A10, with all the components being 
bundled into a single package. The end result 
would be a thinner processor, and thus a 
thinner iPhone, as well as better power 
management and improved speed.

A

WRITTEN BY ALEX BLAKE 

Rumours are 
afoot that Apple 

will ditch 
Samsung as its 
key chip maker

For our latest 
subscription offer 

see page 46!
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One reason for Apple opting for an Intel-
made chip is that Intel is reportedly also 
developing a 10-nanometer manufacturing 
process, which would produce smaller and 
faster chips. Although the process is not yet 
ready for the big stage, reports indicate it 
could be within two years.

However, TSMC has also 
reported that it will start unveiling 
its own products based on a 10nm 
process within the next few months, 
and that it will switch to 7nm by  
2018 and a minute 5nm by 2020.  
If it is able to bring this plan to 
fruition, Intel will have a real fight 
on its hands.

Core customer
A perennial complaint of non-iPhone 
users is that Apple’s devices are 
chronically underpowered for their 
price. But as any iPhone user will 
tell you – and as real-world tests 
have proved – the iPhone repeatedly 
outperforms its rivals thanks to its 
far more efficient software.

Rumour has it, though, that the 
iPhone 7 will come bestowed with 
a six-core processor that will see it 
obliterate the competition. Backed by 
iOS, it would surely wipe the floor 
with any and all challengers.

However, renowned market analyst 
Ben Bajarin has urged caution on this 
front, pointing out that the extra cores are 
likely “needless” in such an efficient device. 
Apple would be better advised to focus on 
GPU improvements, he added.

Novel graphics
Speaking of graphics, there have also been 
developments in that area. Apple licenses its 
GPU architecture from PowerVR Multimedia, 
and CES 2016 saw the latter announce its 
new Series 7XT Plus model. This will feature 
a separate processing unit called the Image 
Processing Data Master, which can run 2D 
graphics at very low power, so theoretically 
this GPU will be able to handle much of iOS’s 
graphical output while using minimal power. 

That means better efficiency from iPhone 
GPUs going forward.

The A9 chip in the iPhone 6s saw a major 
breakthrough in that it was a FinFET chip, 
which helps minimise wasted power (this 
usually rises as chips get smaller). Less 
wasted power means higher achievable clock 
speeds, a large hurdle that Apple struggled 
to overcome with the A7 and A8 chips. That 
has obvious implications for both processing 
power and graphical output, and there are 
hopes that the A10 can achieve a performance 
improvement similar to that witnessed with 
the A9, used in the latest iPhone.

That all suggests 2016 could be a year to 
remember for the A10, where Apple raises 
the bar once again and strides ahead of its 
smartphone and tablet rivals.

With parts shrinking, 
and with the headphone 
jack likely to disappear, 
Apple may well make 
the iPhone even thinner.

A new GPU 
design would  

save power 
when drawing 

2D graphics



And I like it. But I read it as a warning.
More than its predecessors, Shooty Skies is a proper game. 

If you grew up on Xevious, Raiden, Mars Rising or Espgaluda, 
you’ll beat the casual crowd’s high scores. More than a proper 
game, though, it’s a satire. You’re attacked by smartphones, 
lolcats, arcade machines, TVs spewing gouts of static, toasters 
firing pop tarts, and cash tills scattering change. A bald eagle 
labelled ‘FREEDOM’ in red, white and blue rains down cars, 
hamburgers and guided missiles. 

At the end of Antonioni’s Zabriskie Point, the protagonist, 
Daria, watches a desert villa explode, propelling clothes and 
consumer goods into a slow-motion sky. It’s all in her mind, 
a metaphor for her alienation from a destructive society.

Invited into the house, Daria chooses to leave. Shooty Skies 
chooses to stay. It’s a parody of trivial, gaudy freemium games 
in the form of a trivial, gaudy freemium game. It mocks the 

proliferation of distractions 
that demand your money and 
waste your time, and then it 
incentivises you to come back 
every day, offers characters 
for cash, and charges you for 
weapons in currency earned 
by you watching ads for other 
freemium games.

Shooty Skies’ developers 
know exactly what they’re doing – on several levels. At GDC 
2015 in San Francisco, they explained they’d set out to subvert 
the freemium model by creating a free-to-play game that was 
mainly about the gameplay, not manipulating you into in-app 
purchases, like Candy Crush Saga. It worked a treat.  

  This month I’ve mainly been 
playing Shooty Skies, a shooter 
from the creators of Crossy 
Road, the voxellated Frogger 
clone inspired by primitivist 
succès de scandale Flappy Bird.

ADAM BANKS…

APPLE CORE Opinion

Crossy Road took 
$10 million in its 
first three months. 
That’s remarkable 
and well-deserved, 
but Candy Crush 
Saga has made a 
million in a day.

With that kind 
of money regularly 
changing hands, 
nobody’s going to 
be kidding around. 
The techniques that keep players tapping Buy 
are just as sophisticated as those in any Vegas 
casino. And as in a casino, the house always 
wins, by which I don’t mean the app studios, 
which are not guaranteed a return.

No, the winner here is Apple, with 30% of 
every purchase. Ever since Steve Jobs invited 
Zynga’s Mark Pincus to the stage at WWDC 
2010, giving his seal of approval to practices 
Pincus had alsummarised as “[doing] every 
horrible thing in the book just to get  
revenues”, Apple and freemium have been 
uncomfortable bedfellows. The incongruity 
only grows as Tim Cook tries to position 
Apple as one of Silicon Valley’s most ethical.

Since it’s marketed as an ‘endless arcade 
flyer’, Shooty Skies doesn’t have a final boss. 
I like to think it would be a giant apple; the 
only character that’s not blocky, but mirror-
smooth. Instead of bullets, it would shower 
you with feel-good vibes. Then it would 
deplete half your coins, and you would smile, 
understanding, somehow, that this is good.

GOING DEEPER THAN  
A FORCE CLICK WITH  
MUSINGS ON THE  
WORLD OF APPLE
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ABOUT ADAM BANKS
 Adam is Apple to the core, having 

reported on the world of Macs since the 
1990s. As a writer, designer, art director 
and print production contractor, he 
divides his time between the Northern 
Powerhouse and the Creative Cloud.

The incongruity 
only grows as Cook 
tries to position 
Apple as ethical
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APPLE
IN QUOTES

DIETER ZETSCHE
daimler.com

“These companies 
can do more… than 
we had previously 

assumed.”
Daimler CEO comments  
on Apple Car progress

TIM COOK
apple.com

“It’s really cool  
and has some 

interesting 
applications.”

The Apple chief talks VR

JOHN GRUBER
daringfireball.net

“I don’t see how 
curved glass fits 

with the iPhone 5 
industrial design.”

iPhone 5se won’t be 
curved, says Apple blogger

TOM CHESHIRE
sky.com

“…sooner or later, 
Apple will make 

its bet. And it will 
be a big one.”

Sky tech reporter thinks 
Apple will soon spend big

ANGELA 
AHRENDTS

apple.com

“I see them as 
executives in 

the company.”
Apple exec on retail staff

 The MacFormat team debates the hot Apple  
issues of the day, using their iPhones of course!

“WHAT FEATURES DO 
YOU EXPECT TO SEE 
IN THE iPAD AIR 3?”

NEXT ISSUE  Does the Mac App Store have a future?

SPLIT VIEW

I’m curious which way Apple will go with 
the Air 3’s screen tech – 3D Touch or 
support for Apple Pencil, assuming it 
hasn’t worked out a way to add both.

I’ve seen talk of the display being boosted to 4K, but 
I doubt that’ll happen. At least to my eyes        the Air 2’s 
264ppi screen is fine, and I think such an incredibly high 
resolution would be a waste on a 9.7-inch screen.

What impresses me about the iPad Pro is its stereo sound. 
It’s painfully obvious that sound comes out of an Air 2 
from one side only, and I’d really rather not have to wear 
headphones when watching videos.

Definitely. Increasing the RAM would also be a waste given 
how efficient iOS is on the Air 2. I mean, my iPad sometimes 
refreshes when switching apps, but it’s a minor thing.

I’d like to be able to use the 3D Touch shortcuts        from 
my iPhone 6s Plus, but it’d be good to make use of Pencil’s 
creative potential without needing the largest iPad.

Yeah, that would be great for some of my games, too. 
I’d rather the Air 3 had better speakers than just got 
thinner and lighter again,        and I wouldn’t mind getting 
more than 16GB of storage for £400.

Alan says…

Alex says…

Alex hopes the 
base model has 
more than 16GB 
of storage!

Alan’s ears 
are aching for 
better speakers 
in the Air 3.

Turn to page 46
*INCLUDES PRINT AND  

DIGITAL EDITIONS

SUBSCRIBE 
TODAY! 

3 ISSUES  
FOR £5! *
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“What’s your favourite colour”

My favourite colour is... well, I don’t know 
how to say it in your language. It’s sort of 
greenish, but with more dimensions.

Siri...ously? tap to edit
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PRIZES 
WORTH 

AROUND 
£250!

Win an Apple TV bundle
Get Apple’s latest streaming box and two fantastic game 
controllers for the ultimate home entertainment setup

 Apple recently updated the Apple TV, 
so what better time to upgrade your 
living room? But there’s no need to buy 
one – we’re giving one away for free! 
You can win the capacious 64GB model, 
with plenty of space for your films.

The new model comes with tvOS, 
which enables third-party apps to run 
on the little black box. It also includes 
the brand-new Siri Remote, which 
features a trackpad, motion sensors 
and a microphone, enabling you to use 
your voice to navigate the iTunes Store, 
open apps, or find something to watch.

You can take your Apple TV games 
to the next level with two SteelSeries 
Nimbus controllers. Certified for use 
with Apple TV and kitted out with 
a menu button for speedy navigation, 
a Lightning port for quick charging and 
a beefy rechargeable battery, we called 
the Nimbus “the ultimate expression of 
Apple’s game controller vision” in our 
review back in MF295. Its build quality 
is superb, with sturdy thumbsticks 
and buttons, and no sign of the telltale 
creaking you get on cheaper devices. 
It’s the controller to rule them all.

 THE QUESTION
For your chance to win this exciting 
Apple TV and Nimbus controller bundle 
from SteelSeries, just answer the 
following question:

The new Apple TV comes packaged 
with which remote?
A) Handoff Remote
B) Siri Remote
C) AirDrop Remote

For more details about SteelSeries 
products, visit steelseries.com.

 To enter, you can visit our website at futurecomps.co.uk/nimbus. 
  For full terms and conditions, go to futurecomps.co.uk/nimbus. By sending your entry, you 
agree to these competition rules and confirm you are happy to receive details of future offers 
and promotions from Future Publishing Limited and carefully selected third parties. 
 This competition closes on 14 March 2016. Over 18, GB residents only.

HOW TO
ENTER...

In association with
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he huge success of the 
iPod gave rise to a new 
generation of compact 
speakers that found a 

home not just in the living room, 
but also in the kitchen, bedroom 
and even out in the garden.

The arrival of the iPhone 
added Bluetooth wireless 
streaming, but your music 
was still stuck in one room 
at a time. Then Sonos came 
up with the bright idea of 
using Wi-Fi technology, rather 
than short-range Bluetooth, to 
connect multiple speakers to your 
home network, and the modern 
multiroom audio system was born. 
The first multiroom speakers were 
very expensive, but the latest models are 
now only slightly more costly than their 
Bluetooth counterparts. So here’s our guide 
to some of the best multiroom speaker 
systems currently available. 

In many ways the concept 
of the ‘Apple home’ started 
with the very first iPod, 
the tiny little device 
that could put 
a thousand songs 
in your pocket 

T

They might be small in profile, but good multiroom 
systems needn’t be small in sound. Sonos and other 
leading brands are regarded as serious hi-fi.

The smart home is 
here – live the Apple 

dream today!

NEW 
SECTION!



Music has long driven Apple tech, and now 
multiroom sound makes more of your tunes

The greater bandwidth 
of Wi-Fi provides much 
better audio quality 
than Bluetooth does

 GET STARTED WITH…

 MULTIROOM
         WIRELESS   
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Bluetooth  
or Wi-Fi?

 Most multiroom 
speakers are equipped 

with both Bluetooth 
and Wi-Fi abilities.
Bluetooth is really 
handy for quickly 

linking two devices 
together, such as your 

iPhone and a single 
speaker system, but 
the Bluetooth signal 

has limited range and 
is unlikely to penetrate 
walls between rooms, 

or to reach an upstairs 
bedroom. Wi-Fi has 

much greater range 
and speed, allowing 

you to stream music 
to multiple speakers 

in any room.

What about 
AirPlay?

 Apple charges 
manufacturers to 

use AirPlay in their 
speakers, and out 
of the multiroom 
systems we look 
at here, only the 

high-end Sonos Play:5 
currently works with 
Apple’s proprietary 

wireless system.

luetooth has its limitations, 
both in terms of range and 
audio quality, and the need to 
‘pair’ your Mac or iOS devices 

with individual speakers means that your 
music is still stuck in one room at a time – 
unless you physically pick up the speaker 
and carry it to another room with you.

The next step, therefore, is the addition 
of Wi-Fi connectivity, which allows you to 
connect multiple speakers to your home 
network. This means that you can stream 
music to any room in your home – or even to 
several rooms all at once. The greater speed 
and bandwidth of Wi-Fi also provides much 
better audio quality, as well as the ability 
to connect to online music services such as 
Spotify (and potentially Apple Music – but 
we’ll come to that later).

Sound advice
Before we get into Wi-Fi and other technical 
details, it’s important to remember that 
sound quality is still the most important 
aspect of any music system. 

The speakers that we look at here range 
from £100 to about £400, and the good 
news is that there’s not a single dud among 
them. Of course, you can’t really expect 
the little Philips Izzy costing just £100 to 
compete with more powerful rivals such as 
the Samsung R6 or the Sonos Play:5, which 
cost three or four times as much. Even so, 
the little Izzy is still fine if you want a bit of 
background music, and you can buy two or 
three to use in different rooms for the price 
of a single R6 or Play:5. The same applies 

to Pure’s Jongo T4X, which is slightly more 
expensive, but which provides a hefty 50W 
output and quite respectable bass.

The Samsung R6 and Bose SoundTouch 
20 are good mid-range options, costing 
£300–£350 each. Each speaker is capable 
of producing a clear, detailed sound, along 
with room-filling volume. Not surprisingly, 
though, it’s the new top-of-the-range Sonos 
Play:5 that wins on all-round sound quality, 
courtesy of six finely tuned drivers that 
ensure great balance across the spectrum. 

B

APPLE HOME Multiroom audio



iFacts…

32
 The maximum number  
of Sonos speakers that  

you can group together.

10,000,000
 The number of paying 

Apple Music subscribers. 

1,411.2Kbps
 The data transfer rate 
required by audio CDs. 

1.3Gbps 
 The theoretical maximum 
speed of Apple’s 802.11ac 

AirPort Extreme router.

Explained
POWERLINE

 Many people find that there 
are deadspots in their home 
that their Wi-Fi network can’t 

reach. Powerline network 
adaptors can help here, 

allowing you to transmit data 
via a mains power socket 
in any room. You can get 
Powerline adaptors that 
use either Ethernet for a 

wired connection, or range 
extenders that help to give 
your Wi-Fi signal a boost.

 AUDIO

 macformat.com  @macformat

Multiroom audio APPLE HOME
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What about  
my Mac?

 Most of these systems 
revolve around their iOS 

apps, but many people 
use a Mac to play music 
at home too. Bose and 

Sonos both provide 
good apps for the Mac, 

although Samsung 
fumbles with a clunky 

Mac app that has to 
be controlled from an 
iOS device. Pure and 
Philips sidestep this 
problem altogether, 

allowing you to stream 
music from a Mac to 
the nearest speaker 

via Bluetooth and then 
use Wi-Fi to stream 

the music to speakers 
in other rooms.

Adding Wi-Fi?
 You don’t always 
need to buy new 

speakers to create 
a multiroom setup. 

Google’s Chromecast 
Audio adaptor can add 

Wi-Fi to existing speaker 
systems for just £30. 

There’s a slightly more 
expensive alternative 

called Gramofon 
(gramofon.com) which 

costs about £45, but 
that also has Ethernet.

Apps allow you to 
group together multiple 
speakers in different 
rooms in your home

Unlike traditional shelf or free-standing speakers, 
systems like Denon’s Heos don’t need to be in ‘pairs’.

 macformat.com  @macformat

Philips’ Izzy uses Bluetooth to 
stream audio, so it works with 
iOS devices back to the iPhone 3G.

Bose’s SoundTouch 20 Series III can 
even receive Apple Lossless audio, 
and it has a built-in OLED display.

Pure’s Connect app works with MP3, 
AAC, WMA and RealAudio streams, and 
it provides bass and treble control.

APPLE HOME Multiroom audio
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The inclusion of Wi-Fi in these multiroom 
speaker systems has several advantages 
over a conventional Bluetooth speaker. 
The Wi-Fi signal has a much longer range 
than Bluetooth, so you can stream music 
from your Mac or iOS devices to speakers 
all around your home. 

The apps that come with these speakers 
allow you to group together multiple 
speakers in different rooms in your home, 
which is ideal if you’re having a party and 
want to play the same music in different 
rooms. Alternatively, you can stream 
different music to individual speakers, 
perhaps playing dance music downstairs at 
a party, and more chilled-out tunes upstairs. 
The Bose SoundTouch app works particularly 
well when grouping different speakers 
together, with options such as separate 
volume controls for individual speakers, or 
a master control that adjusts the volume for 
every speaker in a group.

These apps can also use your home 
network to connect to the internet, allowing 
them to plug into popular music streaming 
services such as Spotify, as well as a huge 
selection of internet radio stations. Pure’s 
Connect app even links to a good selection 
of podcasts too.

Stuck in the middle
However, reliance on speaker manufacturers’ 
apps can also be a weakness. Despite their 
many advanced features, the iOS apps used 
by the Samsung and Sonos speakers often 
feel a bit rough around the edges. The Mac 
version of the Samsung app also proved 
particularly clumsy, and makes it difficult to 
play music stored on a Mac – hardly ideal! 

Also, none of these apps currently supports 
the Apple Music subscription service either, 
although Sonos is currently testing Apple 
Music on a new beta version of its Controller 
app, which it hopes to release early in 2016 
(we look at a possible workaround for using 
Apple Music on some of these speakers on 
p27). If you subscribe to the Apple Music 
service, or you like listening to music 
broadcasts from other apps, such as iPlayer 
Radio, make sure that you check carefully 
which speakers include support for those 
options before buying.

Finally, we tip our hat to the Philips Izzy, 
the least expensive option in our selection. 
It somehow manages to do without an app 
altogether and magically boils down the 
entire process of grouping speakers and 
streaming music to just two little buttons.



Our best buys in multiroom sound systems 

Multiroom audio APPLE HOME
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FIVE OF THE BEST

Bose SoundTouch 
20 Series III £350
bose.co.uk
 This compact speaker 

still manages to produce 

a big, room-filling sound. 

It features Bluetooth and 

Wi-Fi streaming, so you 

can play music from 

most apps and services. 

The Mac version of the 

SoundTouch app works 

well too, and there’s even 

a 30-day free trial.

Philips Izzy 
£100
philips.co.uk
 Izzy’s sound quality is 

respectable rather than 

impressive, but if you 

want to buy several 

speakers for different 

rooms then it’s the most 

affordable option for 

now. It’s also the easiest 

to set up and use, thanks 

to its simple two-button 

control panel.

Pure Jongo T4X
£150
pure.com
 Pure’s ‘caskeid’ audio 

syncing system, which 

combines Bluetooth and 

Wi-Fi, is a little confusing 

to set up, but it works well 

and allows the speakers 

to play a wide range of 

music services – including 

Apple Music. Its 50W 

output isn’t subtle, but 

it’s sufficiently loud.

Samsung 
Wireless Audio 
R6 £329
samsung.com/uk
 This space-pod design 

sounds just as good as it 

looks, producing 360° 

audio. It’s also portable, 

with six hours of battery 

life. The iOS app works 

well, but there’s no 

support for Apple Music, 

and the Mac version is 

pretty poor.

Sonos Play:5
£429
sonos.com
 It’s expensive, but the 

Play:5 sounds great, and 

it can even scan the room 

you’re in and adjust its 

sound to match the 

acoustics. Sonos is 

working to add support 

for Apple Music soon, and 

there’s a 100-day return 

policy if you decide you 

don’t like the kit.

These apps can also use your 
home network to connect to 
popular music streaming 
services such as Spotify



 HOW TO Group multiroom speakers 

1 Getting started
With the exception of the Philips Izzy, all 

these speakers use an app on your iOS device 
to set up and connect to your home network. 
Here we’re using the Sonos Controller app to 
set up the Play:5 in our living room.

2 Wireless setup
The app automatically detects the Wi-Fi 

signal from the Play:5, which allows you to 
connect your iOS device directly to the 
speaker. The app then locates your network 
and asks for the password to connect to it.

Genius Tip!
 Don’t forget that  
most multiroom 
speakers have a 

Bluetooth option, 
which means that 
you can connect 

them to an Apple TV 
in order to boost the 

sound for films and 
TV programmes.

Explained
WIRED FOR SOUND

 Wi-Fi networks sometimes 
struggle to penetrate walls and 

other barriers, so some multiroom 
speakers, such as the Bose and 
Sonos models, also include an 

Ethernet interface that will allow 
you to create a wired connection 
in rooms that Wi-Fi can’t reach.

1

TWO BY TWO
 As well as grouping speakers in 

different rooms, most multiroom 
audio systems also allow you to pair 
two units together so that you can 

get old-fashioned, two-channel stereo 
output from two speakers that are 

physically separate from each other.

2

MIX AND MATCH
 You don’t have to use identical 

speakers in your multiroom audio 
system either. You can use a 

larger speaker to pump up the 
volume in your living room, and 

a smaller, less expensive speaker 
in a kitchen or bedroom – as 

long as they’re from the same 
manufacturer that is.

The Wi-Fi signal has a much longer 
range than Bluetooth, so you can 
stream music from your Mac or iOS 
devices to speakers around your home

1

2

APPLE HOME Multiroom audio
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3 Room to room
We’ve put the powerful Play:5 in our living 

room, so next we’ll set up one of the smaller 
Play:1 speakers in our kitchen. The app already 
knows our Wi-Fi password, so all we have to do 
is tell it where the Play:1 will be used.

4 Right Said Fred
The app allows you to stream different 

songs to each speaker, but you can also group 
speakers together so that they play the same 
music in every room. Just tap the Group 
button next to each speaker to link them.

Jargon Buster
 Dual-band Wi-Fi 

routers such as Apple’s 
AirPort range can 
transmit on the 2.4GHz 
and 5GHz frequencies. 
The 2.4GHz signal has 
greater range but is 
more susceptible to 
interference, such as 
microwave ovens. Check 
to see which speakers 
also connect at 5GHz.

When you use Bluetooth to connect to a single, 
speaker, that connection allows you to stream 
audio from most apps, including Apple Music  
and rival services such as Spotify and Deezer

Sonos will be the first 
company to add support for 
Apple Music to its multiroom 
speakers, early in 2016.

 WHAT OTHER THINGS 
SHOULD I CONSIDER?

APPLE MUSIC

Multiroom audio APPLE HOME
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nfortunately, the Wi-Fi 
connections used by 
multiroom speakers are 
a bit more complicated 

than the well established wireless 
standard of Bluetooth audio.  
The Wi-Fi link has to be controlled by 
the apps provided by each individual 
manufacturer, which means that 
you’re dependent on the features 
that are built into those apps. Most 
manufacturers include Spotify in their 
apps, but none of them currently 
works with the Apple Music service. 
Bose, Pure and Philips get around 

U
that problem by cleverly using a 
combination of Wi-Fi and Bluetooth 
together – which can be a bit fiddly 
to set up, but allows you to listen 
to Apple Music on their multiroom 
speaker systems.

Sonos speakers don’t have 
Bluetooth, so that route is not an 
option. However, Sonos is planning to 
update its Controller app early in 2016 
with full support for Apple Music (it’s 
in beta testing now). But, of course, 
Samsung and Apple are arch-rivals, 
so while you can still use Bluetooth 
to play Apple Music on individual 
Samsung speakers you probably 
shouldn’t expect to see multiroom 
support for Apple Music from 
Samsung anytime soon. Expect more 
support from other manufacturers.
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APPLE HOME Gadgets

HOME GADGETS 

DoorBird D101 £275
doorbird.com

Many people have intercom 
systems that allow them to see 
who’s ringing their doorbell, but 
DoorBird goes a step further 

by connecting your high-tech doorbell to the 
internet so you can monitor from an iPhone.

DoorBird looks like a fairly conventional 
intercom. It can be installed using the wiring 
from an existing doorbell or intercom, and 
includes a mic and a video camera so that 
you can see and hear any visitors at your door. 
It’s packed with extra features that provide both 
convenience and extra security for your home. 
As well as ringing the bell indoors, DoorBird’s  
Wi-Fi and Ethernet capabilities connect it to 
your network, enabling the use of its app to link 
the intercom to up to eight iPhones or other 
mobile devices, making your iPhone ring and 
enabling you to speak to the visitor on your 
phone even when you’re away from home. And, 
if your iPhone has an internet connection that’s 

fast enough, DoorBird can even send a video 
image of the caller as well.

The video camera features a night-vision 
mode, and a 180° motion sensor that can scan 
the area around your front door and alert you 
if someone’s hanging around. Additional 
accessories include the BirdGuard camera, 
which allows you to remotely open the door so 

Indoors or outdoors, here’s the tech you need 
to create your new smart home

couriers can drop off parcels, and which sounds 
an alarm if they step beyond the doorway 
without permission. Bird Home Automation is 
even working on a software update that will add 
facial recognition so that DoorBird will know it 
can trust your regular postman when he needs 
to drop something off – brilliant!

The basic D101 should be suitable for most 
homes in the UK, yet there are several models 
designed for different types of houses and flats, 
with features such as weather-resistant casing. 
An installation service isn’t provided, but the 
D101 uses standard intercom wiring, so a good 
locksmith should be able to fit it for you.

1

There’s a 180° motion 
sensor that can scan the 
area around your door 
and alert you to loiterers

 WHAT YOU NEED NEXT…

Say goodbye to missed deliveries: 
the BirdGuard add-on enables you 
to remotely open doors for couriers.

Take a voice or video call from the 
internet-connected DoorBird.

For even  
more smart 
home advice 

subscribe 
today!
See page 46
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Gadgets APPLE HOME

Osram Lightify 
Starter Kit £65

Smarter iKettle 2.0 
£100

Canary All-In-One 
Security £160

led.osram.com

smarter.am 

canary.is

Smart  
ideas
WEAR IT!

It’s taken a while for traditional 
lighting companies such as 
Osram to get on board with this 
newfangled Internet Of Things 

malarkey, but we do like the look of its new 
Lightify range. This starter kit includes a 
‘gateway’ – a Wi-Fi adaptor that can control 
multiple Lightify devices – along with one of 
the power-efficient Lightify bulbs. You can 
control the bulb using Osram’s Lightify iOS 
app, and tune it to 16 million different colours. 
Additional colour bulbs cost £40 
each, or £30 for a basic 
white bulb, and Osram is 
also working on flexible 
strip lighting too.

Now on version 2.0, the new 
and improved iKettle does a lot 
more than just boil the water for 
you. The new version of its iOS 

app can check on traffic reports before you 
wake up in the morning; if the traffic’s bad 
and you need to leave a bit early, it can wake 
you up and boil the kettle for you at the same 
time. The iKettle still can’t fill itself with water, 
unfortunately, but its Water Level feature tells 
you if it’s running empty. For purists, there’s 
a Smarter grind-and-brew coffee machine 
available as well, priced at £180.

There are plenty of home 
security devices around at the 
moment, but Canary has pulled 
off a bit of a coup by getting 

its new All-In-One Security system into 
Apple Stores in the UK. It’s good value too, 
as it includes an HD (1080p) video camera 
with night-vision mode, a motion sensor, 
powerful 90dB siren, and even temperature 
and humidity sensors for £160. The compact 
device can be placed in any room, and it 
connects to the internet so that it can send 
notifications to your iOS devices whenever it 
detects any unexpected motion in your home.

 The Apple Watch can 
already control other 
apps and devices, and 
we’re now starting to 
see a new generation 
of wearable tech that 
lets you control devices 
with your body – or 
even your brain.

Thalmic Labs has 
developed an armband 
containing sensors 
that can detect the 
movement of your 
arm and hand. The 
armband can pair with 
your Mac, PC or iOS 
devices using ordinary 
Bluetooth, allowing 
you to control apps 
such as iTunes with 
a quick flick of your 
wrist. Other developers 
are producing their 
own apps for it too, 
including Parrot, which 
has released an app 
that lets you guide its 
flying drones with the 
movement of your 
arm! However, the 
ultimate in remote 
control will be devices 
such as the MindRDR 
headset, which 
monitors brain activity 
and translates it into 
simple commands. 
Its developers can 
currently use it to 
control videos on 
YouTube and BBC 
iPlayer, but it’s early 
days yet, so it’ll be a 
while before we see it 
on our devices.

2

3

4

NEXT ISSUE  Discover how the Apple TV can be the 
hub of your expanding smart home…



Do you want to alter the way your Mac looks 
or behaves for a smoother experience? 
KENNY HEMPHILL shows you how…

30 | MACFORMAT | MARCH 2016  macformat.com  @macformat



W
hether you sit at a desk 
in front of an iMac, or on 
a sofa with a MacBook on 
your lap, using a Mac is an 

intensely personal experience. We all 
use our Macs for different things and in 
different ways, so it’s natural that we like 
to set up a computer – or at least our user 
account – in a way that works best for us. 

How far you go in personalising your 
Mac will depend on how often you use it, 
how organised you are, and the degree to 
which the standard setup suits, or doesn’t 
suit, your needs. 

Some of the ways you can personalise 
OS X are purely aesthetic – frivolous, even. 
Others have a significant impact on the 
way you use your Mac, making you more 
productive in the process. Whether it’s 
creating text shortcuts, adding extensions 
to Safari, or using an app launcher, many 
of these tips will save you time every day, 
so you can spend more of it doing really 
important stuff or reduce the amount of it 
you spend in front of a screen.

The idea behind all these 
tips is simple: to reduce the 
friction between you and 
your Mac by adjusting or 
augmenting OS X so that 
it gets out the way and 
lets you get on with what 
you need to do.

Make multiple user accounts
Create and customise private workspaces for everybody

 To create an account for someone to use as their personal 
workspace, go to System Preferences’ Users & Groups pane. 
Click the padlock (bottom-left) and provide an administrator’s 
name and password. Click the +, then set the account’s type. 
Administrators can change anything on the Mac, while standard 
users have fewer privileges. With a managed account, you can 
restrict access to apps and Apple’s stores, access times, and 
more. Name the account and either set a password to use only 
on this Mac, or let the person use their iCloud account to log in.

With the account created, select it on the left, then click the 
account picture further to the right to pick a new one from the 
standard set, your Photos library, or using your Mac’s camera.

Get an alternative view
Organise your Finder windows and make them pretty

 To choose how files and folders are displayed in Finder, 
click its icon in the Dock, then click View in the menu bar. 
Some people prefer Column view because it shows a drive’s 
folder hierarchy, but you might prefer Icon view, which previews 
many file types in their icon; List view, which neatly summarises 
the attributes of items; or even Cover Flow, which is similar to 
List view but with large previews across its top. 

Finder supports tabs, enabling you to put views of several 
folders in one window. Choose View > Show Tab Bar to enable it.

To set a folder’s background to a colour or an image, switch 
to Icon view and choose View > Arrange By > None. Press ç+J 
and, in the window that opens, select Color or Picture.

Pick a new desktop picture
Customise your desktop background and screen saver

 One of the quickest and most dramatic ways to personalise 
your Mac is to change the desktop background. Open System 
Preferences and click the Desktop & Screen Saver icon. On the 
left, you can choose from one of Apple’s images or a solid 
colour, both of which are filed under ‘Apple’. To truly personalise 
the background, choose an image of your own, either from your 
Photos Library or from any folder (click the + button to add a 
new folder to the list). Kuvva (£3.99, kuvva.com/mac) sets a new 
background daily, plucked from a curated online selection.

To change your screen saver, click on the eponymously 
named tab in the Desktop & Screen Saver pane, then choose 
a style on the left. Some of them provide options on the right.

2

3

1

Turn to page 69 for our 
new troubleshooting 

section.

GENIUS 
TIPS!

FOR MORE  
OS X ADVICE SEE
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Customise the sidebar
 The sidebar in a Finder window 

provides shortcuts to the folders 
you use most. By default, it contains 
links to precreated folders for your 
user account, such as Documents and 
Pictures, but you can put almost any 
folder you like there, including those 
located on a shared network drive.

To add or remove items from the 
sidebar, choose Finder > Preferences, 
click the Sidebar tab, and then check 
or uncheck items in the list here.

To add items that aren’t in that list, 
open a Finder window, browse to the 
folder you want to add, and drag it into 
Favorites in the sidebar – you can place 
it between existing items. To remove it 
again, just drag it out of the sidebar so 
the cursor shows an X, then let go.

To specify which folder is displayed 
when you open a new Finder window, 
open Finder’s Preferences, click the 
General tab, and then select a folder 
from the pop-up menu.

4

Customise the toolbar
 By default, the toolbar on Finder 

windows contains buttons that allow 
you to change the way you view 
items, change how they’re arranged, 
share and tag items, and search for 
files and folders. Some apps, such as 
Dropbox, also add their own tools.

You can change what’s in the 
toolbar by holding ≈, clicking it and 
choosing Customise Toolbar. A panel 
will open below the toolbar. Drag items 
from the panel onto the toolbar to add 
them to it. If you decide you want to 
revert to the default set, drag it from 
here onto the bar. You can add apps 
to the bar while this panel is open by 
dragging them from another window.

Keep it organised
The Space tool allows you to insert a 
fixed space between items, while the 
Flexible Space tool creates a space 
which automatically adjusts depending 
on a window’s width.

5

Master 
Finder

Set your  
login items

Choose which apps 
open automatically

 Apps you use regularly 
can be set to open when 
you log in. Some do this 
automatically when you 
install them, which you 
might want to turn off. 
Often the option is found 
in the app’s preferences. 
If not, go to the Users & 
Groups pane in System 
Preferences, select the 
user whose login items 
you want to change, then 
click the Login Items tab. 
Click the item to remove, 
followed by the – (minus) 
button. Or, you can allow 
an item to open but hide 
its window by putting a 
check mark in the Hide 
column. To add an item, 
click the + button, select 
an app or open a folder, 
then click Add.

Make Finder work better for you
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Attach tags to files 
and folders to help 
you find them 
fast by keyword, 
colour or both

Make the most of tags
 You can attach tags to files and 

folders to help you find them by 
keyword, colour or both. Coloured 
tags are indicated by up to three 
coloured dots next to a file’s name.

The easiest way to create and 
organise tags is to choose Finder > 
Preferences and click the Tags tab. 
Click the + button, type a label, then 
press ® to create the tag. Click the 
circle to the left of the tag to set its 
colour. Putting a check mark in the 
box to the right adds the tag to the 
Tags group in Finder’s sidebar.

To tag a file or folder, drag it 
onto one in Finder’s sidebar, or hold 
≈, click the item, choose Tags, then 
select one. You can also type here to 
filter the list or create a new tag.

To view items with a specific tag, 
click that one in Finder’s sidebar, or 
type its name in Finder’s search bar.

6

Master Spotlight  
and Smart Folders
Find anything on your Mac quickly and easily

Use Spotlight
 Spotlight, OS X’s search tool, is 

hugely powerful, but you wouldn’t 
know it unless you dig deep into it 
to uncover its capabilities. To use it, 
either click the magnifying glass icon 
at the right end of the menu bar, or 
press ç+[spacebar]. When you type 
into the search box, Spotlight starts 
to display results, including apps, 
documents, email messages and 
other items on your Mac, along with 
matching results from Wikipedia, 
the iTunes Store, Vevo and other 
locations on the web. 

That won’t be much help if you 
can’t remember a file’s name or some 
other key detail of what you want, or 
if you get hundreds of results.

Scroll to the bottom of the results 
and double-click ‘Show all in Finder’ 
to see only matching files. In Column 
view, select a file to preview it on the 
right of the window. In any view, press 
the Spacebar to take a closer look.

Set filters
 To narrow the search you can 

add criteria by clicking the + button, 
just below the window’s search bar. 
Each criterion you add is shown as a 
row above the results. Choose a file 
attribute in a row’s first pop-up, then 
use the next pop-up along to specify 
how that attribute is matched. So, 
you could choose ‘Created date’ and 
‘after’ to filter out old, irrelevant files.

Dozens more attributes can be 
searched: choose Other from the first 
pop-up and put a check mark in the 
box next to any you want to inspect.

Unlock extra flexibility
You can apply multiple criteria, but 
by default a search returns results 
that match all that you add. You can 
change that: hold å and the + button 
changes to an ellipsis. Click it to 
add a group of criteria that can be 
matched more flexibly when you 
choose ‘any’, or to exclude certain 
results when you choose ‘none’.
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Create a  
Smart Folder
 If you’re going to use your 

search criteria just once, 
close the window once you’ve 
found the file you’re looking 
for. However, if you’re likely to 
need the same search again, 
particularly if it contains lots 
of criteria, you can save it 
as a Smart Folder. To do this, 
click the Save button near the 
window’s top-right corner. 
You can now give the search a 
name and save it. By default, 
it’s saved in a folder called 
Saved Searches in your user 
account’s Library folder, but 
you can save it anywhere you 
like. You’ll also see an option, 
checked by default, to add it 
to Finder’s sidebar.

Amend your criteria
Adding a Smart Folder to the 
sidebar enables you to easily 
see the results of the search 
just by clicking it. Best of all, 
the results are updated in real 
time, so this will always show 
you up-to-date results.

To tweak a Smart Folder’s 
search criteria, hold ≈ and 
click the folder in the sidebar 
(or open the folder and click 
the cog button in the toolbar), 
then choose Show Search 
Criteria. Click Save if you want 
to preserve your changes. 

Super alternatives 
to Spotlight search
These apps go much further than Spotlight

7

Alfred

Direct your Mac with 
the power of words

 Alfred can perform a 
variety of system tasks. 
Type ‘trash’ into its 
search bar to see the 
contents of your Trash, 
or enter ‘empty trash’ 
to get rid of those items. 
Alfred also understands 
’sleep’, ‘restart’ and 
other commands – see 
bit.ly/alfsyscmd for a list.

Quicksilver

Rename any file 
without using Finder

 Open Quicksilver using 
the keyboard shortcut 
you’ve assigned to it. 
Type the name of a 
file into the first box, 
then press † and 
type ‘rename’ (without 
quotes) into the second 
box. Press † again and 
type the new name for 
the file, then press ®. 

LaunchBar

Create reminders 
and Calendar events

 LaunchBar can create 
items in these apps. 
Open it and type the 
name of one of your 
calendars, then press the 
Spacebar. Summarise an 
event using the format 
[Name]@[Date]@[Time]. 
Confirm the details below 
and press ® to add the 
event to Calendar.

Master Spotlight  
and Smart Folders 
continued...

7.3

7.2

7.1
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Master mouse, 
keyboard &  
trackpad settings
Get the most from all your input devices

8

Mouse
 Apple’s Magic Mouse isn’t 

universally popular, but it has one 
key advantage over rivals: support 
for Multi-Touch gestures. Its smooth 
surface, free from buttons and wheels, 
lets you swipe left and right to go back 
and forward through a document or 
your browsing history. Many more 
gestures are available.

In System Preferences, click the 
Mouse icon. If a Magic Mouse is paired 
with your Mac, you’ll see two sets of 
options, denoted by the ‘Point & Click’ 
and ‘More Gestures’ tabs. 

Unleash new powers
The three gestures under Point & Click 
allow you to set the direction things 
scroll in when you swipe up or down, 
turn on secondary click to save you 
reaching for ≈ to access contextual 
menus, and whether Smart Zoom is 
enabled so you can take a closer look 
at web pages. Note that if you enable 
secondary click, you can set whether 
it uses the mouse’s left or right side.
Also, the slider here tweaks tracking 
speed – how quickly the pointer moves 
as you drag the mouse around.

In the More Gestures tab, you can 
enable gestures for swiping between 
pages, swiping between desktops and 
full-screen apps, and opening Mission 
Control to quickly reach a window.

Keyboard
 There are even more options for 

controlling how your Mac’s keyboard 
works than there are for a mouse. 
In System Preferences’ Keyboard 
pane, click the Keyboard tab. Here you 
can set whether the function keys act 
as normal (handy for some games) or 
control things like screen brightness.

MacBooks provide options that 
determine whether the keyboard’s 
backlight reacts to the ambient light 
sensor, and how quickly it turns off 
if there’s no input. With the former 
turned off, you can manually adjust 
the backlight using keys in the top row.

Under Text you can define short 
phrases that expand into longer ones. 
So, you might use ;hello to quickly type 
‘Hello, my name is [your name].’ 
Autocorrect can be disabled here too. 

The Shortcuts tab provides control 
over key combinations that trigger 
menu items. Click App Shortcuts then 
the + button to set your own for menu 
items that don’t already have them.

Trackpad
 The Trackpad pane in System 

Preferences has similar options 
to the Mouse pane, with a few 
important exceptions. There’s a 
third tab (Scroll & Zoom) for a start, 
which includes the same scroll 
direction and smart zoom options 
available for a mouse. Alongside 
are trackpad-exclusive options. The 
familiar pinch gesture that’s used to 
zoom in and out of images and web 
pages on iPhone and iPad can also 
be used on a trackpad, and there’s 
a Rotate option, which allows you 
to rotate things in Preview, for 
example, by placing two fingers on 
the trackpad and twisting them.

Finger-lickin’ good
In the Point & Click tab, you can 
enable secondary click, and choose 
whether it’s a click with two fingers 
or a click in one of the trackpad’s 
bottom corners. You can also turn 
on the ability to tap instead of 
pressing down to register a click. 
Perhaps the most interesting option  
here is ‘Look up & data detectors’, 
which enables you to tap with three 
fingers over a word and display 
its entries from OS X’s dictionary 
and thesaurus, as well as from 
online sources such as Wikipedia 
and the iTunes Store when relevant.

You can set your 
own shortcut for 
a menu item that 
doesn’t have one
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Set your preferences
Quickly customise OS X’s appearance

Choose your colour
 Head to System Preferences’ 

General pane to set the colour 
used to highlight what’s selected, 
and to set scroll bar visibility.

Customise Spotlight
 In the Search Results tab in the 

Spotlight pane, clear the check 
mark next to categories you don’t 
want to see. Drag disks or folders 
from Finder into the Privacy pane 
to prevent them being searched.

Tailor the Dock
 In the Dock preference pane you can 

adjust its icon size, whether the area 
under the pointer magnifies (handy if 
it’s crammed with items), and set its 
position and additional behaviours.

Enable dark mode
 You can turn the menu bar, the 

Dock and Spotlight dark grey by 
going to the General pane in System 
Preferences and turning on ‘Use dark 
menu bar and Dock’.

Regional settings
 In System Preferences’ Languages 

& Region pane, click the + button to 
add languages. Even if you use just 
one, click Advanced and check the 
way time, date, measurements and 
currencies are formatted suits you.

Change the clock
 In the Date & Time pane, 

use the options in the Clock 
tab to tailor the appearance 
of the clock in the menu bar. 
You can add the date, 
choose a 12- or a 24-hour 
clock, and show seconds.
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Take a closer look

 The Zoom feature enlarges the 
whole desktop so that you see just 
the area near the pointer. This makes 
it less of a strain on your eyes to read 
numbers on a spreadsheet, say.
Turning on ‘Use keyboard shortcuts 
to zoom’ allows you to toggle the 
effect by pressing å+ç+8, and to 
zoom in and out in increments using 
å+ç++ and å+ç+-. You can set 
the maximum and minimum zoom 
levels by clicking the More Options 
button at the bottom of the pane. 

If you turn on ‘Use scroll gesture 
with modifier keys…’ you can zoom in 
by holding a modifier key and then 
scrolling up or down (corresponding 
to zoom in and zoom out) using your 
trackpad or mouse. 

The ‘Smooth images’ option hides 
the pixelation artefacts that come 
from zooming in, and Zoom Style lets 
you choose whether to zoom in on 
the screen as a whole, or in a floating 
window that’s like a magnifying glass.

Click More Options for ways to 
refine the effect, such as whether the 
full-screen zoom tracks the pointer’s 
position or only moves when the 
pointer reaches the screen’s edge.

Get additional clarity
 
 Click Display on the left of the 

Accessibility pane for options that 
adjust OS X’s visuals. The ‘Invert 
colours’ and ‘Use grayscale’ items 
are self-explanatory, but the effect 
of ‘Differentiate without colour’ is 
subtler. With this turned on, OS X 
additionally uses shapes to convey 
meaning. So, where a messaging 
app denotes statuses with a green 
or a red circle, say, those become 
green circles and red squares.

‘Increase contrast’ makes parts 
of the interface stand out more, 
in part by adding dark strokes to 
them, and ‘Reduce transparency’ 
can aid legibility by turning opaque 
those bits of windows that normally 
give a hint of what’s behind them.

Further down are sliders to 
adjust contrast by showing fewer 
colours on screen, and to change 
the cursor’s size. There’s also a  
button here that takes you to the 
Displays pane, where you can turn 
off automatic screen brightness 
adjustment based on ambient light.

Make the most of 
accessibility features
Features useful to everyone await in the Accessibility pane

Talk this way 

 Dictation has come a long way in 
recent versions of OS X and is now 
a usable alternative to dedicated 
speech recognition apps. Go to the 
Dictation & Speech pane in System 
Preferences to turn it on.

You have two options for 
converting what you say to text. The 
first is to have your Mac record your 
voice and send this to Apple’s server, 
which performs the conversion and 
returns text to your Mac. The process 
is reasonably quick and smooth on a 
good internet connection. However, 
to use Dictation when you’re offline, 
or if you have privacy concerns about 
sending recordings to Apple, turn on 
Enhanced Dictation. This downloads 
about 400MB of data, after which 
the whole process runs locally and 
provides live feedback as you speak.

Ensure the mic and language you 
want to use are selected. With the 
focus somewhere that’s ready to 
accept text input, press ƒ twice and 
speak when an input meter appears.

Return to the Accessibility pane, 
select Dictation, then click Dictation 
Commands to see phrases you can 
say to perform specific tasks.
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Go further 
with OS X
Third-party apps that customise OS X

Tame Safari
Make Apple’s web browser 
behave better for you

 Under General in Safari’s 
preferences, you can specify 
what page, if any, is shown in 
new windows and tabs. 

Click the Search tab to 
choose a different search 
engine, or to specify what’s 
included in the results that 
appear as you type in the 
search field. To stop all sites 
asking to send notifications, 
clear the checkbox at the foot 
of the Notifications tab.

You can enhance Safari 
using extensions, which are 
managed in the eponymous 
tab. They’re showcased at 
safari-extensions.apple.com.

Under AutoFill, you can 
separately specify whether 
Safari should save you time 
by filling in your bank card or 
passwords in online forms.

To use another installed 
browser by default, look under 
General in System Preferences.

11

Icon Box
 Icon Box (about £11, iconboxapp.com) allows you to browse all 

the icons on your Mac catalogue-style, much like Photos does 
with your photographs, and replace them with alternatives. 
It features a built-in search engine for finding new icons online, 
which you can import into the app and organise into boxes (similar 
to albums in Photos) and smart boxes, which contain any icons 
you’ve imported that match your criteria, such as the site they 
came from, keywords you’ve attached, or what they are named.

It’s Icon Box’s ability to customise icons we’re interested in 
here, because you can change all the 
system and app icons to give your Mac 
a fresh new look in minutes. (It’s just as 
easy to restore the originals later on.)

Click one of the Customize options 
in the toolbar, browse to the app or 
system icon to replace, then drag a 
replacement icon from the bottom pane 
(which shows your selected box or 
smart box) and drop it on the other one.

Commander One
 There are a number of apps that provide an alternative to the 

Finder; Commander One is one of the best. It works like any other 
app, rather than as an outright replacement, so you can run it 
alongside Finder. If you’ve ever used an FTP tool like Transmit or 
Forklift, it’s interface will be familiar to you. The chief benefit of 
Commander One is that you can view two folders side by side, a bit 
like having two Finder windows open next to each other, except 

both panes are active in this case. 
Within each pane, you can have as 

many tabs open as you want. You can 
drag and drop files just like in Finder, 
but Commander One’s power lies in its 
use of the keyboard. So, for example, 
press ^ with a file selected and a 
window pops up to display the full path 
to that file. From this window, you can 
type a new file path to move it and 
rename the file at the same time.

38 | MACFORMAT | MARCH 2016  macformat.com  @macformat



ULTIMATE OS X TWEAKS

TinkerTool
 TinkerTool allows you to make 

changes to preferences for OS X and 
apps that would otherwise be tricky 
to do, either because they are hidden 
or because you need to type a 
Terminal command to alter them.

Among the most useful of the 
utility’s options are those that alter the 
appearance and behaviour of the Dock. 
So, for example, you can turn on a 
highlight effect for whatever item is 
under the pointer when you click a 
folder that you’ve added to the right 
side of the Dock (what Apple calls a 
stack), or add a stack for recent items.
TinkerTool’s Dock tab also allows you 
to disable Launchpad’s animations.

Under General, you can change the 
file format of screenshots and the 
folder where they are saved, and turn 
off the animation of opening windows. 
Handily, you can increase the active 
area around the edge of windows that’s 
used to resize them.

Other invaluable tweaks allow you 
to use ∫ to navigate back a page in 
Safari, and to toggle dark mode (see 
p36) using a keyboard shortcut).
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and productivity
Work more quickly with these apps

13

Launchpad 
Manager
 Launchpad is one of the more 

underused elements of OS X. 
Many of us are only aware of it 
when it bounces in the Dock to 
signify that a download from the 
Mac App Store has completed. 

One of the reasons for that 
is its inflexibility – apps can be 
rearranged by dragging them 
around, but you can’t do a great 
deal else. Launchpad Manager 
(launchpadmanager.com) fixes 
that. The free download allows 
you to hide apps in Launchpad 
without uninstalling them. 
Unlocking the rest of its features 
will cost you about £6.

Sort and group apps
The tool’s window presents a 
graphical preview of Launchpad, 
in which you can group apps in 
folders, rename them, hide them, 
and add any that are missing. 

You only need to drag apps 
to reorder them, as you would in 
Launchpad, but grouping them is 
much easier: select the ones you 
want by clicking them (which 
marks them with a highlight), 
then click Group in the toolbar.
Alternatively, click Sort in the 
toolbar to rearrange icons in 
alphabetical order. When you’re 
happy with the layout, you can 
preserve it by clicking Save 
Layout in the toolbar. 

HyperDock 

 One of the best features of 
this Dock enhancer is the ability 
to bring forward a single window 
rather than a whole app when 
you click a Dock icon. Put the 
pointer over an app’s icon there, 
wait for its windows to be shown, 
then click on the one you want. 

When you put the pointer 
over Calendar’s Dock icon,  
HyperDock displays upcoming 
events. Put it over iTunes and 
you’ll see what track’s playing.

You can specify how previews 
are displayed, and whether or 
not minimised windows or those 
in different Spaces are shown.

The app also enables you 
to move or resize windows by 
putting the pointer over one, 
holding a modifier key combo 
and then moving the pointer. 
HyperDock is £7.99 from the 
Mac App Store, or about £4 from 
its developer’s site, where you 
can get a trial version.
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Amphetamine 

 Amphetamine is a free utility 
that overrides the Energy Saver 
settings on your Mac. After 
you’ve downloaded it for free 
from the Mac App Store, it lives 
at the right end of the menu bar. 
From there, you can specify how 
long you want your Mac to stay 
awake, whether to allow the 
display to sleep or a screen saver 
to activate, and set a custom 
schedule for staying awake.

Intelligent behaviours
Click Amphetamine in the menu 
bar and choose Preferences to 
access dozens more options, 
including the ability to specify 
that your Mac should stay away 
when it’s connected to a specific 
Wi-Fi network or when specific 
apps are running. 

You can also define keyboard 
shortcuts to start and finish 
Amphetamine sessions, allow the 
app to alert you when it’s running, 
and ensure it stops running when 
your battery drops below your 
chosen level. On a more frivolous 
note, Amphetamine’s preferences 
also allow you to change its icon 
and what it displays, such as how 
much session time remains.

Boost performance  
and productivity
continued...

Turn off Apple Music
To remove the For You and New tabs 
from the Music view, choose iTunes > 
Preferences, click General and clear 
the check mark next to ‘Show Apple 
Music’. Note that this disables 
almost all features of Apple Music, 
including iCloud Music Library.

Turn off Connect
Apple Music Connect is iTunes’ 
social media component. You can 
disable this feature if you don’t care 
what artists have to say beyond 
their music. This is done separately 
to other Apple Music features, under 
Restrictions in iTunes’ preferences.

14

Turn off features you don’t need in iTunes

L
ove it or hate it, iTunes is still 
the app most of us turn to when 
we want to play music on a Mac. 

Whether you subscribe to Apple Music or 
iTunes Match, or only ever use it to listen 
to CDs you’ve ripped, there’s no doubt 
iTunes has grown into something of a 

monster over the years. Fortunately, 
though, there are ways you can strip it 
back to simplify matters, ridding you of 
features you don’t need, enabling you to  
focus on the ones you actually want. 
By doing so, iTunes should become less 
frustrating for you to use.

Hide the iTunes Store
If you never buy from the iTunes 
Store or listen to internet radio 
stations, you can disable access to 
those features under Restrictions 
in iTunes’ preferences. Turning off 
the iTunes Store hides Apple Music 
features, yet you’ll retain access to 
your music in iCloud Music Library.

Hide media types
Near the top-left corner of iTunes, 
click the More button (three dots) 
and choose Edit. In the pop-up, clear 
any check marks next to categories 
you don’t want to appear in the 
navigation bar. The media types 
you’ve hidden remain accessible 
by clicking the More button.

Simplify iTunes
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Set custom  
sound effects
Create your own system alerts

Y
ou can instruct your Mac 
to use an external mic or 
speakers in the Sound 

pane of System Preferences. 
If you select an external speaker 
or headphones in the Output tab 
and then adjust the volume level, 
it’s for that device only; disconnect 
the device and output returns to 
your Mac’s internal speakers and 
its previous volume level.

Go to the Input tab to adjust 
the input level for your mic, turn 
on ambient noise reduction, and 
adjust the stereo balance. The last 
of those is useful if you have a 
hearing impairment in one ear.

To change alert sound effects, 
click the Sound Effects tab, choose 
the one you want and set the alert 
volume, which is separate to your 
Mac’s overall output. If you can’t 
find an alert sound to suit, you can 
create your own.

1Create a custom sound
Open QuickTime Player, choose File > 

New Audio Recording, then record a 
sound using your Mac’s mic. When done, 
choose Edit > Trim, drag the sliders to the 
part you want to use, then click Trim.

3Change the extension
Look down the Get Info window for 

the Name and Extension section. There, 
remove the check mark from the Hide 
Extension box, and replace ‘m4a’ with 
‘aiff’ so the file will work as an alert. 

2Create a compatible file
Choose File > Export > Audio Only, 

give your custom alert a name, then save 
it to the desktop. Select it there, then 
choose File > Get Info (or press ç+I) to 
open a window that summarises the file.

4Put the file in place
In Finder, choose Go > Go to Folder 

and enter ~/Library/Sounds to open the 
folder where effects are stored. Put your 
file there, then go to System Preferences’ 
Sound pane and select your effect.

When using a 
Mac’s built-in 
mic, you can 
choose to filter 
out some of the 
ambient noise
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ULTIMATE OS X TWEAKS
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Y
our Mac’s login window 
is a familiar sight, but 
it’s also a bit boring. 

After all, most of the screen is 
taken up with a blurred image 
of the desktop background, 
with user accounts listed in 
a row across the middle of it.

The good news is that you 
can change the background 
image to anything you want. 
Just make sure your chosen 
image is the same size, in 
pixels, as your screen, and that 
it doesn’t have anything in the 
middle that will clash with the 
user icons.

Here we also show you 
ways to uncover more of your 
background, improve security 
a little bit, and leave a note for 
anyone who finds your Mac in 
case you misplace it.

1 Set a new background
Find a picture you want to use and 

scale and crop it to fit your screen. 
Save it as a PNG file with the name 
com.apple.desktop.admin.png, then 
place it in /Library/Caches. (That’s the 
Library at the top of your startup disk.)

3 Remove some clutter
To hide the buttons at the bottom 

of the login window, go to the Users & 
Groups pane in System Preferences, 
click the padlock and authenticate. 
Click Login Options and turn off ‘Show 
Sleep, Restart and Shut Down buttons’.

2 Add a custom message
In case your Mac gets lost, go to 

the Security & Privacy pane in System 
Preferences and click its General tab. 
Turn on ‘Show a message…’, click ‘Set 
Lock message’ and type something; 
including contact details may be useful.

4 Change the prompt
Still in the Users & Groups pane, 

and authenticated to make changes, 
click Login Options. Next to ‘Display 
login window as’, select ‘Name and 
password’. By doing this, you no longer 
give away some of your credentials.

Putting your 
contact details 
on the login 
screen can help 
someone return 
your MacBook
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Make the login window a more welcoming sight

Customise your  
login screen
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Make the most of 
system extensions
Add features to OS X’s built-in apps

E
xtensions allow you to 
add features to various 
parts of OS X and any 

apps that support them. Go to 
System Preferences, then click 
the Extensions pane to find out 
which are already installed. 
(Some are installed with parent 
apps, while others can be added 
on their own.)

You’ll see they are split into 
five categories: Actions provide 
features in supported apps, 
such as Preview; Finder 
extensions augment OS X’s file 
manager; Photos extensions 
add editing tools to apps such 
as Apple’s Photos; Share Menu 
extensions add locations like 
social networks; and Today 
extensions are widgets that 
you can add to the Today view 
in Notification Centre.

1 Photo-editing extensions 
If you’ve installed Affinity Photo or 

Pixelmator, go to System Preferences’  
Extensions pane, click Photos on the 
left, and put a check mark next to their  
extensions to enable you to use their 
editing tools in Apple’s Photos app.

3 Today view widgets
 Go to Notification Center’s Today 

view and click the button at the bottom 
of it, which is labelled Edit or with the 
number of new widgets installed. Drag 
items from the list of unused ones on 
the right to where you want them.

2 Share things easily 
If you use Dropbox, select Finder 

in the Extensions pane and turn on its 
extension. In Finder, choose View > 
Customize Toolbar and add Dropbox’s 
button, which is a shortcut for making 
sharable links and to version histories.

4 The Share menu
If this menu is getting clogged up, 

click Share Menu in the Extensions 
pane and clear the check mark next to 
items you don’t need. Remember, you 
can drag items up or down this list to 
change their order in the Share menu.

Extensions 
enable you to 
add shortcuts 
and features so 
that it’s easier to 
get things done
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 Understand iOS gestures

EDITED BY ALAN STONEBRIDGE 

What’s inside 

50–51 
SET UP FAMILY 

SHARING
 Pay once for music, 

videos, iBooks and apps 
for your whole family

52–53  
MASTER 

AFFINITY PHOTO
 Make Instagram-like 

colour effects, but with 
full manual control

55  
USE SIRI REMOTE 

WITH A MAC
 Take control of iTunes 

and other apps using 
your remote’s trackpad

56–58  
RECOVER OLD 

DOC VERSIONS
 Roll back changes 

or recover selected 
content in iWork for iOS

60–61  
MAKE YOUR OWN 
LIVE WALLPAPER

 Put any animated 
GIF or video on your 

iPhone 6s Lock screen

62–63  
SKETCH OUT 
3D MODELS

 Turn things drawn on 
an iPad Pro’s 2D screen 

into a rotatable object

64–67  
MAKE YOUR OWN 

TIME CAPSULE
 Turn a Raspberry Pi 

into a networked backup 
drive for your Mac

 When you see a shortcut like 
ç+å+C, hold all but the 
last key, then press that one.

 ç is the Command key, 
which is also labelled cmd.

 å means the Option key, 
labelled alt or opt.

 ≈  means the Control key, 
labelled ctrl, and shown as ^ 
in shortcuts in the menu bar.

 ß  is the Shift key, which is 
typically just labelled shift.

 ∫  means the Delete key, 
which deletes to the left of the 

insertion point. Press ƒ+ ∫ 

to delete to the right.

 † is the Tab key, which shifts 
the focus between some 
controls in windows and web 
forms. Turn on Full Keyboard 
Access in System Preferences 
to jump between all controls.
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 Master Mac keyboard shortcuts

 A tap is a brief contact of 
(usually) one finger on your 
device’s screen.

 To drag is to move a finger 
across the screen to scroll 
or pan around content.

 Swipe means move one or 
more fingers across an item 
or the screen, then let go. 
 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.

 Pinch means move two 
fingers together or apart, 
usually to zoom in or out.

 Touch and hold means lightly 
rest your finger on an item 
and wait for a reaction.

SKETCH 3D 
MODELS ON 

iPAD PRO
p62

Your new-look guide to 
getting more from 

your Apple kit

NEW 
SECTION!



You can create 
Apple IDs for 

under-13s, but 
you’ll need 

a credit card 
to prove your 

own age

1 Sign in to iCloud
Family Sharing links the Apple ID of 

each family member with the iCloud 
account of your chosen family organiser, 
so check you’re signed in as that person 
in System Preferences’ iCloud pane. 
(Family Sharing can also be set up in iOS.)

2 Say bye to your salary
The family organiser is in charge of 

managing Family Sharing. Click Set Up 
Family on the left-hand side of the iCloud 
preferences pane. By proceeding, you 
agree to pay for your family’s purchases 
from the iTunes, iBooks or App Stores.

3 See what you can share
Some things can’t be shared – iCloud 

storage is tied to individual accounts, for 
example – but Family Sharing covers the 
essentials: music, movies, iBooks, apps, 
shared photo albums, and a calendar 
and a reminders list for the group.

APPLE SKILLS iCloud
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Set up Family Sharing
Share music, videos, iBooks and apps with family the easy way

IT WILL TAKE
 10 minutes

YOU WILL LEARN
 How to share iTunes, 
iBooks and App Store 

purchases with 
family members.

YOU’LL NEED
 An iCloud account, 

everyone’s Apple IDs, 
and a credit card. 

Remember when you were the 
only person in your family who 
had Apple hardware? Those 
days, we’re sure, are a distant 

memory now: your partner’s been iPhoned up 
for years, and between the various members 
of your household you’ve probably amassed 
everything from iPods to iMacs or MacBook 
Pros for work, study or play. 

It’s great that everybody’s got the Apple 
bug, of course, but how do you ensure that 
stuff bought on Apple thing X can be shared 
on Apple thing Y, or that everybody is kept in 
the loop when it comes to family photos.

The short answer is Family Sharing, and 
the long answer is Family Sharing too. What 
this does is link everybody else’s Apple ID to 
yours, so when they buy an app or something 
from iTunes it’s your card, as the family 
organiser, that takes the hit. Family Sharing 
enables you to approve or deny your kids’ 
requests for in-app purchases; to watch or 
listen to purchased content from your iOS 
devices or Macs on Apple TV and vice versa; 
to share the same Mac and iOS apps among 
multiple devices; and to have a single photo 
album that’s shared by everybody. You can 
also hide content from family members, which 

is handy if you want to share your videos of 
Peppa Pig but not the Kill Bill movies. 

As you’ll see, Family Sharing is simple to 
set up; usually it’s just a matter of providing 
the appropriate Apple IDs for the people you 
want to share with. You can also create 
accounts for under-13s, who aren’t allowed 
iTunes accounts, but there are two caveats: 
you need a credit card (not a debit card) to 
prove that you’re a grown-up, and those 
accounts can’t be removed from Family 
Sharing without a phone call to Apple Support.

Share (almost) everything
We think Family Sharing is great, but it does 
have limits. Extra iCloud storage you’ve paid 
for can’t be divvied up between your loved 
ones as it’s tied to your account. You can’t 
share a personal Apple Music subscription 
either: you’ll need a family sub to play it on 
more than one device at a time (to get one, 
open iTunes and go to Store > View Account, 
then click Manage next to Subscriptions). 
Family Sharing doesn’t work across regions, 
so if your kids are in the US, say, they can’t 
access your purchases from Apple’s UK stores, 
and it only supports devices that run Yosemite 
or iOS 8 or later versions. Gary Marshall

 HOW TO Get started with Family Sharing 



4 Confirm your identity
Apple plays it safe: even though 

you’re already signed in to iCloud, you’ll 
need to confirm your identity by entering 
your Apple ID and its password – a good 
thing given we’re talking about using 
your payment card.

5 Check your settings
By default, Family Sharing will bill 

your family’s purchases to whatever 
payment card it has on file for you as the 
family organiser. You can change that 
here. To make an Apple ID for an under-13 
you’ll need a credit card, not a debit card.

6 Add the first member
Click the + button and you can either 

enter the details of a family member – 
their name or email address associated 
with their Apple ID – or you can create 
an ID for a child. Here we’re adding our 
spouse by giving their email address.

7 Play your cards right
Once you’ve chosen to add a new 

family member, Apple asks for yet more 
proof of identity: this time in the form of 
the CVV code, which is the last three 
digits on the back of your payment card. 
You can’t proceed without entering this.

8 Reply to the invitation
Your nominated family member can 

either enter their iCloud password in 
person, as we’re doing here, or you can 
opt to send an invitation, which appears 
on their device. They’ll only be added to 
the family if they accept the invitation.

9 Set a person’s abilities
After adding someone, you can 

specify additional options for them. Put 
a check mark next to ‘parent/guardian’ to 
give them the ability to approve children’s 
Ask to Buy requests. You can also share 
your location with them.

Keep everyone on the same page

One of Family Sharing’s less obvious benefits is that it automatically creates 
a Family calendar, which is added to the accounts of everyone you’ve included 
in your family group. Any event that any family member places in this calendar 
will be copied across to everybody else’s devices, and like any other calendar 
events you can attach maps, notes, web addresses and other essential details. 
This is a fantastic feature for busy families – and terrible news for anybody who 
uses “Nobody told me!” as an excuse to get out of things.

Similarly, Family Sharing creates a list in Reminders that’s also shared by the 
group. As with personal reminders, family ones can have a due date, a repeating 
frequency, a priority level, notes, and a location-based trigger. Although the list’s 
contents are shared, each person can assign the list a colour that suits them.

Family Sharing covers more than media and apps 

Set up Family Sharing APPLE SKILLS
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 CONTINUED… Get started with Family Sharing 



 Learn how to mimic 
a double exposure

NEXT MONTH! 

APPLE SKILLS Mac Software
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Master adjustment layers
Beat Instagram at its own game with this invaluable colour-changing trick

IT WILL TAKE
 20 minutes

YOU WILL LEARN
 How the split toning  

technique works.  
How to make infinitely 

adjustable edits to 
your images. 

YOU’LL NEED
  Affinity Photo

The old-school, analogue style 
popularised by the likes of 
Instagram has plenty of fans 
besides us, but for most people, 

adding the treatment to a photo involves 
nothing more than tapping at a selection of 
premade filters.

In this part of our Affinity Photo series 
you’ll create a cross-processed effect from 
start to finish. By the end, you’ll be able to turn 
a photo into an Instagram-style classic without 
relying on automation at all – useful because it 
will allow you to vary how each of your images 
turns out, and to learn about Affinity Photo’s 
colour correction tools and its powerful 
adjustment layer tool in the process.

The Adjustment Bureau
Here’s how editing a photo used to work: you 
would decide what you wanted to do – change 
an image’s exposure, say – then work directly 
on your image’s pixels, making changes to the 
picture itself. The problem with that approach 
is that the only way to undo your changes is to 

step back through your document’s history 
until you find where you changed exposure. 
Affinity Photo stores more than 8,000 undo 
steps, but if you changed an image’s exposure 
and then worked on it for a few more hours 
you would lose a lot of work by rolling back.

The answer is to use layers, which sit on 
top of your original image. These can contain 
new pixels, such as text, or alter your image in 
a way that’s infinitely adjustable. For example, 
an exposure adjustment layer enables you to 
change that attribute at any time. Adjustment 
layers can change anything from exposure to 
the level of shadows or highlights, to various 
colour correction tools, including curves, 
balance and, for Instagram fans, split toning.

Split toning is the colour correction 
process that’s responsible for Instagram’s 
default style, in which dark areas (shadows) 
and light areas (highlights) of an image are 
tinted with complementary colours. The result 
is vintage-looking, filmic photos that look like 
they’ve come straight from a classic lo-fi 
Holga camera. Dave Stevenson

1

2

3

4

1

 Adjustments
 Split Toning, 

and many other 
tools, can be 
accessed by 

clicking items 
in this panel.

3

Layers panel
 The actual 

pixels of your 
image are 
organised here, 
along with any 
effects you 
apply on top.

2

The Split 
Toning tool 
 This controls 

the overall effect 
you produce. 

We explain what 
it all means in 

the walkthrough.

4

History panel
 Remember this  

Invaluable tool is 
available in the 
event you want 
to roll back 
your image to 
an earlier state. 

EXPLAINED… Essential panels for split toning 

TUTORIAL 
SERIES

PART 2
OF 5



Affinity Photo guide APPLE SKILLS
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1 Find the Split Toning tool
Not every shot will benefit from split 

toning, but this one, with its emotive 
subject, soft warm light and grainy finish, 
will. In the panels on the right of the app’s 
window, click Adjustment, then scroll 
down to find Split Toning and click it.

2 Pick your colours
The window that opens lets you 

choose colours for your image’s shadows 
and highlights. Choose the tones you 
want the highlights and shadows to take 
on by dragging the Highlights Hue and 
Shadows Hue sliders, respectively.

3 Set their saturation
Before you can preview the effect 

of your colour choices, you will need to 
increase the saturation sliders for both 
highlights and shadows below those that 
determine their hues. For best results, 
keep each saturation slider below 50%.

4 Help with colour theory
The theory of complementary 

colours works well when split toning 
an image. If you’re new to this concept, 
go to colour.adobe.com to use a nifty 
colour wheel that automatically picks 
complementary colours for you.

5 Keep experimenting
For this image, we’ll opt for a green 

tinge for the highlights, a reddish one for 
the shadows, and saturation around 
20%. Changes occur live in the image, 
so play around. Subtlety is key, as is a 
colour-accurate display (see MF292, p52).

6 How the effect’s applied
When you like what you see, close 

the Split Toning window, then click the 
Layers tab on the right-hand side of the 
app. Here you’ll see not only your original 
image as a layer, but your split toning 
edits as a separate adjustment layer too.

7 Toggle the effect
An adjustment layer works similarly 

to a standard layer. Clear the checkbox to 
the right of the adjustment layer and its 
effects will be removed from your image. 
Click the layer’s name if you want it to 
say something more descriptive.

8 Refine your choices
Finally, if you decide you want to 

change the effect, double-click on the 
adjustment layer in the Layers panel 
(away from its name). The Split Toning 
window will reopen, allowing you to 
further refine your image.

9 Save your work
The JPEG and PNG formats are fine 

for posting online, but they don’t support 
layers, so your changes will be indelibly 
written into them. It’s a good idea to keep 
a ‘full fat’ version of your work: Affinity 
Photo’s own file format preserves layers.

 HOW TO Use the Split Toning tool 



Master your tablet’s apps and system features

iPAD 
PRO
Worth the 
upgrade?

EACH ISSUE JUST £2.99 / $4.99,  SUBSCRIPTIONS FROM £1.99 / $2.99

JOIN US ON TWITTER: @iPadUserMagbit.ly/iTunes_iPadUser



Siri Remote & OS X APPLE SKILLS

 HOW TO Set up and use SiriMote 

You’ll want 
to use the 

Siri Remote 
for iTunes 
playback

1 Pair with your Mac
Install SiriMote, then open System 

Preferences and go to the Bluetooth 
pane. On your Siri Remote, press and 
hold the Menu and Volume Up buttons 
for about five seconds. Click Pair next 
to the new device detected by your Mac.

2Master the controls
The app then shows you the basic 

playback controls, and it tells you how to 
re-pair the remote with your Apple TV 
when you need to. This is important as 
re-pairing will not automatically happen 
when you next turn on your Apple TV.

3 Enjoy better playback
Open iTunes and you’ll be able to 

control it right away with the Siri Remote,  
including the playback of Apple Music, 
of course. Once fully charged (using its 
Lightning cable), a Siri Remote lasts for 
months, which is practical for a controller.
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Use a Siri Remote with a Mac
If you’ve got the new Apple TV, you can use its remote for much more!

IT WILL TAKE
 5 minutes

YOU WILL LEARN
 How to pair a Siri 

Remote with your Mac.  
How to use a Siri 

Remote to control 
iTunes playback.

YOU’LL NEED
  OS X 10.11.  

Siri Remote. 
A Mac with  

Bluetooth 4.0. 
SiriMote.

The new Apple TV comes with 
a brilliant new remote control 
that has touch controls and 
integrated Siri commands, but 

what if you want to use it away from 
your little black box? 

Being a Bluetooth device, 
the Siri Remote can be paired with a 
Mac, but you will need to install 
SiriMote (free, bit.ly/mfsirimote) to be 
able to do anything more with it than 
test your self-developed apps in 
Xcode’s Apple TV simulator.

SiriMote, from the same 
developer as MacFormat 
favourites Transloader and 
Yoink, enables anyone to use 
the Siri Remote with 
numerous Mac apps, 
including QuickTime, iTunes, 
VLC and Keynote. The app 
translates button presses on 
the Siri Remote to equivalent 
key presses on your Mac. So, the 
Volume Up and Down buttons on 
the Siri Remote mimic the 
corresponding keys on a Mac’s 
keyboard. Likewise, the remote’s Play/

Pause button matches up to the equivalent 
media key on an Apple keyboard.

What does it work with?
Primarily you’ll want to use the Siri 
Remote for iTunes playback, where 
it enables you to play/pause, 
fast-forward, rewind, and skip 
tracks, yet it works with a few other 
apps too. In Keynote, SiriMote lets 

you to move through your 
presentation. In QuickTime, you 

can pause and resume 
playback, fast-forward and 

rewind; the same functions 
are available in the popular 
VLC media player.

Sadly, there’s no way 
to make the voice control 

aspect of the Siri 
Remote work with 
your Mac, but if you 
prefer to use a more 
tactile remote control, 
you’ll love this simple 
solution over Apple’s 
Remote app for iOS. 

Christian Hall



APPLE SKILLS iOS Software

You can even 
recover part 
of a version, 
not just the 
whole thing
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Manage document versions
Learn how to roll back documents to an earlier state in iWork for iOS

IT WILL TAKE
 5 minutes

YOU WILL LEARN
 How to recover earlier 

versions of a file you’ve 
been editing in Pages, 
Numbers or Keynote.

YOU’LL NEED
 iPad or iPhone.

Version 2.6 or higher  
of Pages, Numbers 
or Keynote for iOS.

With iOS becoming evermore 
important, Apple is working hard 
to beef up its mobile apps. You 
might have thought this was only 

happening in response to the iPad Pro, the 
wannabe iOS-based laptop, but it’s actually 
been going on far longer than that.

Pages, Numbers and Keynote are the 
primary beneficiaries, and version 2.6 of each 
app, released in October 2015, added a key 
feature to the iOS versions that will be familiar 
if you’ve used the apps on a Mac: document 
versioning. In a nutshell, this lets you roll your 
document back to an earlier state if you 
decide against an edit, even if that state is no 
longer available in an app’s Undo history.

In the Mac versions of the apps, this is 
accessed by choosing File > Revert To > Browse 
All Versions. This command drops you into a 
Time Machine-like interface in which you can 
scroll back through earlier states of your 
document, and either copy text out of them or 
reinstate earlier versions in their entirety to 
overwrite the latest one.

The process of creating new breakpoints in 
a document’s history is entirely passive, with a 
new version being created every time the file 
is saved, so it’s a feature you can safely forget 
about until you first need to use it.

Document versioning is available in all 
three versions of the iWork apps – on the Mac 
and iOS, and the online versions at iCloud.com. 
After signing in to the iCloud website, open the 
relevant app, hold ≈ and click the document 
you want to recover, then choose Browse All 
Versions. You’ll be presented with a list of all 
previous versions of the document. Select one 
of them and the Restore button will become 
available; when you click it, the current version 
of the document is overwritten with the one 
you selected.

Be careful when restoring previous 
iterations of a file through the web-based 
iWork apps because you don’t get the option 
to preview them before committing yourself. 
This is likely a limitation of doing this online, 
whereas the counterpart apps for iOS and the 
Mac aren’t limited in this way – in fact, they 



Recover old versions APPLE SKILLS

Genius Tip!
 Unlike Time Machine, 

Versions can’t recover 
deleted files – heed any 
warning about deletion 
also occuring on your 
other iCloud devices.

Jargon Buster
 Versions maintains 

past editions of a file 
even as you update a 
document. It was only 
recently added to the 
iWork for iOS apps.

1

2

3

4

1

The most 
recent version

 The current 
version of your 
document is at 

the top of the 
version history.

3

Preview
 To ensure 

you restore the 
correct version, 
tap Preview 
to check its 
contents first.

2

Previous 
versions

 Scroll through 
earlier versions 
below, including 

those made by 
the equivalent 

Mac app.

4

Changed 
your mind?
 You’re not 

committed to 
rolling back your 
document. Just 
tap Done if you 
want to cancel.

EXPLAINED… Restoring previous versions 
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even make it possible to select and copy 
specific parts of an older document version 
if you don’t want to reinstate the whole thing.

Selective reinstatement
To reinstate just a small part of a file on iOS, 
open the app that created it, make sure you’re 
at the document picker, then tap Edit. At this 
point the document icons will start to jiggle, 
just as they do when you’re duplicating them, 
dragging them into folders, or deleting them. 
Tap a document and then Versions in the 
toolbar to see previous editions you saved 
manually on your Mac, or which the iOS app 
has saved automatically on your behalf.

Don’t be surprised if you don’t see any 
earlier versions: this feature is still quite new. 
Documents edited solely using older versions 
of the iOS apps won’t have had their previous 
states saved along with the current one, so 
any document, spreadsheet or presentation 
that you haven’t worked on since then will only 
show the latest version. (However, you will see 
versions edited within the Mac counterpart 
if yours has the Browse All Versions option, 
which first appeared alongside OS X Lion’s 
Auto Save feature back in July 2011.

Assuming the file you’re working on has 
previous states, tap one to select it, then 
either tap Restore if you know for sure that 

you want to roll back to the way it was on that 
date, or tap Preview to take a look without 
committing yourself. Also choose Preview 
if you only want to recover a small part of 
the document rather than the whole thing.

You can’t edit a previewed document, 
but you can select either the whole thing or 
a subsection of it. Double-tapping a word in 
the preview highlights it, with grab points at 
the start and end for you to drag to refine the 
selection; holding a finger on a word until a 
magnifying glass appears and then letting go 
reveals the Select All command, giving you a 
quick way to copy the full contents of the old 
version, as you would in a regular document.

Whatever you copy is placed on the 
Clipboard, ready for you to paste into another 
document, or even another app. So, if you 
had sent the latest version of a document to 
someone for review and they wanted to see 
the previous state of a particular paragraph 
within it, you could copy it from here, paste it 
into an email, and then send it without having 
to dispatch an earlier edition of the entire 
document. This is a boon as it means you don’t 
have multiple states of the file being passed 
around, so there’s less chance of confusion, 
and of an earlier version being made public.

You might not always want to copy the 
content of your document, though: sometimes 
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Jargon Buster
 Time Machine on the 
Mac keeps an archive 
of file changes on an 

external drive, separate 
from the version history 
that some apps, such as 
the iWork suite, store as 

part of a document.

1 Select your document
Open the app you want to work with 

and go to its document picker. Tap Edit 
on the toolbar, then tap the document, 
spreadsheet or presentation that you 
want to roll back. Tap Versions on iPad, 
or the clock face-like icon on iPhone.

2 Browse older versions
A list of earlier versions of the 

document will pop up. These versions 
might have been edited in iOS, OS X or 
the browser. If the file has only ever been 
edited on iOS, changes made before 
version 2.6 of the app aren’t shown.

3 If you’re confident…
If you’re sure you know which 

version you want to roll back to, tap it 
in the list and then tap Restore. That 
version will be reinstated as the current 
one immediately, and the most recent 
edition will be demoted to the history.

 HOW TO Inspect and recover old document versions 

4…and if you’re not
Tap Preview to take a look at the 

version you’ve selected. This will let 
you check that you’ve identified the 
correct one prior to rolling back to it. 
If you have, tap Restore on the toolbar 
to complete the process.

5 Partial reinstatement
To recover part of the old version, 

select it as you would when editing a 
document, then tap Copy. Similarly, copy 
text‘s appearance with Style > Copy Style. 
In the current version, tap and pick Paste, 
or select text and pick Style > Paste Style.

6 Search for content
Though you can’t edit old versions 

without restoring them, you can swiftly 
search through one. Tap the magnifying 
glass on the toolbar and type something. 
Matches are highlighted; step through 
them using the arrows on the search bar.
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you’ll just want to copy a style – particularly 
if you’ve set up complex formatting that 
you’re having difficulty recreating later on. 
In this case, rather than tapping Copy after 
making a selection, tap Style then Copy Style.

Search within a version
The toolbar’s magnifying glass icon helps you 
find precise content in long documents: tap it, 
then type your search term in the bar that 
appears just above the keyboard.

To refine the search results, tap the cog to 
the left of the search bar and use the switches 
to specify whether to find whole words (so 
‘was’ wouldn’t match the start of ‘washer’ or 
‘waste’), or to match the case exactly.

If you need to work with the entire old 
version, you have two options: it can be 
reinstated in place of the most recent version 
by tapping Restore on the toolbar, or tap Save 
a Copy to create an instance of the document 
in its earlier state without affecting the latest 
one. Reinstating the old file in its entirety 
happens immediately, without any warning 
about overwriting your latest edits, and if the 
document is saved in iCloud the change will be 
reflected on each device that uses the same 
account. Fortunately, doing this also adds the 
document’s most recent state to the version 
history so you can retrieve it later, if needed, 
by repeating the operation and selecting that 
version from the list. Nik Rawlinson
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You can use 
this to put 

funny, furry 
creatures on 

your iPhone’s 
Lock screen

1 Prepare a Keynote project
In Keynote, choose File > New and pick any 

template, then delete everything from the slide. 
Choose View > Inspector > Document and set a 
custom slide size: 790x1054 (width by height) 
for an iPhone 6s, or 1080x1440 for a 6s Plus.

2 Set some timings
Above the slide size, set the presentation 

to play by itself, then reduce the build time to 
zero to avoid the video holding on its poster 
frame. Drag your media from Finder onto the 
slide and then resize and position it.

Genius Tip!
 You might have read 
that the frame rate of 

Live Photos is low – just 
15fps. In our example 
of creating one using 
Keynote, you’ll notice 
we don’t address this. 

In our testing, we 
found it didn’t matter 
that Keynote exports 
QuickTime video with 
a frame rate of 30fps.
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Use anything as live wallpaper
Find out how to put an animated GIF or video on your iPhone’s Lock screen

IT WILL TAKE
 30 minutes

YOU WILL LEARN
 How to use any video 
or animation on your 
phone’s Lock screen.

YOU’LL NEED
 Apple’s Photos app. 
Keynote or another 
app that can export 
QuickTime movies. 

iCloud account. 
iPhone 6s or 6s Plus.

The ability to use a Live Photo 
as the Lock screen wallpaper 
on an iPhone 6s or 6s Plus is 
ripe for fun, yet Apple provides 

no way to use an existing video in this way. 
It turns out that it’s possible using nothing 
more than Keynote, Photos and a shared 
photo album published to iCloud. (If you 
prefer, you can use another app that can 
export QuickTime movies in Keynote’s place.)

This opens up all sorts of opportunities 
to turn hand-drawn or computer-generated 
animations into Lock screen wallpapers, or 
you may just want to convert an animated GIF 
of amusing animal antics for when you need 
a pick-me-up; just press your phone’s screen 
and try not to burst out laughing if you’re 
somewhere that would be inappropriate!

Obstacles to watch out for
Note that the crossfade and enlargement from 
a Live Photo’s still part to its video is baked 
into iOS and can’t be suppressed, but perhaps 
you’ve realised this already with Live Photos 
made using your iPhone’s camera.

There are two stumbling blocks to be 
aware of. First, when taking a Live Photo in 
step 6, hold your iPhone in landscape 

orientation, with its Home button on the right. 
This may seem nonsensical given the portrait 
Lock screen, but any other way will require 
you to rotate your still in Preview to ensure it 
and your video are the same way up on your 
phone; this saves you some experimentation.

The other hurdle, also in step 6, is locating 
the parts of that Live Photo after importing it 
into your Mac‘s photo library. Finding the still 
part in the Masters folder is relatively simple 
because subfolders there organise photos by 
year, month and date taken. Things are mildly 
trickier in the modelresources folder, so use 
View > Arrange By > Date Added in the Finder’s 
menu to bring the most recently added items  
(the folder containing your newly imported 
Live Photo’s video) to the top of the view.

One more thing: if you’ve created multiple 
libraries in Photos, you must switch to the one 
set as the System Photo Library as only it can 
use iCloud Photo Sharing, which is the only 
way to share a Live Photo from Photos for Mac 
right now. Reports say OS X 10.11.4 will enable 
the use of iMessage, making the last two steps 
of our walkthrough simpler through the use of 
an empty library, rather than your main one, 
which will be easier to browse in Finder. 
Alan Stonebridge

 HOW TO Make and transfer your photo 
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CONTINUED… Make and transfer 

3 Choose what to play
With the media still selected, switch to 

the Format inspector’s Movie pane. Under Edit 
Movie, drag the in and out points to set which 
part of the media will play. Actual Live Photos 
are three seconds long, but ours is a bit longer.

4 Pick out a wallpaper image
Optionally, drag the Poster Frame slider 

to the frame you want as your Lock screen’s 
static wallpaper. Choose File > Export To > 
QuickTime. Set Format to Custom, enter the 
dimensions from step 1, and select H.264.

5 Export a photo and a video
Click Next and save the video. When done, 

choose File > Export To > Images, select JPEG 
as the format, then click Next. This will create 
an image of the poster frame. Next, we’ll make 
a Live Photo from these two parts.

6 Prep a placeholder
Take a new Live Photo using your iPhone, 

then import it into Photos for Mac. Quit Photos, 
≈-click its library in Finder and choose Show 
Package Contents. Find the Live Photo’s parts 
in Masters and resources/modelresources.

7 Swap in your creations
Rename the files you made using Keynote 

to match the Live Photo’s two parts in Photos’ 
library package, then overwrite the ones in the 
package with them. You may first need to trash 
the latter to put your files in their places.

8 Get it onto your iPhone
In Photos, open your Live Photo. (Note its 

thumbnail is unchanged; that doesn’t matter.) 
Pick File > Share > iCloud Photo Library and 
upload the Live Photo. When it appears on your 
phone, open it, tap Share, then Set Wallpaper.

Genius Tip!
 You might notice the 

file extension of a Live 
Photo’s video portion, 
when taken with an 
iPhone, is MOV, yet 
QuickTime videos 
exported from Keynote 
have the extension M4V. 
Don’t be concerned by 
this when you rename 
Keynote’s output in 
step 7 as the video will 
work fine as part of 
your handcrafted Live 
Photo when transferred 
to your iPhone.

Jargon Buster
 The term Live Photo 

might sound like some 
grand new file format, 
but it’s really two types 
that are probably 
familiar to you already: 
a regular JPEG image  
and a short QuickTime 
video. Apple has added 
to the Lock screen the 
same 3D Touch gesture 
that reveals shortcuts 
elsewhere in iOS, and 
set it to play a video for 
as long as you maintain 
pressure on the screen.
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uMake looks 
amazing in its 

demo video, 
in which a car 
is drawn then 

3D-printed

APPLE SKILLS iOS Software
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Sketch a 3D model in uMake
Get started with a unique modelling app based on freehand drawing

IT WILL TAKE
 20 minutes

YOU WILL LEARN
 How to draw lines and 

shapes, then convert 
them into 3D surfaces.

YOU’LL NEED
 iPad Air or later, 

iPad mini 2 or later, 
or an iPad Pro, 

ideally with a stylus.
uMake.

It’s a tough journey from 2D to 
3D. Even basic drawing ability 
translates easily to the 
touchscreen, but constructing 

a 3D model is another matter. However 
simplified the tools at your disposal are, 
it takes practice to get your head around 
creating forms in three-dimensional space 
using a two-dimensional display.

uMake is an innovative iPad app that tries 
hard to bridge the gap. Although it’s based on 
an XYZ space like any 3D modelling program, 
the first thing it wants you to do is just draw. 
Sketch an object from one side, and you can 
extrude that into a solid. Or, draw two curved 
lines and you can generate – or ‘loft’, in 3D 
modelling jargon – a surface between them.

It all looks amazing in uMake’s demo video, 
which you can watch at umake.xyz. In that 
example, someone draws a car with the iPad 
Pro’s Pencil, which then springs into 3D, and 
finally a physical model of it is printed out. 
In theory, you really could do all that with the 
Pro version of the app – and a very large 3D 
printing budget! Files can be exported from 
uMake in the OBJ format, which is compatible 
with apps including Photoshop, or in the IGES 

and STP file formats for use with more serious 
CAD software, so you can use uMake as a 
starting point and develop your models 
further on your Mac.

A beginner’s perspective
uMake Pro is only available on subscription, 
though, which costs $20 (about £14) per 
month or $199 (£136) per year. So far, the app 
doesn’t feel quite convincing enough to justify 
that. Here we’ve stuck to the free Starter 
version. Among its limitations, we particularly 
missed the option to repeat an object, which is 
essential for quickly constructing things like 
spoked wheels. This version also limits you to 
10 drawings, but if you export files in the UMK 
format you can delete them from the app’s file 
manager to make room for more creations, 
then reload your older ones later by opening 
UMK attachments from Mail.

When you install and open the uMake app, 
it insists you log in with Facebook or provide 
your email address. You’re then offered a 
series of video tutorials, which are well worth 
watching, although they don’t quite match the 
finished version of the app. If you prefer, just 
dive straight into our tutorial. Adam Banks

1

File manager
 Tap this to 

go back to the 
screen that lists 
your drawings, 
including some 

example files.

2

Help panel
 Scroll through 

this panel for 
a quick feature 

guide, or tap 
the triangle to 

reduce it to a bar 
and save space.

1

2

3 4

3

Top toolbar
 As you select 

objects, the 
icons in the 

toolbar change 
to show relevant 

editing objects.

4

Share/export
 Tap this icon, 

then slide along 
and pick UMK to 

email yourself 
a copy of your 

work in uMake’s 
own format.



1 Start a new document
After browsing the example files, 

if you feel like it, go to a new drawing. 
You’re presented with an infinite gridded 
plane. To begin, tap the fifth view icon 
(spectacles viewed from above) on the 
right to switch to a top-down ‘plan’ view.

2 Use Symmetry
Tap the Symmetry icon (in the set 

across the top of the screen, to the right 
of the pencil and pen) and choose Z-axis. 
A dotted line appears across the middle 
of the view. Whatever you draw will be 
mirrored on the other side of that line.

3 Draw your first line
With your finger, a stylus or an Apple 

Pencil, draw half of a boat shape, starting 
and ending on the dotted line. The other 
half appears too. Use the Undo arrow if 
you need to retry. Tap the next view icon 
up on the right side of the screen.

4 Extrude it into 3D
From the side, your ship just looks 

like a line. Double-tap the line and it will  
turn blue to show it’s selected. Now tap 
Extrude (the box icon with an up arrow). 
Drag the handle on your line downwards 
to add depth, then tap on the green tick.

5 View it from any angle
Draw an arching line for the top 

profile of your ship. Before proceeding, 
hold the Orbit button at the bottom-left 
corner and, with another finger or your 
stylus, drag to rotate the model. Your 
drawing is looking more 3D already! 

6 Compound surface
Double-tap the arched line, then 

double-tap the top edge of your ship too. 
They turn orange and new icons appear. 
Tap Create Surface (the black sail icon) 
to make a solid surface between the lines. 
Now go back to the top-down view.

7 Add another shape
Draw a triangle beside your ship, 

taking care to join the ends. Double-tap 
to select it, then switch to the side view 
and use Extrude as before, but to about 
half the depth. Tap the green tick, then 
double-tap the new shape’s bottom line.

8 Give it a top surface
Drag the shape’s Rotate handle to 

create a wedge shape, then tap the green 
tick. Inspect the wings in 3D, then double-
tap an empty area to clear your selection. 
Double-tap one wedge’s top edge and 
use Create Surface to make both solid.

9 Complete your model
Tap the wedge’s bottom edge so 

both top and bottom are selected, then 
drag the wedge up to the ship. The other 
one moves too. Switch to the ship’s end 
view. Finish up by drawing and extruding 
two circles into pipes for the engines.

Make 3D models APPLE SKILLS
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 HOW TO Turn 2D sketches into a 3D object 
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We’re big fans of the Raspberry 
Pi. This tiny and inexpensive 
computer packs enough power 
to run Linux and can be used for 

many fun projects. We’re going to make a 
Time Capsule using a Raspberry Pi 2 and an 
external hard drive. You’ll need to download 
and install some extra software so the Pi can 
use a Mac-formatted drive and talk to Time 
Machine on your Mac. (Note, because this is 
an unofficial method, you shouldn’t rely on it 
as your only backup.) If you’ve only just got a 
Raspberry Pi, you’ll need to put an OS on it; 
follow the steps on p67, then return here.

With your hardware ready to go and 
Raspbian’s desktop in front of you, choose 
Menu > Accessories > Terminal, which is similar 
to the Mac app of the same name. At its 
command line, enter sudo apt-get update 
&& sudo apt-get upgrade to make sure 
your installation is up to date. You’ll see lines 
of text filling Terminal’s window. This process 
will be finished when the scrolling stops and 
you see another coloured line of text that ends 

with a $. Now we can get down to business 
with the various bits of required software. 
Portions of what follows are based on Caleb 
Woods’ tutorial at http://bit.ly/mfcwtc. 

Get the Pi to read a Mac disk
First, download the tools Raspbian needs to 
work with Apple-formatted drives. Still in 
Terminal on the Pi, enter sudo apt-get 
--assume-yes install hfsprogs hfsutils 
hfsplus to download them.

To check where the drive is connected in 
the system, enter sudo /sbin/parted then, 
at this tool’s own command line, enter print 
to get info about your external drive. The 
command’s output will include a line that 
starts with ‘Disk /dev/sda’ followed by the 
drive’s capacity. Below that, a table should 
have two rows: find the one that refers to 
the partition named ‘Time Machine’ on the 
external drive – all being well it should be 2.  
This tells us /dev/sda2 is the location of the 
Time Machine partition. Enter quit.

We need Raspbian to mount the drive so 

Make a Time Capsule
Learn how to build an inexpensive, Linux-based networked backup drive

IT WILL TAKE
 About four hours

YOU WILL LEARN
 How to use a 

Mac-formatted drive 
with a Raspberry Pi. 

How to set up a Pi as a 
Time Machine target.

YOU’LL NEED
 A Mac, a Pi, an empty 
USB hard drive, an SD 

card, and an HDMI 
cable and display.

Raspberry Pi  
is inexpensive 

and can be 
used for many 

fun projects
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we can use it. First, create a folder by entering 
sudo mkdir -p /media/time_machine. 
The last parameter there represents where 
the partition’s file system will be mounted, 
much like the /Volumes folder in OS X.

Next you’ll use a text editor, Nano, to edit 
a file that contains a list of all file systems we 
want the system to mount at startup. Enter 
sudo nano /etc/fstab. This file will contains 
several entries already. Below them (but above 
the lines starting with a # symbol), add the 
following text as a single line. (Where you see 
a gap in the text below, press the † key 
exactly once, rather than the Spacebar.)

/dev/sda2    /media/time_machine    
hfsplus    force,rw,user,auto    0    0

Press ≈+o and then ® to save your changes 
to the file, then press ≈+x to quit Nano. Now 
you’re back at the command line, enter sudo 
mount -a to ensure the partition is mounted.

Get the Mac and the Pi talking
Next we’ll install Netatalk. We need version 3.0 
or higher, which we’ll build from source code. 
Open the Epiphany web browser from the left 
end of Raspbian’s Task Bar and go to netatalk.
sourceforge.net. Under ‘current releases’ on 
the left, click the link to download the latest 

stable version (3.1.8 at the time of writing) in 
gzip format. It will be saved to your Downloads 
folder, and the Xarchiver app will open to show 
you its contents. Right-click the file within and 
choose Extract (if right-clicking doesn’t work 
with your mouse, select the file, then choose 
Action > Extract). Put it in your Downloads 
folder (it should already be chosen for you).

We need to install the packages listed at 
bit.ly/mfntpackages. If you’re new to this, it’s 
safest to install one at a time. For each of the 
required packages, type sudo apt-get 
--assume-yes install followed by a space, 
type the the name of a package, then press ®.

Enter cd ~/Downloads/netatalk-3.1.8 
To configure Netatalk’s installer, enter the 
following text – every double hyphen should be 
preceded by a space, and every line below that 
ends with a hyphen has no space after it. 

./configure --with-init-style=debian-
systemd --without-libevent --without-tdb 
--with-cracklib --enable-krbV-uam --with-
pam-confdir=/etc/pam.d --with-dbus-
sysconf-dir=/etc/dbus-1/system.d 
--with-tracker-pkgconfig-version=1.0

You’ll see a summary when this process 
completes. The next few commands each take 
a while to complete. Enter sudo make. When 

Genius Tip!
 The apt-get command 

used in this project is a 
key part of Raspbian 
that’s used to upgrade 
its components, and to 
install new packages.

Jargon Buster
 fstab is a system 

configuration file that 
tells Raspbian about 
connected disks, 
whether to auto-mount 
them, and who should 
be able to write to them.

There are a few Raspberry Pi models. 
We’ll use the £30 Pi 2 Model B; an old 5W 
iPhone USB mains adaptor will power it.
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it’s done, enter sudo make install to run the 
installer. When this finishes, verify Netatalk 
installed correctly by entering afpd -V. All 
being well, the first line of the response will be 
‘afpd 3.1.8 - Apple Filing Protocol (AFP) 
daemon of Netatalk’.

To start the software, enter sudo service 
avahi-daemon start, followed by sudo 
service netatalk start. Neither command 
should return any output, but you should see 
‘raspberrypi’ appear under Shared in Finder’s 
sidebar on your Mac.

You’ll want Netatalk to start at login. Enter 
sudo nano ~/.bashrc and add the same two 
commands you just ran on new lines at the 
end of the file. Press ≈+o and then press ® 
to save the file, then ≈+x to quit Nano.

Make it visible to Time Machine
Enter sudo nano /etc/nsswitch.conf and 
look for the line starting ‘hosts: files mdns4_
minimal’. Add a space to its end, then append 
mdns4 mdns. Save changes and quit nano.

Now enter sudo nano /etc/avahi/
services/afpd.service and enter this:

<?xml version="1.0" standalone='no'?>< 
!--*-nxml-*-->
<!DOCTYPE service-group SYSTEM 
"avahi-service.dtd">

<service-group>
    <name replace-wildcards="yes">%h</
name>
    <service>
        <type>_afpovertcp._tcp</type>
        <port>548</port>
    </service>
    <service>
        <type>_device-info._tcp</type>
        <port>0</port>
        <txt-record>model=TimeCapsule</
txt-record>
    </service>
</service-group>

Save and quit, then enter sudo nano /usr/
local/etc/afp.conf and under [Global] add 
mimic model = TimeCapsule6,106. Also, 
append this to the end of the file:

[Time Machine 3TB]
path = /media/time_machine
time machine = yes

Save and quit, then restart your Pi. In Finder 
on your Mac, under Shared in the sidebar, 
connect to the Time Machine partition on the 
Pi using pi and raspberry as the username and 
password, respectively. Finally, connect Time 
Machine to your Pi. Lucy Hattersley

Genius Tip!
 The afp.conf file 

contains Netatalk’s 
settings. The changes 

we make to it tell the Pi 
to fake its identity as 

being a Time Capsule.

Jargon Buster
 The file .bashrc is used 

to set environmental 
preferences. Here we 

use it to ensure the 
software that powers 
our homemade Time 

Capsule runs whenever 
the Pi starts up.

1

2

3

4

1

Network
 We’re using 

the Pi’s Ethernet 
port, but you 

can use a 
Wi-Fi dongle to 

network your 
Time Capsule.

3

USB ports
 The Pi 2 has 

four, so you can 
connect storage 
as well as input 
devices. You 
may need a hub 
on other models.

2

Storage
 You can use 

any USB drive; 
we’d advise at 

least 2GB, 
depending 

on your  
Mac’s drive.

4

Raspberry Pi
 The Pi runs 

Raspbian on an 
ARM processor. 
Raspbian is 
based on Linux, 
which makes Pi’s 
official OS free.

EXPLAINED… The hardware you’ll need 
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 HOW TO Prepare your hardware 

1 Format the hard drive
In Disk Utility, select the external volume, 

click Erase, name it ‘Time Machine’, select OS X 
Extended (Journaled) and GUID. Click Erase. In 
Terminal, enter sudo chmod 777 /Volumes/ 
Time\ Machine && ls -l /Volumes. The row 
for formatted volume must start drwxrwxrwx.

3 Install NOOBS
Download the offline version of NOOBS in 

Zip format from bit.ly/getnoobs. Unpack and 
copy the contents to your SD card. When you 
start up your Pi in a moment, you’ll need to 
follow on-screen instructions for NOOBS to put  
a working installation of Raspbian on the card.

5 Connect to your network
When you reach Raspbian’s desktop, 

ensure your Pi is connected to your network. 
Put the pointer over the icon of two networked 
computers at the right end of the Task Bar and 
a tooltip should appear with a line like ‘eth0: 
connected’ followed by an IP address.

2 Format the SD card
Download and open SD Formatter 4.0 

from bit.ly/1T4Ufgs. Connect an 8GB or larger 
MicroSD card to your Mac and select it in the 
app’s Select Card pop-up menu. Next, select 
Overwrite Format and enter ‘boot’ (without 
quotes) in the Name field, then click Format.

4 Assemble the hardware
Eject the hard drive and SD card from 

your Mac and connect them to the Pi. Also 
connect a USB keyboard and mouse, an HDMI 
cable and a display, and connect the power 
supply. Using NOOBS to install Raspbian is 
simple, though a full guide is at bit.ly/runnoobs.

6 Connect to the internet
On top of Raspbian, you’ll need to 

download some additional software from the 
internet. Open the Epiphany web browser, 
which you’ll find at the left end of the Task Bar, 
and direct it to a website to ensure your Pi can 
reach the outside world.

Best Buys!
 Our Time Capsule 

project is based on 
inexpensive hardware. 
Your Time Capsule will 
need a USB hard drive 
and a mains adaptor, 
of course. In addition 
to that, here’s what 
we recommend.

MicroSD card 
 You’ll need to install 

the Raspbian OS on a 
MicroSD card. An 8GB 
one will do, but 16GB is 
more versatile and will 
cost you about £10. 

Raspberry Pi 2
 You can use any model 

of Raspberry Pi to 
create a Time Capsule. 
However, the Pi 2 has 
four USB ports, which 
makes life a lot easier.

Raspberry Pi  
official case
 The official case is 

modular, and its sides 
can be removed to gain 
access to the board’s 
ports and pins.
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Q
Whenever I start Safari, or open 
a new browser window, it uses an 
old Mozilla user agent that doesn’t 

work with many websites. When I change 
User Agent in the Develop menu to Safari, 
everything is hunky dory, but that setting 
will not stick. How can I return it to normal?
by A L A S T A I R  S E A G R O A T T

A
This is strange. You can only change 
Safari’s user agent – what the app 
pretends to be to web servers – in the 

Develop menu (enabled in the Advanced tab of 
Safari’s Preferences window).

Normally that setting does not persist 
after you restart Safari, and reverts to default 
(that is, Safari’s real identity) when you next 
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start up the browser. That yours is stuck on 
an incorrect user agent implies something 
has written it to Safari’s preferences file,  
com.apple.Safari.plist, which is located in 
the Preferences folder in your user account’s 
Library folder. You can correct it using a 
property list editor, such as PlistEdit Pro, or by 
forcing Safari to write a new preferences file.

To do the latter, make a record of your 
current preferences, quit Safari, then move 
its preferences file to your Documents folder. 
Reopen Safari and set its preferences again. 
When you enable the Develop menu, it should 
have reverted to the default user agent once 
more. If this still does not stick, you have 
another app which keeps making the change; 
you’ll need to work out which it is and stop it.

Safari identifies itself as an old Mozilla 
browser and it won’t change back

Our resident expert 
solves your Mac and  

iOS problems

NEW 
SECTION!

MARCH 2016 | MACFORMAT | 69



Mac Hardware 
Thinking inside the aluminium box to refresh 
the parts that other tips can’t reach

Q
My 27-inch iMac (Mid 2011) with an 
AMD Radeon HD 6970M graphics 
processor was running fine when 

suddenly it showed the ‘blue screen of death’ 
and I had to force it to shut down. It now 
freezes during startup, whether I try from its 
hard drive or a bootable USB recovery stick. 
What is wrong with it?
by T E D  O L I V E R

A
The fact that you saw a blue screen 
(the dreaded ‘BSOD’) and that your 
Mac will not start up from a bootable 

USB stick suggests this is likely to be a 
hardware failure, of something other than 
memory or storage; memory failure should 
give you a sequence of tones instead of the 
normal startup sound, and a faulty hard drive 
should not prevent booting from a USB stick.

After the ‘blue screen of death’, my 
Mac freezes even starting up over USB

Hardware 
quick-fire

questions 
Why do the fans 
in my Mac come 

on full blast when 
I reset the PMC 

and NVRAM?
> The default setting for 

Mac fan management 
is for the fans to run 
at maximum speed 

in order to safeguard 
your processor. It is 

only when the hardware 
sensors override this, 
to slow or stop them, 

that they’ll settle down.

Can I install OS X 
on a memory stick 
or SDHC card and 

start up from it?
> You can, and you will 

be able to fit a basic 
installation on a 16GB 

stick or card, but writing 
to this type of flash 

storage is painfully slow, 
so it’s only advisable 
for use as a recovery 

and install disk. It would 
be unusable compared 
to a USB 2.0 hard drive 

as your startup disk.

Start up with all peripherals disconnected 
apart from a USB mouse, a USB keyboard and 
a wired Ethernet connection, and hold å+D 
to run Apple Hardware Test over the internet. 
Follow the on-screen instructions to run the 
tests, noting any errors.

If no hardware error is reported, next try 
resetting the PMC and NVRAM. Disconnect all 
cables from the iMac, including the power 
lead. After at least 15 seconds, hold down the 
power button, reconnect the power lead, then 
release the power button. Connect your wired 
mouse and keyboard, and start up the iMac 
while holding ç+å+p+r until you hear the 
second startup chime, then release.

If those don’t fix your problem, make an 
appointment at your local Genius Bar or with 
an Authorised Service Provider: the chances 
are that the Mac’s graphics card is dead.

GENIUS TIPS Mac Hardware
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Apple Hardware Test (and Apple 
Diagnostics since 2013) runs fairly 
thorough checks, but it may not 
spot some graphics card errors.

USB flash drives are typically 
slower than you might expect.



Make sure you read 
Luis’s Love Your Mac 
pages for ways to reuse 
your old hardware

Q
Since I upgraded to El Capitan, 
my quad-core 27-inch iMac 
(Mid 2010) has been sluggish, 

often showing the spinning beach ball. 
It already has 16GB of memory, and its 
1TB hard disk has ample contiguous 
free space. I cannot afford to replace 
the iMac yet, so what can I do to get it 
running more quickly again?
by O S C A R  L A N G D O N

A
Increasing memory further is 
unlikely to bring much performance 
improvement. However, you should 

see greatest acceleration from running OS X 
and your core apps from a solid-state drive 
(SSD) rather than a hard drive, much in 

Q
My wife’s Power Mac G5 desktop 
runs OS X 10.4.11, and has been 
protected by Intego Internet 

Security Barrier X5. Intego has discontinued 
support for OS X versions before 10.7. How 
can I obtain protection for her Mac now?
by T R E V O R  C L A R K E

A
Although it is tempting to update to 
a later version of OS X, that would 
not help much, and only cause more 

problems. Sadly, support for PowerPC-based 
Macs ended years ago, and there is no real 
equivalent protection available. As there are 
so few PowerPC Macs still running, and they 
cannot run modern Intel apps, the chances 
of any modern malware or virus being able to 
infect her Mac are so low that it’s probably 
safer now than it has been in the past.

How should I upgrade my iMac 
to run El Capitan better?

It’s not virus protection that’s 
needed for an old Power Mac G5

Mac Hardware GENIUS TIPS

the way that Apple currently offers with its 
Fusion Drives, as well as pure flash storage, 
on modern iMacs.

A 1TB SSD would be expensive, typically 
costing over £250, and would not be a wise 
investment on an older Mac. However, your 
iMac has a second internal 3.0Gbps SATA port 

that would have been filled if 
you’d opted to buy your Mac 
with an SSD fitted as well as 
the hard drive.

A 128 or 256GB drive costs 
between £50 and £100; with a 
clean installation of OS X and 
your essential apps on it, you 
should get a significant boost 

in performance, putting an end to the 
incessant beach ball.

Installing the SSD requires quite major 
internal surgery. Unless you’re familiar with 

the process, you’ll want an Apple-authorised 
engineer to perform the upgrade for you.

PowerPC-based Macs are now near impossible to maintain 
due to the scarcity of parts. Hardware faults mean sudden 
death, and even replacing hard disks can be tricky.

Far more pressing is the age of this Mac. 
Because hardware support has also ended, 
getting spares to replace broken parts is 
now very difficult, and on those grounds you 
should look for a replacement when you can. 
Problems with any component other than the 
hard disk would be difficult to repair.
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Though still more expensive 
per gigabyte than hard drives, 
SSDs are pretty affordable now.

If I add an internal 
SSD, will I need to 
enable TRIM 
support – and how?
> El Capitan has TRIM 
support for most SSDs, 
and may be automatic; 
check with your SSD 
supplier whether you 
need to do anything 
else. You can turn it on 
manually by entering 
sudo trimforce 
enable in Terminal.

Other than eBay, 
where can I find 
previous versions 
of OS X to support 
my old Mac?
> Apple still sells OS X 
10.6 to 10.8 through its 
Online Store (bit.ly/
mf-oldosx). Versions 
10.9 and 10.10 can be 
redownloaded through 
the Mac App Store, 
provided you bought 
them before they 
were withdrawn 
from sale, from the 
store’s Purchased tab.



Mac OS X 
Shining a spotlight on sagacious solutions 
to your most maddening Mac maladies

GENIUS TIPS OS X

Sometimes Mail’s outgoing mail server (SMTP) settings appear to be correct, but they have become damaged. 
Deleting entries and re-entering them by hand should be enough to fix this and enable you to send email again.
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Q
I use a MacBook Pro (running OS X 
10.9.5) when away from my iMac 
(which runs OS X 10.7.5). I migrated 

and checked my settings from the iMac to 
the MacBook Pro. Why can I only receive but 
not send email on the MacBook Pro when its 
settings appear identical?
by D A V I D  H A L L

A
Your MacBook Pro is suffering from 
the infamous SMTP server bug in 
Mail. Although they may appear to be 

set correctly, in fact it’s using broken SMTP 
server settings.

Open Mail’s preferences window on both 
Macs, then select each one’s Accounts tab. 
Click the Outgoing Mail Server (SMTP) pop-up 
menu on your iMac and edit the server list. 
Select the correct SMTP server so that you 

can view all of its settings in both the Account 
Information and Advanced tabs.

On the MacBook Pro, open that same list 
of SMTP servers. Select each one in turn and 
use the – (minus) button to delete all except 
those which are still needed. You should then 
have either no servers, or just those needed 
for other services.

Next, click the + button to add a new SMTP 
server. Set it up with exactly the same settings 
that are shown on your iMac. Make sure that 
server’s row is selected, then click OK. Check 
the account settings on both Macs one last 
time, then close both preferences windows.

If that doesn’t help, repeat the process, 
but don’t add any SMTP server details yet: on 
your MacBook, set the outgoing mail server to 
None. Quit and reopen Mail, and again set up 
the SMTP server to match the iMac’s settings.

I can’t send email even though all of 
Mail’s settings appear to be correct

Why does Mail’s 
Connection Doctor 
test old accounts?
> Connection Doctor, in 

Mail’s Window menu, 
checks all accounts 

listed in its Accounts 
preferences tab – even 
those you haven’t used 

recently. Even if an 
account is disabled 
there, you may find 

Connection Doctor tests 
its servers. Either cancel 

the tests or use the – 
(minus) button to 

remove any accounts 
you no longer need.

Why does Outlook 
open rather than 

Mail when I click an 
email link online?

> In Mail’s General 
preferences tab, set 

‘Default email reader’ to 
Mail instead of Outlook. 
If clicking an email link 

still opens the wrong 
app, locate a message in 
Finder, hold ≈ and click 
the message, then hold 

å and choose Always 
Open With > Mail.

Software  
quick-fire 

questions 



OS X GENIUS TIPS

Can Numbers autofill rows or columns 
with a series of numbers?

How do I work out which iTunes tracks 
are compatible with my MP3 player?

Numbers does support 
this, and you only need 
to type two values then 
extend a selection box 
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Q
I have a wonderful underwater 
MP3 player, a Finis Neptune 2, 
which uses bone conduction to 

enable listening while swimming. Tracks that 
I converted to MP3 using iTunes are listed 
alongside the original versions in My Music, 
and I cannot tell them apart. Is there a smart 
way to identify the MP3 versions so I can 
copy them to my Finis player?
by M I K E  B U L P I T T

A
The best way to achieve this is by 
choosing File > New > Smart Playlist. 
Add two rules to this playlist. Set the 

first to check whether a library item’s Media 

Kind is set to Music to disregard other kinds 
without inspecting them any further.

The second rule should inspect the Kind 
metadata for the phrase ‘MPEG audio file’. 
Tracks downloaded from the iTunes Store, or 
which are stored in your iCloud Music Library 
but not on your Mac, will instead contain the 
phrase ‘AAC audio file’, preceded by either 
‘Purchased’ or ‘Matched’.

Make sure you search for the whole of the 
phrase given above, not just the word MPEG. 
Although you might intuit that word to be the 
only important detail at this point, you will 
want to correctly exclude from the playlist 
any tracks whose is ‘MPEG-4 audio file’.

Q
In Numbers, is there a way to fill 
a row or column with a series of 
values, with a set increment or 

decrement between them, or is that feature 
still only available in Microsoft Excel?
by D A V I D  H O R W O O D

A
Numbers does now support this. 
Put the first two entries into their 
adjacent cells to set the starting 

value and its increment or decrement. Next, 
select those two cells – by selecting one and 
dragging the corner of the selection box to 
enclose the other, for example.

Move the pointer over the edge of the 
selection box that corresponds to the direction 
in which you want to add values. Drag the 
yellow blob that appears in the middle of that 
edge to extend the selection and fill in the 
series of values through the additional cells.

Information about 
messages in Mail is 
muddled. How can 
I straighten it out?
> In Mail’s preferences,  
click Viewing and turn 
on ‘Use classic layout’, 
then turn it off again. 
Try dragging the 
dividers in the Message 
Viewer. Otherwise try 
rebuilding that mailbox 
(select it, then choose 
Mailbox > Rebuild).

Can I compare two 
images in Photos, 
like I did in iPhoto?
> At present there is no 
way to do this; shocking 
given that this feature 
was in both iPhoto and 
Aperture. Third-party 
apps that can access 
Photos’ library, such as 
PowerPhotos ($29.95 – 
about £21, fatcatsoft 
ware.com), should be 
able to do it though.

To create a row or column series, enter values in the first 
two cells in the sequence, then select those cells.

Next, put the pointer over one of the selection’s edges and 
drag the yellow handle on that edge to extend the series.

A two-rule Smart Playlist 
can be used to find all MP3s 
in your iTunes library.



iOS Software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS devices 
quick-fire

questions 
Is there an app 

that will perform 
housekeeping 
for my iPad?

> Each iOS app operates 
within its own protected 

sandbox, and they are 
not allowed the same 
degree of freedom as 
Mac apps. So, unless 
you were to jailbreak 

your iPad (which brings 
its own concerns), you 
have to perform such 

housekeeping manually.

How can I find out 
which apps are 

using lots of space?
> In Settings, go to 

General > Storage & 
iCloud Usage > Storage > 

Manage Storage to see 
a list of installed apps. 

Tap an app to see 
separate counts of the 
space taken up by the 
app itself and its data. 

You can delete apps 
and their data here, 

rather than having to do 
so at the Home screen.

GENIUS TIPS iOS Software

Q
I have purchased a few movies and 
downloaded them to my MacBook, 
iPad mini and iPhone. They are now 

taking up storage on the iPad and iPhone 
which I need to reclaim. How can I move 
them back to iCloud?
by J O N  L E W I S

A
Videos bought from the iTunes Store 
remain available to redownload from 
iCloud after you remove them from 

your Mac or iOS device. On your iOS device, 
open Videos, tap Movies in the bottom bar, 
then tap Edit at the top-right corner of the 
screen. Items stored on your device will have 
an X at their top-left corner. Tap that X on any 
items you want to remove, then tap Done.

Reclaim storage on your iOS device 
by putting videos back in iCloud

For TV shows, you can delete individual 
episodes by tapping the show. Next, swipe left 
on a downloaded episode’s row, and then tap 
the red Delete button that appears at the 
right-hand side of it.

Once deleted, you can redownload videos 
(and music from the iTunes Store) from iCloud 
whenever you’re on Wi-Fi. The exception is 
audiobooks, which you must back up as they 
aren’t stored by iTunes in the Cloud.

Some people have complained that this 
has not worked for them, in which case there 
has been a problem with the iTunes Store and 
iCloud. Apple’s support team can address this 
if it occurs. It mostly seems to happen across 
major iOS upgrades, and its causes should be 
fixed in iOS 9.2.

Removing watched movies or TV Shows you’ve downloaded from iTunes – you’ll be able to redownload them.
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rowsing internet forums on my iPad 
at night is a terrible way to get to 
sleep. The light from the screen has a 

lot of blue wavelengths mixed in with it, and 
research has shown that this suppresses the 
production of the sleep hormone melatonin. 
So what happens is I read until late into the 
night, until I am exhausted but not sleepy, and 
then eventually put down the iPad and stare at 
the ceiling for the rest of the night. Reading an 
actual book is slightly better, but there is still a 
sudden transition when I turn out the bedside 
light. Getting up in the morning when it’s still 
dark outside is even worse. My brain needs a 
more gradual transition to get used to the idea 

that it’s time to sleep or wake up. Our 
ancestors lived by the natural rhythms of the 
day and went to bed when the sun went down, 
but since that’s not very convenient in winter, 
I’m going to use some leftover Apple 
technology to make my own artificial sunset. 

Tackle insomnia 
and improve the 
quality of your 
sleep with a  
sunset night light
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B

 The first Apple computer I ever used was the Macintosh 128K, 
which was the first Mac. In 1987, my own computer was a BBC 
Micro Model B, but my zoology tutor at Oxford had a Macintosh 
128K on his desk, which he allowed me to use in the evenings 
to write up my Honours project in MacWrite. A WYSIWYG word 
processor was as startling as a lightsaber in those days, and 
I spent dozens of mesmerised hours adjusting my tab rulers 
and adding shading effects to my tables.

 LUIS’S APPLE CLASSIC!



LOVE YOUR MAC iPod touch
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he light source for my sunset will 
be an old second-generation iPod 
touch. It can’t be upgraded past 

iOS 4.2.1, so most apps won’t run on it now, 
and its headphone jack has an intermittent 
connection somewhere, so I can’t use it for 
music or podcasts either. There’s nothing 
wrong with its screen though. If I mount it 
on a gooseneck bracket fixed to the head 
of my bed, then a plain white screen gives 
out enough light to read an old-fashioned 
paper book by, without disturbing my wife. 

The trouble with this is the iPod’s screen 
would emit the same harsh blue-white light 
that keeps the brain awake. I need the 
screen to fade gently through a sequence 
of progressively more orange and red 
colours, to simulate the changing light of 
a natural sunset. When it gets too dark to 
read by the screen’s light, it’s time to sleep.

Animation challenge
My first thought was to point Safari at 
a web page that handles this animation. 
I could just sign up for some free hosting 
and create a web page that checks the 
time of day and looks up the colour 
to display in a big table of RGB 
values. That’s quite a lot of work for 
such a simple task though, and it 
only works if I go to bed at the same 
time every night.

Another way might be to use some 
JavaScript that I append to the address of an 
existing website (a bookmarklet) and use that 
to override the style sheet of a blank page, 
such as blank.org, to change the page’s 
background colour according to some simple 
rules. The problem with this is the code in the 
bookmarklet only gets executed when the 
page loads, so I’d need to somehow force the 

A light that 
changes colour
Drift gently off to sleep with a reading light 
that simulates the colours of sunset

Software 
quick-fire

questions 
How do I change 

the timestamps on 
many image files?

> The Photos app will 
let you change the 

date and time in the 
EXIF information of a 

single photo, but if you 
change several files 

as a batch, they will all 
end up with identical 
timestamps. To give 

each image a slightly 
different timestamp, so 
they end up sorted into 

the correct sequence 
when synced to your 

iPod night light, 
you need to change 

the time on the image 
file itself. Download 

the TouchFiles action 
for Automator from  

bit.ly/touchfiles. 
This gives Automator 

access to Terminal’s 
touch command, so you 

can set the timestamp 
of a file from within 

your workflows.

How much storage 
will my night light 

slideshow require?
> Very little. The images 
can be just a few pixels 

across because the 
iPod will automatically 
scale them up to fill its 

screen. A slideshow 
consisting of 1,500 

slides required less than 
a megabyte on my iPod.

page to refresh periodically, and I can’t think 
of an easy way to do that on an iPod touch.

Then I hit on the idea of playing a real-time 
video of a sunset. YouTube has lots of these 
(here’s a very nice one from a beach in 
Kagoshima, Japan: bit.ly/mfsunset). 

T

An old iPod touch that’s idle in a desk drawer can be 
brought back into service by turning it into a night light 
with little effort, and with benefit to your sleep to boot.



Make a night light LOVE YOUR MAC

 macformat.com  @macformat

You can turn your sunset photo into colour slides for your insomnia-busting 
reading light in seconds with the help of free software.

Find an image of a sunset with a smooth gradient, like this one, to make your 
night light fade through a natural sequence of warm and soothing colours.

which should have been fine, but the slicing 
app I used to create the individual slides gave 
them all exactly the same timestamp, and 
when iTunes synced them to the iPod, the 
slides appeared in a semi-random jumble.

To fix this, I built a workflow in Automator 
that took each image file in turn, set the file 
timestamp to the current date and time, 
waited a few seconds and then moved on to 
the next file. This wouldn’t normally work with 
Automator because it processes every file in 
a selection all at once. But there is a very 
handy Automator action called ‘Dispense 
Items Incrementally’ (from automator.us) 
that will force a workflow to operate on just 
a single file at a time. At the bottom of my 
workflow, I included the Loop action so the 

Converting YouTube video to run in iOS 4.2.1 is 
complicated though, and I don’t actually need 
30fps video. A series of still photos is enough. 

I tried taking screenshots of the video at 
one-minute intervals, and playing them back 
as a slideshow on the iPod. That was 
unsatisfactory because even a bright sunset 
still has lots of deep shadows in the frame, 
and the screen on the iPod is only just large 
enough to emit a usable reading light when all 
of its pixels are glowing. If I start with half of 
them showing a dark beach, there’s really no 
point bothering to fade it down any further. 
So instead I picked a single bright sunset 
JPEG with a nice colour gradient in the sky 
and cropped out a narrow vertical strip that 
ran from the bright yellow sun down to 
blackness at sea level. I sliced this into 
120 chunks and saved each one as 
a separate PNG file.

Natural colours
The longest interval you can 
set between slides in Photos 
for iOS is 20 seconds, 
so our number of slides 
is enough for a sunset 
slideshow that lasts for 
40 minutes, and it’s bright 
enough to read by for at least 
the first 20. Of course, at this 
point I could have just used 
single-colour image files from 
a Pantone colour chart, but there’s 
something quite pleasing about using 
a real sunset as the source for my slides. 
It feels more natural and it guarantees that 
the colours shift in a realistic way.

For that to work though, the slides have to 
stay in the correct order. The iOS Photos app 
only lets me display the photos sorted by date, 

Using a real sunset 
is pleasing because 

it feels more natural 
and guarantees 

the colours shift 
in a realistic way

Set the duration for each 
slide to the longest allowed, 
and turn off Shuffle.

A gooseneck clamp like 
this one (about £8) will 
enable you to position 

your night light for 
maximum comfort.



LOVE YOUR MAC iPod touch
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1 Crop your sunset photo
Choose a beautiful sunset with an even 

colour gradient. Hazy ones work better 
than those with dramatic clouds. We’re 
only interested in the section from the 
sun downward, because we want the 
slides to start bright and get gradually 
darker. Crop to this section with an image 
editing app and save it as a separate file.

2 Slice up the sky
An easy way to slice your gradient 

into separate images is to use Tilen (free, 
nasolab.com/tilen). Divide the height of 
the colour strip by the number of tiles 
you want and enter this in the height 
field. The purple lines are just a guide to 
show you where the image will be sliced; 
they don’t end up in the final image files.

3 Import and sync to iPod
Import the images into Photos on 

your Mac and check they are correctly 
ordered. If not, edit their dates manually, 
or use an Automator workflow to alter 
the timestamps (see p78) on the files and 
then reimport them. Put the images in 
their own album and use iTunes to sync 
this album to your iPod.

 HOW TO Turn a sunset strip into a slideshow 

workflow repeats, but this time with the next 
file in the list, and so on. Basically, this action 
makes Automator behave in the way I always 
thought it did.

Waiting for dawn
I discovered another problem while testing my 
sunset slideshow. When the slideshow finishes, 
it loops round to the beginning again – yes, 
even though ‘Repeat’ was turned off in 
Settings > Photos. I tried the usual advice to 
turn it off and then on again, but this made no 
difference. So, in the end I just added another 
1,260 plain black slides to extend the 
slideshow through another 7 hours 
of night. Each one of these slides 
contains only one pixel, so they 
take up virtually no space and the 
iPod automatically 
rescales them up 
fill its screen. 
A one-pixel image 
doesn’t have the 
right aspect ratio to 
fill an iPod’s screen, 
but the pillarboxing 
bars the Photos app 
displays either side 
of the image are 
black as well, so the 
image’s dimensions 
don’t matter.

As the slideshow plays all night long, 
I figured I may as well repeat the colour fade 
in reverse with a series of colours taken from 
an image of dawn to wake me up in the 
morning. The old battery in the iPod doesn’t 
last through a whole night’s slideshow, so it 

needs to be left plugged in to 
a USB power adaptor through 
the night if I’m to be woken up 
by an artificial dawn. However, 
this means that at weekends 

I can simply unplug the iPod 
to automatically get a lie-in 
the next day.

Next Issue!
 Luis resurrects an 

‘anglepoise’ iMac G4. 
He’s found software 

that lets him get useful 
work done even on a 

PowerPC Mac that dates 
back to the Iraq War.

You may need a spare 5W 
USB power adaptor to hand 
to ensure your night light has 
sufficient power to wake you.

Your night light won’t give off 
blue-white light that disrupts 
the process of falling asleep.
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CRAIG GRANNELL 
scours the App Store 
for the best free apps  
to install on your 
Apple Watch, iPhone, 
iPad or iPad Pro

 macformat.com  @macformat



CHRISTIAN LOVES...
ONEFOOTBALL

 Saturdays just aren’t the same 
without this gorgeous football 
results app – a must for fans!

ALAN LOVES... 
ARTSY

 This is great for inspiration, even if 
putting thousands of art pieces in 
a pocket makes me feel like a thief.

ALEX LOVES... 
POCKET

 This is much better than Safari‘s 
Reading List as it lets you tag 

items to organise in multiple lists.

PAUL LOVES... 
TUNEIN RADIO

 I love the BBC’s iPlayer Radio 
app, but this great alternative 

offers its content and much more!

SETH LOVES... 
HOTUKDEALS

 I’ve saved loads when buying 
things thanks to this. Of course, 

it’s caused me to spend loads too!

 The tiny problem in splashing out 
on a shiny new piece of Apple kit is that it 

might leave your bank account gasping for breath. 
If that’s the case, immediately buying dozens of apps is 
probably not the best next move to make. Fortunately, 
getting great apps on your Apple Watch, iPhone, iPad or 
iPad Pro needn’t cost a penny.

That’s not to say MacFormat has turned into Freebies 
Monthly. Many of the very best iOS and watchOS apps 
require you to cough up some cash, and we’re not of the 
‘every app should be free’ mentality, but that doesn’t mean 
there aren’t amazing bargains to be had. Whether through 
sheer generosity or companies creating apps to support 
hardware products or Mac software, there’s plenty of 
choice when it comes to apps that cost nothing at all.

There’s arguably too much choice. The App Store now 
has well over 1.5 million apps – plenty of them free, though 
quite a lot of them are rubbish. That’s why this feature 

focusses on a small selection of first-rate apps for each 
of your devices, all of which we’ve used and enjoyed. 

Note that some of them offer in-app purchases 
(IAPs), and we outline what features they give you. 

However, to make our list, the vanilla experience 
of every app had to be superb. So get reading, 
and then get downloading!
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29 FREE APPS

Best apps for iPhone
Learn, exercise, work, and be entertained with these apps

 macformat.com  @macformat84 | MACFORMAT | MARCH 2016

3Amend your 
login details

To edit a login in the 
1Password app, tap the 
item to open it and then 
tap Edit. 1Password 
provides you with 
greater control than 
iCloud Keychain does 
when generating 
complex passwords.

2Keep things 
secure

In the 1Password app, 
tap Categories and 
then +. You’ll see a list 
of the many things you 
can store securely in 
it. Tap Secure Notes. 
You can now create a 
basic text note outside 
of Apple Notes.

1Use it 
with Safari

To use a stored login, 
tap the Share button, 
and select 1Password 
(tap More if it’s not 
visible, then turn it 
on). Select the details 
to use. The app allows 
you to store multiple 
logins for sites.

1Password
 iCloud Keychain stores login and payment 

details across Mac and iOS devices, but 
1Password goes further. It’s free for iOS, 
with a single ‘pro’ IAP if you want to unlock 
Apple Watch support.

Forecast
 A weather app for people who like 

the look of Dark Sky, just not its cost, 
Forecast is all about hyperlocal 
forecasting. You get fast access to 
current conditions, imminent rainfall, 
and predictions for the next week. 
It’s a web app – the sole one included 
here – so visit forecast.io in Safari 
and add it to your Home screen.

Duolingo
 Learning languages can be tricky, 

so this app transforms the process 
into a bite-sized game. Select a 
language from over 20, then work 
your way through exercises that test 
recognition of words and phrases. 
Before long, you’ll favour extending 
your learning streak over wasting 
time on Facebook or Candy Crush.

Runtastic
 Technology has a reputation for 

encouraging a level of exercise that 
might power up your prodding 
finger and little else, yet the iPhone 
is a superb means of getting fitter. 
This app uses the phone’s GPS to log 
activity and give you exciting charts 
to peruse. IAPs add motivational 
stories and training programmes.

Scanbot
 It’s a stretch to argue your iPhone 

can replace a traditional desktop 
scanner, but it’s fine for quick scans. 
This app cleverly detects edges in 
any document you photograph, 
enhances the image, and you can 
share the result. An IAP adds OCR 
and editing tools. Look at Evernote 
Scannable for business cards. 

Overcast 
 Overcast is worth grabbing as an alternative to 

Apple’s Podcasts because it’s packed full of features 
designed to make listening more pleasurable and 
save you a bit of time. Smart filters and per-podcast 
priorities get you to favourite shows first. During 
playback, there’s a lot of magic going on. Adjust the 
speed and things remain audible. Better, if you’re 
listening to a show that has loads of gaps, turn on 
‘smart speed’ to intelligently cut them out — not 
great for comedy, but perfect for technology shows.



29 FREE APPS

Best apps for iPad
For work and play, there are great free apps for your iPad
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Dropbox
 There’s a sense with iCloud Drive 

that Apple’s finally understanding 
some people still need a traditional 
document filing system, and that it 
should be available on iOS. Dropbox 
has been there all along and, frankly, 
we prefer it. It has strong integration 
with a large range of iOS apps, 
optional automatic backing up of 
photos, offline file downloads and, 
perhaps most importantly, simple 
sharing of files using hyperlinks, 
rather than emailing huge documents.

Novation Launchpad
 If you recoil in horror on seeing a piano roll or hearing 

the word ‘MIDI’, you can still create music on your iPad. 
This app has you select from eight free genres and then 
play – and, if you like, record – a mix by tapping on a grid 
to combine loops, sounds and effects. It’s so simple a 
six-month-old can use it (we checked!), and it has scope 
for pros in its £4.99 IAP to import loops and sounds.

Status Board
 Put your idle iPad to good use. This app presents you 

with rearrangeable widgets, which can be set to display 
different kinds of data: calendars, weather, clocks, 
email, Twitter and newsfeeds. A £7.99 IAP provides 
more options (graphs, tables, HTML, photos, text and 
countdowns), yet the basic set is enough to make your 
iPad useful while you’re busy on an adjacent Mac.

Storehouse
 Sharing experiences through photos and videos can be done 

using iCloud Photo Sharing, yet Storehouse provides scope 
for something more exciting. Import a selection of up to 50 
visual treats, tweak the layout and add some text. Your media 
is transformed into a story that can be sent to friends. 
Alternatively, you can create a collaborative ‘space’ in 
Storehouse to work on a story with other people.

Snapseed
 Apple’s iPad App of the Year from 2011 remains a first-rate 

photo editor. The basics involve selecting a tool or filter, then 
dragging across your image to select a property and to adjust 

its value. The result is 
precise and tactile. The 
app recently added the 
concept of Stacks, smart 
layers that enable editing 
or removal of existing 
filters. This is rare in paid 
photo editors for iOS, and 
remarkable in a freebie.

LiquidText
 One of the best things about iOS is being able to directly 

manipulate content, but PDF annotation apps mostly feel like 
they’ve been bussed in from the Mac. LiquidText is different, 
having you define excerpts that are then dragged across to 
a sidebar. These can have notes applied, and be attached 
to each other, which is great for reference and context. 
Documents can be collapsed to view annotations side by side, 
and your highlights and notes can be exported to PDF or RTF.



TouchCast Studio
 This app makes videos people can 

touch. Pick your content – web pages, 
photos, moving footage – then add 
annotations and use studio features, 
such as the built-in teleprompter and 
green-screen effect. Shared videos 
can be explored and interacted with. 
The app’s simple to use, and the iPad 
Pro’s large screen is great for editing.

Paper
 Paper began life as a virtual 

Moleskine notebook, which you’d 
doodle on and later leaf through. 
A recent revamp rethought the app 
as a modern, essential note-taker. 
The sketching tools remain, but you 
can now add text, lists, photos and 
precise lines. Hipsters may sob at 
notebooks being replaced by piles of 
virtual sticky notes that explode into 
a grid when tapped, but this hugely 
boosts productivity: they’re easily 
browsed, rearranged, and exported 
to presentations. As you’d expect on 
the iPad Pro, Paper works very nicely 
with Apple Pencil – or the developer’s 
own older stylus, also called Pencil!

Adobe Comp CC 

Slack
 The simplest of our iPad Pro choices, 

this real-time messaging tool works well 
enough in single-column mode on an 
iPhone – and that’s the point. With the 
iPad Pro’s acres of space, you can run it in 
a Split View column to talk to colleagues 
about work while simultaneously doing 
something else on the rest of the display. 
It’s optimised for full-screen use for those 
moments when you want to focus on it.

Concepts
 With its infinite canvas and rich toolset, 

Concepts helps designers, illustrators and 
architects quickly get ideas down. It looks 
clean and elegant, and offers a range of 
papers, including standard and isometric 
grids. A £5.99 IAP adds precision tools 
with Multi-Touch shape guides, snapping, 
and much more, yet the free version is a 
great start, supporting five layers, loads 
of brushes, and Apple Pencil.

Best apps for iPad Pro
For Apple’s giant tablet, productivity is the goal

 Even as the iPad Pro muscles in on the 
Mac’s turf, Adobe continues to see iOS 
devices as ‘satellites’, with ‘proper’ work 
being done on a Mac. That doesn’t mean 
its relatively simple apps aren’t worth 
space on your iPad Pro. Comp CC lets you 
quickly wireframe layout ideas for print, 
web and mobile. Shapes, placeholders, 

images and text frames can be placed on 
a canvas and quickly manipulated. Smart 
guides and history-scrubbing speeds 
things along nicely, and Pencil owners can 
doodle outlines for elements that the app 
then tidies up. Wireframes can be sent to 
InDesign, Photoshop or Illustrator for 
refinement, or to Photos as flat images.
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29 FREE APPS

Cheatsheet
 Rather than jotting down terrifically 

important notes — Wi-Fi passwords; new 
luggage lock combinations; the Konami 
code — on scraps of easily lost paper, 
use Cheatsheet. A list is created on your 
iPhone — or directly on Apple Watch, 
using dictation —  and looks great in 
the app or glance view, with large icons 
helping your eyes find every fact morsel.

Currency
 Plenty of currency conversion apps 

exist for Apple Watch, but this one 
makes our list due to its efficiency. 
Select currencies on your iPhone and 
they appear on your wrist; changes 
come across instantly. Tap any currency 
to use it (and a specific value) as your 
new base — it’s great when juggling 
unfamiliar notes and coins when abroad.

Find Near Me
 It’s an oddball on the iPhone, but Find 

Near Me is great on Apple Watch for 
locating amenities and pointing you in 
their general direction. There are loads 
of categories, including supermarkets 
and, oddly, zoos; you can also search 
using built-in or dictated terms. To delve 
further, you can have the app display 
contact details, reviews and directions.
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Citymapper
 When you find yourself in 
one of its supported cities, 
Citymapper will give you 
a fighting chance at not 
getting lost and reaching 
wherever you need to be. 
It’ll locate nearby public 
transport, and quickly build 
journeys to ‘home’ and 
‘favorite’ locations, which 
you define in its iPhone app. 
Even on the tiny Apple Watch 
display, you get loads of well 
presented information, such 
as scrolling lists of upcoming 
buses, trains and tubes, 
along with diagrams of the 
current line that helpfully 
point out your location.

Best apps for Apple Watch
For work and play, there are great free apps for your iPad

PCalc Lite
 PCalc’s Apple Watch app may send you 

into Casio-drenched nostalgic bliss.  
It betters any plasticky forebear with its 
smart, responsive interface, in which a 
tip calculator is available from the blue 
button; tip percentage and number of 
guests are elegantly set from the Digital 
Crown. PCalc is £8, yet the Lite version 
generously includes the Watch app!

 This app utilises your Watch’s motion-
tracking capabilities to monitor sleep 
duration and quality. Accuracy will vary 
by individual, but you’re likely to get at 
least basic insight into sleep patterns – 
a boon when you constantly feel tired. 
Its visualisations are straightforward, 
and it includes a Complication for 
getting at details from the watch face.

Sleep++

 Streaks is about forming good habits, 
from walking 10,000 steps to reading for 
half an hour a day. It has tons of presets, 
and you can add your own tasks. Once 
set up, tasks are immediately available 
on your Watch, which shows what’s next 
in a watch face complication. You only 
get six tasks at a time, which we’d argue 
is good for focus rather than limiting.

Streaks
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 Awarded to a 
five-star product 
we believe is truly 
exceptional in its 

category. Given solely at the 
discretion of the Editor.

 Given to a 
hardware or 
software product 
that might not be 

the very best in its category, 
but is a noted for affordability.

 Our group test 
winner gets this 
award for being 
the best of its 

kind when pitted against 
other comparable products.

 The MACFORMAT Awards

 Manifesto – our ratings explained

Our revamped reviews 
help you make more 

informed choices

NEW 
SECTION!

What’s inside 

90–95  
MAC HARDWARE 
 Affordable 3D printing 

and other great kit 

96–99  
GROUP TEST 

 Expand your Mac with 
a Thunderbolt 2 dock

100–101  
MAC SOFTWARE 

 Great apps including 
a new PDF editing tool

102–103  
iOS SOFTWARE 
 View two web pages, 

and analyse your fitness

 Our reviews are totally 
independent; we’re not 
affiliated with Apple or 
anyone else, nor are we 
influenced by advertisers. 
You can trust us to give 
an honest assessment 
of a product’s worth.

The prices quoted for 
products are correct at 
the time of writing and are 

the best we can find from 
a reputable online dealer, 
excluding delivery. 

 A brilliant thing in all regards, 
and worth every penny

 Strongly recommended; any 
flaws are only minor concerns

 Worth considering, though 
there may be better options

 Fundamentally flawed; look 
at alternatives as a priority

 A waste of your money and 
everyone’s time; do not buy!

Contact us

 Email your queries 
and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

 Get the latest 
subscription offers at 

macformat.com

APPLE 
iPHONE 
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APPLE CHOICE Mac Hardware

 We’d normally warn 
you away from 3D 

printers that cost as 
little as this, but we 

were really impressed 
by the da Vinci Jr. Our 
3D printing feature in 

MF290 highlighted 
several affordable 

models – but all cost 
over £1,000. That just 

goes to show what a 
bargain this printer is.

Alex says…

Considering what you get for 
your money, you’ll be hard 
pressed to find a better 3D 
printer at this price point.
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XYZprinting 
da Vinci Jr. 1.0

 £269  FROM XYZprinting, xyzprinting.com
 FEATURES 100-400 micron resolution, enclosed print tray, quick calibration

Super-affordable 3D printing

X
YZprinting has been producing 
budget printers since 2013 and 
unlike other companies that have 

made printers with high print speeds, 
material compatibility and resolutions, 
XYZprinting has strived to make the 
technology accessible and affordable. 

The da Vinci range of printers aims to give 
the less tech savvy user an inexpensive way 
into 3D printing. XYZprinting printers have 
always been exceptionally well designed, with 
fully enclosed cases and a professional finish 
that is in stark contrast to rivals like the (more 
expensive) LulzBot Mini, which still looks 
like it’s been built in a garage. 

The reason that XYZprinting machines 
are so inexpensive is that the company has 
a clear mission to build the best machine 
possible for the price. This means bearings 
will be brass or nylon rather than ball or 
polymer. The hot end where the filament is 
melted will be a basic model and rather than 
using high precision lead screws, threaded 
bolts will be used. There is a careful balance 
to be met between cost and quality and this is 
certainly true with the da Vinci Jr. From the 
outset it proves to be exceptional for the price.

Impressive build quality
This is the smallest and lightest of the firm’s 
printers, but can only really be called ‘Jr.’ 
when compared to the rest of its range. 
Weight-wise, however, it’s quite light at 15kg, 
and carrying the printer is easy enough. 
Its footprint is a manageable 42x43x38cm.

The plastic-formed shell and T-Slot tubed 
interior creates an ultra-solid platform for the 
moving parts. Wobble and vibration can be a 
major issue for 3D printers, so the more solid 
the frame the better the print – something the 

manufacturer has evidently considered. The 
solid top, sides and base ensure there’s no way 
stray fingers can get burned. On the side of 
the printer is the USB port for firmware 
updates and tethered printing. It’s only 
designed to print using PLA filament, and 
this is supplied by XYZprinting at a 
competitive price. On the inside left is the 
filament reel, and on the front-mounted 
control panel is a small LCD to show menu 
options and a handy navigation pad, along 
with an SD card slot for card printing.

All that’s required prior to the first print 
is the installation of the filament reel – five 
minutes later (once the machine finishes the 
commissioning process) you’re good to go. 
It’s very much a step-by-step process and far 
easier than many other similar systems.

The XYZprinting software is required to 
print; you can get it from the manufacturer’s 
website at the same time as the models. The 
controls for the software are incredibly easy, 
with simple sliders enabling you to move the 
model around the build area.

After a five minute warm-up, our selected 
test print began. It took just under an hour to 

Reviewed by ALI JENNINGS



XYZprinting da Vinci Jr. 1.0 APPLE CHOICE

 Not the best print 
resolution, but its 
design and ease 
of use offers a solid 
introduction to 
3D printing.

 Affordable
 Reliable
 Great software
 Low resolution

VERDICT

The da Vinci Jr. is a real looker 
of a 3D printer, unlike many of 
its more spartan rivals.
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print and the resulting model  showed a very 
capable printer. The printer’s low resolution 
does mean that ridges from the layers are 
pronounced, but overlook this and the actual 
extrusion is precise, resulting in clean models 
with few signs of common issues like under-
extrusion, stringing or warping. The factory 
calibration for the printer was spot on with no 
adjustment or fiddling required.

Small print
As a budget 3D printer, nothing really comes 
close to the quality build and well-considered 
print process of the da Vinci Jr. Its software 
does the job perfectly, enabling the easy 
opening and export of models for printing. 
And with its safe, robust design, this is a 
printer you will be happy to let kids use.

Print quality at this price is good, but 
don’t expect the detailed models of the 
Ultimaker series. Models are well rendered 
and although layering is visible, detail, edges 
and corners are all clearly defined. If you 
want a refined model with smooth surfaces, 
you’re going to have to spend more time on the 
finish. The da Vinci Jr. is also limited by the 

materials it is capable of printing, and 
although this isn’t a huge issue the present 
range of PLA filament supplied by 
XYZprinting is limited. It’s also sizable, so 
while it will fit on a desktop, it will require a 
little more space than other small-footprint 
3D printers such as the MakerBot Mini. 

We feel that the pre-calibrated print bed, 
choice of direct SD card or tethered printing 
and easy-to-use software make it an ideal first 
printer. Reservations are only highlighted 
when the print resolution is taken into 
account, as although the prints are good 
(especially when it comes to accuracy), when 
you compare the models to those from other 
printers, you do feel that the print resolution 
could have been a bit higher. 

If you’re looking for a budget, fuss-free 
3D printer for your Mac that produces good, 
accurate prints (albeit at a low resolution), 
then you really can’t do better at present than 
the da Vinci Jr. The ease of use and enclosed 
case design make it an ideal, inexpensive 
choice for education, but if you want more 
refined prints then you’re better off saving 
your money for a higher-end 3D printer.

Ultimaker 2 Go 
£892

SPECIFICATIONS 
 FROM ultimaker.com  
  12x12x11.5cm maximum 
print dimensions
 2.85mm filament diameter 
 260̊ C maximum hotend temp 
 Works with PLA print materials 
  20-micron resolution
 SD card reader

Ooznest Prusa i3 
£475

SPECIFICATIONS 
 FROM ooznest.co.uk  
  20x20x17.5cm maximum 
print dimensions
 1.75mm filament diameter 
  295 C̊ maximum hotend temp
  Works with ABS and PLA 
print materials
  100 to 300 microns resolution 
 USB and SD card reader

ALTERNATIVE CHOICES
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Quarter

HP Envy 4520

Look, a MagSafe battery pack!

Smart looks, but expensive ink

W
hen travelling with 
your Apple gear, 
you can get tied 

down with cables. This 
battery pack, which gives 
any iPhone more than a full 
charge from its USB port, can 
itself be charged up using a 
MagSafe 2 power adaptor.

Quarter can take high 
power throughput, so it can 
be fully charged from a power 
outlet in 45 minutes. In fact, it 
takes just 15 minutes to charge 
enough to take an iPhone 5s 
from 0 to 100%. So, you’ll have 
one less cable to carry, and 
spend less time charging. It 
can also be used as an adaptor 

T
his is one of the 
most affordable 
multifunction 

printers available, yet it 
still has a good range of 
features – including 
AirPrint for iOS devices.

It’s neatly designed, and 
the low-profile unit stands 
just 128mm tall on your desk. 
Despite its low cost, the Envy 
4520 includes printer, scanner 
and copier functions, along 
with both USB and Wi-Fi 
connectivity, two-sided 
printing, AirPrint and HP’s 
ePrint for non-Apple devices.

It’s quite speedy for such 
a low-cost device, printing 10 

to power a 12-inch MacBook 
from a MagSafe charger, since 
its USB port can output the 
2.1A the MacBook needs (it’s 
also suitable for charging an 
iPad). There’s an optional 
MagSafe car charger, too.

Quarter worked great for 
us; it was fast to juice up an 
iPhone 6s Plus, and it really 
does charge quickly over 
MagSafe. Some people have 
reported that it gets overly hot 
when charging, though we 

pages per minute for text files, 
4.5ppm for colour graphics, 
and taking just 50 seconds to 
print a glossy 4x6-inch photo. 
Print quality is good, with 
smooth text output and strong 
colours on our photo prints.

As always with low-cost 
printers, though, you have 
to watch out for the cost of 
replacement ink. The supplied 
black ink cartridge lasts for 
just 190 pages, which works 
out at a hefty 5.8p per page, 

 A great portable 
battery pack for  

your devices – and it 
comes with MagSafe!

 Fast charging 
 Larger capacity?

 A well designed 
printer, but you 

should shop around 
for the cartridges.

 AirPrint capable
 Expensive inks

VERDICT

VERDICT

 $50 (about £35)  FROM Beaver Electronics, thebeaver.cn  
 FEATURES 5,000mAh battery, MagSafe, USB and Micro-USB

 £50  FROM HP, hp.com  FEATURES 1200x1200dpi prints 
and scans, 100-sheet input tray with duplex printing  

didn’t experience this – and 
it stops drawing power once 
full, in any case.

The aluminium is finished 
to a really high quality, but a 
tad heavy. We’d like a higher 
capacity with a second USB 
port, but maybe we’re greedy.

Our big concern is that 
Apple may stop sales of the 
device, but the manufacturer 
is confident that will not 
happen. Time will tell!  
MATT BOLTON

although the coloured ink 
cartridge comes to a more 
reasonable 8p per page.  
HP’s high-yield cartridges 
reduce those prices a little, 
but they’re still costly.

There are rival printers 
that provide lower running 
costs – especially if you 
mostly just need to print 
simple text documents – so 
make sure you check out the 
competition before buying.
CLIFF JOSEPH

 macformat.com  @macformat

The inclusion of 
AirPrint is a nice boon 
for your iOS devices.

The Quarter looks  
at home among your 

aluminium Apple products.
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The Theta S makes taking virtual reality images discreet.
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Ricoh Theta S
Take virtual reality photos and videos 
with this one-shot 360° camera

 £299  FROM Ricoh, theta360.com 
 RESOLUTIONS 5376x2688 (photos), 1920x960 (spherical panoramic video) 
 STORAGE 8GB (built-in)  CONNECTIVITY USB, Wi-Fi

T
his is the year of panoramas. 
Trust us, the virtual reality 
planets are aligning. A number of 

‘VR’ cameras have become available recently, 
but Ricoh’s new Theta S is the easiest and 
most flexible 360° panoramic camera 
currently available. It’s a slim black device 
with two bulbous fisheye lenses, positioned 
opposite each other. Expect jokes about the 
Men in Black Neuralyzer device when you 
use it, and expect utter incredulity when you 
show people the results. Push the button 
that sits under your thumb and a complete 
‘spherical’ (all the way up and down, as well 
as around) 360° photo is taken in one go, or 
a spherical video starts recording. It really is 
as simple as that, although the smartest bit is 
how the device pinches itself out of the bottom 
of the shot; look down in any photo or video 
and you’ll see your hand, rather than the sides 
of the camera.

If you want more control over shutter 
priority, ISO, white balance, EV adjustment 
and so on, or you want to use a tripod so as 
not to see your hand in shots, companion apps 
for iOS and Android fulfil that duty. A button 
on the camera’s side sets up its own Wi-Fi 
network; connect your iOS device to that and 
you’re ready. As well as control over shooting 
settings from your iPhone, the app shows a 
live view of what the camera sees, and shots 
can be automatically transferred to your iOS 
device as they’re taken.

The Theta S’s fixed focus ranges from 
just a few centimetres all the way to infinity, 
so you can use it to take shots practically 
anywhere it will fit, including your mouth if 
you fancy seeing your teeth from that vantage 
point. The device is aware of which way up 
you’re holding it, so there’s no need to worry 
about holding it straight. It performs better 

 The easiest way to 
capture VR photos 

and videos, with good 
output. Theta S is the 

best option in its price 
range and far simpler 
to use than its rivals.

 Spherical VR capture
 Incredibly easy to use

 Remote control app
 Image quality could 

be sharper

VERDICT

The Theta S’s 
fixed focus 
from a few 

centimetres to 
infinity means 

you can take 
shots almost 

anywhere it fits

Reviewed by KEITH MARTIN

than previous Theta models in low light, so 
much that we’ve captured pleasing shots in a 
candlelit corner of a pub, but, unsurprisingly, 
it still works better in well-lit scenes.

Sphere of influence
The two fisheye lenses capture half the scene 
each and the results are merged automatically 
for photos. The edges are blended almost 
perfectly, although slight alignment hiccups 
can sometimes be seen near where the Theta 
has removed itself. These panoramas sound 
large at 5376x2688 pixels, but remember you 
only look at part of the complete scene at once; 
viewed full-screen on your Mac, the results 
will be a bit soft. The 360° video is saved 
unmerged, but the phone app displays it 
correctly, and a free Mac app converts it for 
YouTube’s interactive 360° display.

The Theta S is not a pro-level panoramic 
device, but those cost many times more. 
It delivers higher image quality and longer 
video recording than the previous model, it’s 
astoundingly easy to use, and it’s better than 
anything else around the same price.
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Parrot Bebop 2
All jazzed up for better flying time

I
f you’re looking to 
expand your Mac’s 
storage without a 

performance penalty, then 
on the surface an external 
Thunderbolt drive with 
1TB SSD sounds perfect.  
It better be, though – seeing 
as you can now purchase a 
960GB SSD drive and USB 3.0 
enclosure for around £200.

Transcend’s StoreJet 500 
series has both USB 3.0 and 
Thunderbolt. We tested both 
interfaces using QuickBench, 
and while Thunderbolt was 

W
e were huge fans of 
the 2014’s Bebop 
drone, the first 

‘home’ model to really 
capture our attention, but 
there was plenty of room 
for improvement.

The Bebop 2 had to do 
one thing above all others: 
squeeze some more life out of 
the battery. Any prospective 
drone owner knows that 
powering four propellers 
means just a few minutes of 
battery life, and the original 
Bebop couldn’t even make 15 
minutes. We got closer to the 
quoted 24 minutes with its 
successor, and where battery 

quicker by up to 40MB/sec in 
the standard tests, the USB 
port not only matched its 
write speeds (289MB/sec), 
but actually outperformed 
Thunderbolt in the read tests 
(421MB/sec and 435MB/sec 
versus 387MB/sec and  
391MB/sec, respectively).

We’ve seen this difference 
between the two port types 
before, with a portable drive 
from Elgato (see MF270). 
However, this just serves as 

technology is at present you 
can’t really expect much 
more. In fact, those extra 
few minutes makes all the 
difference to your enjoyment 
as it feels like you’ve been 
flying it for much longer. 
The other boon is the much 
improved clasp for holding 
the battery place. All too 
easily the previous strap 
mechanism would come 
loose, and it never really 
fitted together snugly either.

 Fast, but most 
people will be better 

off saving money 
with a USB-only SSD.

 Smart, sleek, sturdy
 Performs worse 

over Thunderbolt

 A much improved 
Bebop, but we still 

had a few problems 
with our unit.

 More battery life!
  Connectivity issues

VERDICT

VERDICT

 £440  FROM Parrot, parrot.com/uk
 FEATURES 14-megapixel camera, 1080p video, 300m range

encouragement to avoid the 
Thunderbolt premium if your 
Mac has USB 3.0, and to buy 
or build a USB-only SSD.

These speeds are still 
much quicker than traditional 
hard drives, but are eclipsed 
by our 2012 Mac mini’s 256GB 
SSD. And that’s the rub: 
performance is good enough 
to run apps and even virtual 
machines, but it’s not worth 
the hefty premium just for 
Thunderbolt. NICK PEERS

Another welcome physical 
tweak is the quick propeller 
locking system (just twist into 
place with the provided tool), 
but it seemed to be a bit fussy 
about which propellers in the 
box fitted well! 

Flying was just as good 
as the first Bebop until we 
experienced odd glitches in 
the Wi-Fi connection, which 
is a little unsettling when the 
drone is over 100m from you!
CHRISTIAN HALL

 macformat.com  @macformat

Compact, lightweight and 
simply a joy to use – if the 
connection stays, that is! 

The StoreJet’s design is 
sleek, yet sturdy enough 
to survive some shocks.

Transcend 
StoreJet 500 1TB
Exposes a Thunderbolt weakness
 £436  FROM Transcend, transcend-info.com
 FEATURES Thunderbolt and USB 3.0 ports (bus-powered)
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VERDICT
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 There’s more power and control, yet also a 
bulkier feel and a lack of iOS integration. Great 
for a hardcore user, though good for anyone.

 The bulge looks a bit daft, yet this case has 
enough juice to eliminate most battery anxiety.
Of course, go Mophie if you need more power.

Apple iPhone 6s 
Smart Battery Case

Mophie Juice  
Pack Air

Lower capacity, but it may be enough Positively packed with power

 £79  FROM Apple, apple.com/uk  
 NEEDS iPhone 6 or 6s

 £63  FROM mophie, uk.mophie.com  
 NEEDS iPhone 6 or 6s (also available for other models)

Battery life and charging 
The battery in this case is 2,750mAh, which is plenty 
on top of the iPhone 6’s 1,810mAh and 1,715mAh in the 6s. 
A switch toggles the battery on or off; with care and 
understanding, you can use this to power your phone for 
even longer. Four LEDs on the back show the power level.

Connection 
Mophie’s case uses Micro-USB, which is inexpensive 
compared to Lightning cables. You can also buy a £40 
dock to drop the whole thing into easily. The case comes 
with an adaptor to let you connect any headphones.

Ease of fitting 
Apple has made much of how easy it is to slip an iPhone 
into its case, yet Mophie’s system is hardly arduous. Pull 
the top off, slide in your phone (we’d prefer a soft lining), 
and then click the top back on. It can be stiff, but it’s fine.

Comfort and finish 
Mophie’s case definitely adds heft to your iPhone – they 
weigh a combined 241g – and bulk. Indeed, unless you 
have big hands, the added width makes it even harder to 
hold on to your iPhone. It’s available in nine colours, and 
it’s well made, but the finish acquires a few fingerprints.

Battery life and charging 
This case’s 1,877mAh battery about doubles your iPhone’s 

capacity. Battery physics means this doesn’t always double 
battery life, but it was enough to alleviate our anxiety, even 

on long, busy days. Close integration with iOS puts its 
charge status on the Lock screen and in Today view.

Connection 
The use of a Lightning port is of little consequence if you 

charge your iPhone using a cable, and if your bedside dock 
has Lightning, popping your encased phone on it is a boon. 

EarPods fit okay. Others may struggle; there’s no adaptor.

Ease of fitting 
There’s a knack to slipping your iPhone in and out of this 

case, but it’s easy once you’ve got it, and the soft lining 
means you won’t worry about scratching your phone in 

the process. The fit on your phone feels snug and secure. 

Comfort and finish 
This case feels great in the hand – there’s lots of friction – 

and the bulge on the back actually provides a nice grip and 
rest points. The buttons feel nicer than Mophie’s too, 

though the silicone can attract dust. It takes your phone’s 
total weight to 244g. It only comes in grey or white.

R
ev

ie
w

ed
 b

y 
C

H
R

IS
T

O
P

H
E

R
 P

H
IN



APPLE CHOICE Group Test

96 | MACFORMAT | MARCH 2016  macformat.com  @macformat

THUNDERBOLT  
All these docks expand what you 

can connect to your Mac, but 
which should you pick?

Reviewed by ALAN STONEBRIDGE

T
hunderbolt docks are one of the 
most exciting things you can add 
to your Mac, not so much because 

of what they do on their own but because 
they enable you to do a great deal more 
through a single port on your computer. 
Such is Thunderbolt’s versatility that you 
can use a dock to add USB 3.0 to the earliest 
Thunderbolt-equipped Macs, or connect a 
Mac to a network using a cable where Wi-Fi 
isn’t an option, or get more life out of your 
legacy FireWire devices. 

Since we last tested Thunderbolt 2 docks 
(see MF285), additional models have become 
available, replete with tantalising features 
that put the high bandwidth connection to 
even greater use. Three of the models in this 
group test – those from Akitio, OWC and 
Sonnet – are new to us. One of them adds a 
whopping five USB 3.0 ports to your Mac, 

while another contains a bay for an optical 
drive and two bays into which you can install 
2.5-inch hard drives or solid-state drives, 
reducing the number of cables that trail 
around your desk if you need to connect more 
than one of these to your Mac (bear in mind, 
though, that each of these docks uses an 
external power supply, so you’ll need a plug 
socket for that). These models are up against 
the best of last year’s round-up: the docks 
from Elgato, CalDigit and StarTech.

Thunderbolt docks aren’t inexpensive, 
and you may be wondering what could justify 
spending so much on one. Ports aside, you can 
connect and disconnect a single cable as you 
come and go with a MacBook, quickly making 
your peripherals available each time you plug 
in. Also, you’ll need a Thunderbolt 2 model, 
rather than one for the original spec, if you 
want to daisy-chain a 4K display from a dock.

How we tested
 Due to USB 3.0’s 

popularity, we tested 
transfer rates on all 
such ports to check for 
performance variations, 
using a Samsung 850 
Evo SSD in a StarTech 
enclosure. On top of 
checking hardware 
features, we looked at  
differences in supplied 
software, and we tested 
Sonnet’s internal drive 
bays using the supplied 
512GB Crucial BX100 
SSDs, both as individual 
drives and configured 
as a striped RAID array 
to boost performance.

DOCKS ON TEST…
 Akitio Thunder2 Dock 
  CalDigit Thunderbolt Station 2
 Elgato Thunderbolt 2 Dock 
 OWC Thunderbolt 2 Dock
 Sonnet Technology Echo 15+ Thunderbolt 2 Dock
 StarTech.com Thunderbolt 2 Docking Station
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 2 DOCKS

Things to consider… Higher…
 Sonnet’s Echo 15+ is 

undoubtedly the king 
where the number of 
ports is concerned. 
There’s even room 
inside for two SSDs!

…or lower?
 Elgato and CalDigit 

offer fewer, less capable 
connections, but at a 
keen price. They even 
provide ejection tools, 
which many docks lack.

Everything you need to know before getting started

1 USB 3.0 ports
If Apple’s penchant for putting ports on 

the back of desktop Macs grates when using a 
portable drive, a dock with a USB 3.0 port on its 
front will appeal. Some docks are smart enough 
to charge devices even without a Mac present.

2 Backwards compatibility
Unless you find an absolute bargain on a 

first-generation Thunderbolt dock, it’s now best 
to buy a Thunderbolt 2 model. It will work with 
older Thunderbolt Macs, and you’ll future-proof 
your investment in the even that you upgrade 
your Mac and want to add a 4K display to it.

3 FireWire 800
Though a dedicated FireWire adaptor will 

cost you £25, it won’t have a passthrough port 
for a display or other devices. If you need it, 
check out docks with built-in FireWire to avoid 
sacrificing further expansion opportunities.

4 A Thunderbolt cable
Carefully check the dock you’re buying 

includes a Thunderbolt cable. Some of our 
contenders are available with or without one. 
Since it’s unlikely you’ll have one spare, we’ve 
rated based on prices with one where possible; 
OWC‘s dock doesn’t come with one, though.
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 If an ample supply of USB 3.0 ports is your priority, take note 
of OWC’s dock, which leads the pack with five of them. Rather 
than having any on the front, two are on the right side, which 
might be beneficial on a shallow or cluttered desk.

Sonnet and StarTech give you four USB 3.0 ports, evenly 
split between front and back on the former, and just one up 
front on the latter. CalDigit and Elgato also put one USB port 
on the front of their docks – great for connecting a thumb 
drive. Akitio is stingiest, with two USB ports on its right side.

We saw only small variations in transfer rates in our 
testing of USB 3.0 ports. Notably, even the best transfer rate of 
359MB/sec when reading from an SSD (connected to Sonnet’s 
dock) is worse than the rate of 434.7MB/sec we got from the 
drive when it was connected directly to our MacBook Pro.

Several docks will keep charging iPhones and iPads when 
your Mac is powered down or disconnected. This doesn’t 
always work on every port, though – see the table opposite.

If you need FireWire 800, Akitio, OWC and Sonnet provide 
one such port. On the docks that have eSATA, you might use 
that port to get better transfer rates from older drives on which 
performance is normally inhibited over USB 2.0 and FireWire.

All except Akitio’s and Sonnet’s docks have an HDMI 1.4b 
port, which can run a 4K display at just 30Hz. The second 
Thunderbolt 2 port is a better option for 4K, if your display 
has a mini or full-size DisplayPort and can accept 60Hz input. 

The ability to run two displays off docks that include HDMI 
depends on your Mac’s graphics processor, and there are 
limitations on display types and resolutions you can use 
together; read guidance that’s given on manufacturers’ sites.

Akitio’s dock is focussed on storage connections; it lacks 
Ethernet, HDMI and 3.5mm audio ports. Sonnet’s dock is at 
the other extreme, and is only bested by OWC for USB 3.0 
ports. You can consolidate storage and an optical drive inside. 
Its internal bays gave good peak transfer rates of 778.8MB/sec 
and 718.4MB/sec when reading and writing data, respectively.

 Elgato, OWC and StarTech use a low-profile, bar-like design. 
They and Akitio’s dock fit well with the Mac aesthetic, while 
CalDigit and Sonnet have a heat sink-like appearance that’s 
attractive in its own way. However, it’s ironic that the cooling 
fan in Sonnet’s dock emits a light whir; music will drown it 
out, but it’s less than ideal if you prefer silence. Sonnet’s dock 
is larger than a Mac mini, so bear that in mind if desk space is 
limited. All the others are short enough to tuck under an iMac. 
CalDigit’s dock stands tall by default, yet it comes with rubber 
feet in case you want to lie it down. Akitio’s dock has ports on 
three sides, and so it looks unappealing with cables trailing 
away from it.

 CalDigit, Elgato and Sonnet provide 
a menu bar utility to eject all storage, 
so you can quickly leave with your 
MacBook. CalDigit’s thoughtfully 
allows individual drive ejection.

Sonnet’s Echo 15+ hardware offers 
something quite different to other 
docks. It can be bought in various 

optical, hard and solid-state drive configurations; ours came 
with a Blu-ray writer, and two Crucial BX100 SSDs that, when 
set up as a striped RAID array, gave impressive mean average 
transfer rates of 7XXMB/sec when reading and 7XXMB/sec 
when writing. Blu-ray models include playback software  
(bit.ly/mfblu), which worked fine with the discs we tested.

Akitio, OWC and StarTech do not provide an ejection tool, 
and they don’t have any standout hardware features, which is 
the sole reason for their low ratings in this test.

TEST RESULTS

TEST RESULTS

TEST RESULTS

Test 1 Design

Test 3 Extra features

Test 2 Expansion ports
How well do they fit on your desk?

Which docks go beyond the basics?

The all-important factor in any dock

Akitio 

CalDigit 

Elgato   

OWC   

Sonnet   

StarTech.com   

Akitio 

CalDigit 

Elgato   

OWC   

Sonnet   

StarTech.com   

Akitio 

CalDigit 

Elgato   

OWC   

Sonnet   

StarTech.com   

It’s worth noting that some docks 
charge USB devices, such as iPhones, 
even when disconnected from your Mac



 How 
do they 
compare?

 I’m tempted by the 

Echo 15+ thanks to it 

doubling as a drive 

enclosure. Viewing it 

that way helps to justify 

its price, and I could fit 

a couple of SSDs inside 

as they become more 

affordable. I would’ve 

liked the option of 

fitting one or two more 

hard or solid-state 

drives in place of an 

optical drive (films on 

discs are a thing of the 

past for me) in order to 

store my Time Machine 

backups in there too.

Alex says…

Thunderbolt 2 Docks APPLE CHOICE

unpowered hub to it for 
self-powered devices.

Sonnet deserves a 
nod for thinking inside 
the box when it comes 
to expansion. Its price 
will put off most people, 
but it’s not unjustified. 
OWC’s effort is good, 
but its lack of a utility to 
eject drives and, more 
so, the omission of a 
Thunderbolt cable both 
stings a little bit.

 THE SPECS AKITIO  CALDIGIT  ELGATO  OWC  SONNET  STARTECH.COM 

PRICE £141 £180 £180 £220 From £408 £192

DIMENSIONS (WxHxD) 15.9x1.8x9.8cm 4.4x13.2x9.9cm 20x2.9x8.9cm 23x2.5x9cm 21x7.7x22.1cm 23.4x3.8x8.2cm

USB 3.0 PORTS Two Three Three Five Four Four

GIGABIT ETHERNET None One One One One One

OTHER DATA PORTS 2x eSATA,  
1x FireWire 800

2x eSATA None 1x FireWire 800 2x eSATA
2x SATA-III
1x FireWire 800

1x eSATA

AUDIO PORTS None 1x stereo output
1x mono input
(both on the front)

1x stereo output
1x mono input
(both on the front)

1x mono input
1x stereo output
(both on the back)

2x inputs
2x outputs
(front and back)

1x input (back)
1x output (front)

USB CHARGE W/O MAC No Yes (front port only) Yes (all three ports) Yes (right ports only) Yes (all four ports) Yes (front port only)

DRIVE EJECTION APP No Yes Yes No Yes No

 DESIGN

  EXPANSION PORTS

 EXTRA FEATURES

 FINAL VERDICT

C
alDigit’s dock stands 
out due to its compact 
form, good enough 

selection of ports, its price, and 
because it shows even greater 
consideration than Sonnet and 
Elgato by allowing you to eject 
a single drive from its menu bar 
utility. So, it ousts Elgato, the 
winner of our last round-up, as 
our dock of choice; its price has 
fallen to match Elgato’s since 
then. However, if you find 
yourself using the cloud more 
than portable drives to move 
files around, and if eSATA 
doesn’t matter to you, Elgato’s 
dock is a fine alternative.

FireWire and eSATA are 
niche now, and USB 3.0 is likely to 
be your priority. CalDigit doesn’t provide the 
greatest quanity of that port type, but when 
added to those on your Mac, you may find it’s 
enough – you could always connect an 

THE WINNER CalDigit
Attractive hardware backed up with considered software

CalDigit’s dock 
stands out for its 

form, ports, price and 
the best software support

CalDigit’s compact dock stands 
upright by default, and includes 
rubber feet so it can lie down.
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Mr Corner

Undertale

Easy shortcuts… but unnecessary

Make friends with monsters

M
r Corner is a little 
utility that kind of 
expands on OS X’s 

Hot Corners concept. Run the 
app, click its menu bar icon 
and you can assign three apps 
to each corner of your screen. 
You can then place the pointer 
over a corner to make icons 
for its assigned apps appear, 
and click one to open that app. 
You can also add folders or 
files for quick access to them: 
in the app, just drag whatever 
you want in from Finder.

If you’re now thinking 
“But I can just put these 
things in the Dock”, well, 
yeah – you can. Actually, 

U
ndertale is a role-
playing game that 
plays on your 

expectations and subverts a 
host of gaming tropes; much 
will feel familiar if you’ve ever 
played an RPG. The game’s 
protagonist is a human child, 
and its antagonists are 
increasingly strong monsters. 
Your journey takes you 
through villages populated 
with shops and talkative 
non-combatants, and down 
roads punctuated with 
random encounters.

Some puzzles aren’t meant 
to be solved, even though your 
hand is literally held through 

in some ways putting things 
in the Dock makes them more 
useful than using Mr Corner. 
That’s because in Mr Corner’s 
case, you can only click to 
open the app or folder – you 
can’t drag things into a folder, 
as you can if it’s in the Dock.

That’s not to say there’s no 
merit to the idea: you might 
like to keep a very small, 
select set of apps in the Dock, 
and arrange a few others 
with Mr Corner, grouped for 

the first few. Each monster is 
different from the last, while 
some boss battles can be 
avoided entirely.

Each kind of monster has 
a unique attack; your defence 
is generally to help your soul 
dodge different kinds of 
projectiles. Undertale’s main 
selling point, though, is in 
your choice of how to end the 
encounter. Choose to fight 
and a minigame lets you beat 
down the monster’s health 

 A well-made utility, 
but it just left us 

appreciating how 
useful OS X’s Dock is. 

 Tidies up your Dock…
 …but do you need it?

 A well-written game 
about games that 

avoids the traps of 
similar meta-games.

 Continually funny
 Varied combat

VERDICT

VERDICT

 £7.99  FROM Everyday Tools, apple.co/1ZvJXWB   
 NEEDS OS X 10.10 or higher

 £6.99  FROM tobyfox, undertale.com
 NEEDS OS X 10.6 or higher (patch due for issues with OS X 10.11)

certain tasks. Alternatively,  
you may feel it makes sense to 
keep particular apps in one 
corner – Calendar and other 
productivity apps in the 
top-right corner next to the 
time and Spotlight icons, say.

At its low price, those may 
be compelling enough reasons 
to buy Mr Corner. Otherwise, 
you’re probably better served 
through smarter use of your 
Mac’s Dock instead.
MATT BOLTON

until it dies. Or you can spare 
your foe and convince it not to 
fight: laugh at its jokes, ask it 
to clean you, flirt, and so on.

So much of Undertale’s 
appeal comes from what you 
learn as you play that it’s 
difficult to write about it 
without spoiling that. 
Unsettling but funny, it’s 
great for both genre pros and 
anyone who’s thought about 
what it means to be a hero.
JORDAN ERICA WEBBER

 macformat.com  @macformat

Many of the monsters 
you meet are open to 

long-lasting friendships.

Mr Corner is decent, but 
it’s of limited appeal 

compared to the Dock.
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PDF Expert
The popular PDF app 
finally makes the move 
from iOS to the Mac

 £14.99  FROM Readdle, readdle.com 
 NEEDS OS X 10.10 or higher

M
ac developers have been jumping 
to iOS ever since Apple first 
opened the App Store in 2008, 

but an increasing number of mobile-only 
developers have been doing the opposite 
in recent months. The one with the most 
potential is Readdle, which is already 
synonymous with quality iPhone and iPad 
productivity apps. Its PDF Expert app has 
long been the gold standard for filling in 
forms, or signing or annotating documents 
on iOS devices. A piece of truly impressive 
‘desktop-class’ software, its power and 
performance has finally reached the Mac.

If you’ve used PDF Expert for iOS (or its 
free version, Documents), you already know 
what to expect. Documents open in a flash, 
and even enormous files with high-resolution 
graphics zoom and scroll with buttery 
smoothness. Page refreshes happen so 
quickly that you barely have time to blink. 
Multiple documents can be opened as tabs, 
and you can pick up from the exact page 
where you left off next time the app is opened.

Apple’s built-in Preview already does 
some of this – along with annotation and 

document signing – for free. But, with 
its intuitive user interface, PDF Expert offers 
a more robust solution than Preview and a 
more affordable offering than the reigning 
PDF heavyweight, Adobe Acrobat Pro DC.

Reading the small print
Most of the action is instigated from three 
buttons in the app’s top-left corner: the first 
opens a thumbnail view of the current 
document, where individual or multiple pages 
can be moved, rotated, deleted, or extracted; 
the second reveals a sidebar for browsing 
bookmarks, outlines, or annotations; and 
the third is for editing, and adding text, 
shapes, stamps, or notes. Signatures can be 
added by typing or scribbling on a trackpad, 
but sadly there’s no way to import scans of 
existing signatures for cleaner results – not a 
huge problem, but it’s a noticeable omission.

Other key features missing include inline 
text editing and form creation, both of which 
are promised to be delivered as free updates 
for existing customers. We feel that Readdle 
should also consider advanced object editing, 
audio and video support, and the ability to 
directly scan paper documents into editable 
digital ones, even if those features were to 
require a paid in-app upgrade. They would 
truly make this a PDF powerhouse able to 
compete with Adobe’s top-tier app.

PDF Expert for Mac is every bit as good 
as its sister iOS app, with a slick interface 
and lightning-fast performance. The app is 
already superior to Preview, and all that 
remains are a few additional pro features to 
make it a contender for the throne occupied 
by Adobe’s expensive desktop powerhouse.

 Packed with plenty 
of power, Readdle’s  
app falls just short 
of PDF perfection. 

 Super-fast
 Handoff support 
 Lacks features of 

Adobe Acrobat DC
 Can’t import scans of 

existing signatures

VERDICT

Even high-res 
graphics zoom 

and scroll 
with buttery 
smoothness

Reviewed by J.R. BOOKWALTER

Comparisons let you see 
how your changes are 

altering the original shot.
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HeartWatch

Infuse 4

Keep tabs on your heartbeat

Get networked video on Apple TV

H
eartWatch uses 
data collected 
by your Apple 

Watch’s sensors to keep 
track of your pulse 
throughout the day. 
It splits the day into four 
categories: waking, workout, 
regular (for most of the day) 
and sleep (should you wear 
your Watch in bed).

Data is well presented, 
making it easy to detect 
‘triggers’ of an increased 
pulse. Commute to work on 
the train every day? A quick 
look at your heartbeat during 
that time will show how that 
it affects you, stress-wise. 

W
ith older Apple 
TVs, playing 
content from 

network devices required 
hacky workarounds; 
transcoding ‘servers’, 
iOS apps and AirPlay, or 
jailbreaking. Firecore has 
form in both areas, and now 
brings its smarts to the new 
fourth-gen Apple TV.

The idea is to store video 
anywhere – on a Mac, PC or 
NAS – and stream it to this 
app on your Apple TV. Many 
file formats are supported, 
and the paid ‘pro’ version 
supports cross-device 
syncing of playback position 

Workout data splits your 
heart rates into four coloured 
zones of increasing intensity 
(green, blue, yellow, and red), 
showing how long you’ve 
spent in each zone.

Notifications warn when 
your heart rate exceeds or 
drops below a level you 
specify. You can zoom out 
to a max of 12 weeks to see 

through trakt. The app 
attempts to pretty up your 
files by automatically adding 
cover art and metadata, 
rather than showing a bunch 
of folders and filenames.

When it works, Infuse is 
great, with an interface that‘s 
fast and intuitive, and useful 
options such as continuous 
playback of episodes and the 
means to download subtitles. 
However, this Apple TV 
release feels a bit 1.0. 

 An easy and fun 
way to discover 
what’s stressing 

you out.

 Alerts are useful
 Limited features

 Excellent when it 
works, but connection 

can be a lottery. Try 
the free version first. 

 Gorgeous interface
 Metadata failings

VERDICT

VERDICT

 £1.49  FROM Tantsissa, heartwatch.tantsissa.com 
 MADE FOR iPhone and Apple Watch

 Free/£7.99 for pro version  FROM FireCore, firecore.com 
 MADE FOR Apple TV

your average heart rate, with 
daily high and low figures.

Health data geeks will 
love the app’s meaningful 
visualisations. It’s useful to 
find out how much of gym 
visits were a benefit, and fun 
to see if a meeting really was 
stressful, or how your heart 
responded during a footy 
match. KENNY HEMPHILL

During testing, we had 
numerous connection and 
metadata issues. The latter 
amusingly labelled a home 
movie of a baby and a dog 
playing as Edge of Darkness. 
The former can be plain 
infuriating, occurring when 
we logged in to local shares 
or reconnected to locations 
we’d bookmarked. This is 
doubly infuriating given Plex 
for Apple TV is fast to set up. 
CRAIG GRANNELL

HeartWatch’s heart 
rate visualisations 

are easy to interpret.

Infuse 4’s interface makes 
all your boring video files 
look amazing.
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Sidefari

Firefox

See double with Safari

Smarter searching… but that’s it

B
y now, you’re 
probably familiar 
with Split View on 

the iPad Air 2, iPad mini 4 
and iPad Pro, which puts 
two apps side by side. 
Though it’s a great feature, 
it doesn’t enable you to run 
two instances of the same app 
next to each other, such as two 
Safari tabs.

Sidefari is an inexpensive 
way around this shortcoming. 
It makes cunning use of Safari 
View Controller, the ‘in-app’ 
browser Apple provides to 
developers, which you’ve 
likely spotted in third-party 
apps already.

A
fter years of 
resistance, Firefox 
has joined iOS 

properly with an all-new 
mobile browser. A lot of its 
features are familiar – tabbed 
browsing, smart search, 
a reading view to strip away 
fluff from sites, easy-to-find 
top sites – and it’s a fairly slick 
package. To displace Safari, 
though, you need something 
more than ‘being quite nice’ 
to tempt people. 

If you use Firefox for Mac, 
the tempting feature might be 
cloud syncing through a 
Firefox account, but for us the 
best feature is the great search 

Fire up Safari, then open 
Sidefari in Split View, activate 
the Safari ‘Send to Sidefari’ 
Share sheet extension, and 
you’ll then be able to view two 
web pages next to each other, 
as well as send links between 
the two apps. Sidefari also 
works with installed content 
blockers and retains its own 
history. Additionally, there’s 
a ‘modal’ view in apps that 
support it, which loads a page 
in an overlay window without 

layout. When you tap the 
address field and then type 
a search term, a toolbar of 
site logos appears above the 
keyboard. You can tap any 
logo to immediately search 
using that site – whether it’s 
an alternative search engine 
or Amazon, Twitter and 
Wikipedia. Firefox also shows 
suggestions of possible search 
terms in a neater way than 
Safari, displaying lots of them 
as buttons at the top, instead 

 An elegant and 
affordable way to 

view two web pages 
at once on your iPad.

 Fab on larger iPads
 Does little on iPhone

 Clear and smooth, 
with a great search 

screen – but without 
the extras we love.

 Fantastic search field
 Lacks power features

VERDICT

VERDICT

 79p  FROM Francisco Cantu, macrecon.com  
 MADE FOR iPhone, iPod touch, iPad

 Free  FROM Mozilla, mozilla.org  
 MADE FOR iPhone, iPod touch, iPad

exiting the current app (even 
on iPhone), though this is less 
useful than Split View mode.

It’s worth noting Sidefari 
isn’t Safari. It lacks tabs, can’t 
access Safari’s bookmarks, 
and doesn’t enable you to 
manually edit its address bar. 
However, at this price it’s an 
affordable way of plugging a 
gap Apple should have filled 
itself, until such point as 
engineers in Cupertino see fit 
to do so. CRAIG GRANNELL

of as a space-filling list.  
It’s a really cool setup.

However, that’s really 
Firefox’s standout feature, 
and the browser currently 
lacks the power user extras 
that make Chrome a viable 
Safari alternative, such as 
an easy Reopen Closed Tab 
option. There’s no support 
for 3D Touch, and some of the 
interface elements are quite 
small, even on a 6s Plus. 
MATT BOLTON

Sidefari is affordable and 
integrates well with iOS.

Firefox’s search (left) is brilliant, 
but the rest isn’t quite that good.
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 Ever since the famous Bondi Blue iMac debuted 
way back in August 1998, Apple’s all-in-one 
desktop computer has been setting standards 
in gorgeous design and powerful performance. 
Apple’s spirit of innovation was as clear back then 
as it is today – the iMac was the first Macintosh to 
abandon the floppy disk in favour of USB ports, 
and its bright, colourful aesthetic set it apart as a 
playful pretender in a world of staid beige boxes.

These days Apple is again pushing boundaries 
with the iMac, blessing all of its 27-inch models 
with the world’s best display, which has a massive 
5K (5120x2880) resolution. Add in a quad-core 
Intel Core i5 processor (configurable from 3.2GHz 
up to 4.0GHz), 8GB of RAM, a fast and capacious 
Fusion Drive, and a powerful AMD Radeon R9 
graphics processor – and the large iMac is the 
desktop system to own. In 2015, Apple lowered the 
price of the top-spec 27-inch model by £150 and 
introduced the first 21.5-inch iMac with a Retina 
4K display. All iMacs (except the entry-level, 
21.5-inch model) have a quad-core processor.

 MODEL  KEY SPECIFICATIONS  PRICE

21.5-inch 
2.8GHz  
quad-core  
Intel Core i5

RAM 8GB of 1867MHz LPDDR3
GRAPHICS Intel Iris Pro Graphics 6200
STORAGE 1TB (5,400rpm)
DISPLAY 1920x1080 (IPS, sRGB gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,049

21.5-inch 
3.1GHz  
dual-core  
Intel Core i5

RAM 8GB of 1867MHz LPDDR3
GRAPHICS Intel Iris Pro Graphics 6200
STORAGE 1TB (5,400rpm)
DISPLAY Retina 4K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,199

27-inch 
3.3GHz  
quad-core  
Intel Core i5

RAM 8GB of 1867MHz DDR3
GRAPHICS AMD Radeon R9 M395
STORAGE 2TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,849

 iMac

 Choose an iMac

  Inside your buying guide…

 Who’s it for?
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W
elcome to MacFormat’s new-look Store Guide, the place to go 
to find out about all the Apple kit that matters. We’ve chosen 
our top products from Apple’s product line-up, plus the best 

third-party kit that meets our quality standard.
This month we’ve updated our Thunderbolt 2 dock and iPhone battery 

case picks in light of reviews in this issue, so turn to pages 95 and 96 for the 
low-down on those fantastic accessories to complement your Apple gear. 
We’ve also added helpful icons to point out which categories have been 
updated each month, so you know you’re always up to date on the latest 
hot new kit from the world of Apple and beyond. 

Your complete guide to the 
best Apple hardware and 
third-party accessories

EDITED BY ALEX BLAKE 
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ENTRY LEVEL
 You’re just getting 

started in the world 
of Apple and need to 
know where to begin.

UPGRADER
 A firm Apple user, 

you’re ready to move 
on and get even more 
from your tech.

HIGH END
 Apple is your life. 

You prize quality and 
want the best that 
money can buy.

UPDATED
OCT 2015

EXPECTED
LATE 2016
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 The baby of Apple’s laptop family, 
the MacBook is a marvel of compact 
design and ultra-portability. Weighing 
in at just 0.92kg, it’s Apple’s most 
lightweight laptop and easily stows 
away in a backpack for use on the 
move. The pixel density of its 12-inch 
Retina display stands at 226ppi, which 
is almost as high as the MacBook Pro.

The MacBook is powered by an Intel 
Core M processor (at 1.1GHz, 1.2GHz or 
1.3GHz), which doesn’t require a fan to 
keep cool, so the MacBook runs silently. 
It was also the first Apple notebook 
to feature a Force Touch trackpad, 
which can trigger different responses 
as you apply more pressure. All models 
come with 8GB of RAM and Intel HD 
Graphics 5300, while there are options 
for either 256GB or 512GB of flash 
storage. It’s available in three colour 
options: Silver, Space Grey and Gold. 

 Following hot on the heels of the 
MacBook, the MacBook Pro recently 
gained a Force Touch trackpad. At the 
same time, the MacBook Pro range saw 
small boosts to its Intel and graphics 
processors. The top-of-the-line model 
is currently the only one to offer a 
discrete graphics processor, in the form 
of the AMD Radeon R9 M370X – the 
other models have an integrated Intel 
Iris or Iris Pro graphics processor.

All except the entry-level MacBook 
Pro are equipped with a Retina display, 
in either 13-inch or 15-inch sizes. They 
also have two Thunderbolt 2 and two 
USB 3.0 ports, an SDXC card reader, 
and their flash storage ranges from 
128GB to 1TB, depending on the model 
you pick as a starting point. Battery life 
is also improved, with the 13-inch model 
lasting 10 hours and the 15-inch model 
going strong for nine hours.

 If you need power – and we mean 
serious power – this is the computer 
for you. Even the entry-level model 
comes with 12GB of RAM, a quad-core 
3.7GHz processor, 256GB of speedy 
PCIe flash storage and dual AMD 
FIrePro D300 graphics cards. However, 
with a price point to match, it last being 
updated in 2013, and Thunderbolt 3 
just around the corner, consider 
holding out for the next version.

 A welcome update in 2014 brought a 
£100 price drop to the most affordable 
Mac. The mini has some interesting 
talking points: the entry-level model 
has a 1.4GHz dual-core Intel Core i5 
processor and 4GB of RAM, making it 
akin to the entry-level MacBook Air 
but with a 500GB hard drive and no 
display. Higher end models come with 
1TB storage (a Fusion Drive option is 
available), 8GB of RAM, a better 
graphics processor and either a 2.6GHz 
or 2.8GHz Intel Core i5 for £569 and 
£799, respectively. Those models can 
be upgraded to Core i7 processors, 
though there are no quad-core options 
available – you’ll need an iMac for that.

 MODEL  KEY SPECIFICATIONS  PRICE

12-inch 
1.1GHz  
dual-core  
Intel Core M

RAM 8GB of 1600MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 5300
SSD 256GB

£1,049

12-inch 
1.2GHz  
dual-core  
Intel Core M

RAM 8GB of 1600MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 5300
SSD 512GB

£1,299

12-inch 
1.3GHz  
dual-core  
Intel Core M

RAM 8GB of 1600MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 5300
SSD 256GB or 512GB

£1,249 
or 
£1,419

 MODEL  KEY SPECIFICATIONS  PRICE

13-inch 
2.7GHz  
dual-core  
Intel Core i5

RAM 8GB of 1866MHz 
LPDDR3
GRAPHICS Intel Iris 
Graphics 6100
SSD 256GB

£1,199

15-inch 
2.2GHz  
quad-core  
Intel Core i7

RAM 16GB of 1600MHz 
DDR3L
GRAPHICS Intel Iris Pro 
Graphics
SSD 256GB

£1,599

15-inch 
2.5GHz  
quad-core  
Intel Core i7

RAM 16GB of 1600MHz 
DDR3L
GRAPHICS AMD Radeon 
R9 M370X
SSD 512GB

£1,999

 MacBook  MacBook Pro  Mac Pro

 Mac mini
 Choose a MacBook  Choose a MacBook Pro
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From 
£2,499

From 
£399

UPDATED
DEC 2013

EXPECTED
SOON

UPDATED
MAY 2015

EXPECTED
Q2 2016

UPDATED
MAR 2015

EXPECTED
Q2 2016

UPDATED
OCT 2014

EXPECTED
LATE 2016
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 Apple brought 3D Touch to the iPhone 
with the 6s and 6s Plus, providing extra 
interactions depending on the level of 
pressure you apply to the screen. For 
example, a light press on an email lets 
you ‘peek’ at its contents, so you can 
decide whether to delete it or, with a 
firmer press, ‘pop’ it open to reply to it.

The 12MP rear camera produces 
fantastic images, although you only 
get optical image stabilisation on the 
6s Plus. But with support for 4K video 
recording, the 6s camera has been 
taken up a notch. All models have 
front-facing cameras for video calls. 
There’s also Live Photos, which capture 
the moments before and after you take 
a photo to make a short video.

The largest capacity iPhone 6s 
comes with 128GB of storage, twice 
that of the iPhone 6. Avoid the 16GB 
model – that really isn’t enough space.

 Aside from the beautifully gargantuan 
iPad Pro, there was a small but very 
welcome change among Apple’s other 
tablets. The iPad mini 4 was unveiled 
alongside the Pro back in September 
2015, and it’s essentially an iPad Air 2 
in a smaller chassis. The iPad Air 2 
hasn’t changed since late 2014, though.

On the software side, iOS 9 has 
brought multitasking features, which 
are a boon for productivity. You can 
slide a second app over the right side 
of the one you’re working in (great for 
quickly checking email), then dismiss it 
to get back to work. Picture in Picture 
enables you to watch video in a corner 
of the screen – but it may be a bit too 
small on the mini. Those two features 
work on the Air, mini 2 and Pro and 
newer models. There’s also Split View, 
on the Air 2, mini 4 and Pro, which lets 
you work on two apps side by side.

 MODEL  KEY SPECIFICATIONS  PRICE

iPhone 6 CAPACITY 64GB
PROCESSOR A8
3D TOUCH No
CAMERA 8MP photos,  
1080p video recording

£539

iPhone 6s CAPACITY 64GB
PROCESSOR A9
3D TOUCH Yes
CAMERA 12MP photos, 
4K video recording

£619

iPhone 6s 
Plus

CAPACITY: 128GB
PROCESSOR: A9
3D TOUCH Yes
CAMERA 12MP photos,  
4K video recording

£789

 MODEL  KEY SPECIFICATIONS  PRICE

iPad mini 2 CAPACITY 32GB 
PROCESSOR A7
CONNECTIVITY Wi-Fi
CAMERA 5MP
TOUCHID No

£259

iPad Air CAPACITY 32GB
PROCESSOR A7
CONNECTIVITY Wi-Fi
CAMERA 5MP
TOUCHID No

£359

iPad Air 2 CAPACITY 128GB
PROCESSOR A8X
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCHID Yes

£559

 iPhone  iPad

 Choose a iPhone  Choose a iPad
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 The largest iPad packs in a 12.9-inch 
display, and comes in 32GB and 128GB 
capacities. Every model has Wi-Fi, and 
the most costly one also works with 
mobile networks. Its A9X processor is 
the most powerful in any iOS device, 
and it has an impressive four-speaker 
sound system, too. Add the pressure-
sensitive Apple Pencil and it becomes 
an accomplished drawing tool that’s 
surprisingly lightweight for its size.

 Apple’s first foray into the world of 
high fashion certainly turned heads 
when it arrived on the scene. Apple has 
since released a slew of updates in the 
form of watchOS 2, which expands the 
capabilities of third-party apps, as well 
as a range of new case colours and 
strap options (although hardware 
specifications are unchanged). 

Among the new straps are several 
Hermès models, available as Single 
Tour, Double Tour or Cuff bands, and 
Product(RED) and two different white 
versions of the Sport Band. The Watch 
comes in aluminium, stainless steel or 
18-carat gold cases, the first of which 
now has Gold and Rose Gold colours.

 iPad Pro

 Watch

From 
£679

From 
£299

UPDATED
SEPT 2015

EXPECTED
SEPT 2016

UPDATED
SEPT 2015

EXPECTED
Q2 2016

UPDATED
NOV 2015

EXPECTED
2016?

UPDATED
SEPT 2015

EXPECTED
MID 2016?
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 MONITOR

 NETWORK STORAGE

 PRINTER

 ULTRA HD MONITOR

 WIRELESS ROUTER

 MACBOOK STAND/DOCK

 PORTABLE STORAGE

 THUNDERBOLT DOCK

 MACBOOK BAG

ViewSonic VP2772 
£569
viewsonic.com

Western Digital 
My Cloud Mirror £255
wdc.com

Samsung Xpress  
SL-M2026 £50
samsung.co.uk

AOC U3277PQU 
£574
aoc.com

Netgear Nighthawk X4S 
£252
netgear.co.uk

Henge Docks Horizontal 
€449 (about £325)
hengedocks.com

Samsung T1 SSD
From £88
samsung.com

CalDigit Thunderbolt 
Station 2 £180
caldigit.com/uk

Knomo James
£169
knomobags.com

 If you’re not fussed 
about 4K but still want 
exceptional image quality, 
this IPS display is truly 
superb. It offers 99% 
coverage of the Adobe 

RGB colour space, 10-bit colour and a 
2560x1440-pixel resolution. It has HDMI 
1.4, DVI and Mini DisplayPort connections, 
and four USB 3.0 ports for expansion.

 Winner of MF294’s NAS 
group test, the My Cloud 
Mirror provides Apple-like 
ease of use – but it’s no 
Time Capsule knock-off; 
with top performance 

(thrashing its group test rivals when it 
came to writing large files), whisper-quiet 
operation and a good range of features, 
it’s great if you want more from a NAS.

 For simple home printing 
at an affordable price, you 
just can’t beat this mono 
laser printer. For £50, you 
get 20 pages per minute 
printed at great quality, 

plus a rack of eco-friendly options, beating 
its main rivals at this price point. It doesn’t 
print colour, but if that’s not an issue for 
your documents then this is a no-brainer.

 The recent winner of 
our 4K displays group 
test, this 32-inch screen 
is a joy to work with, and 
a monitor of this size is 
the perfect setting for 4K 

to really come into its own. From stunning 
picture quality and top-notch contrast 
ratio to the reasonable price for such a 
wide display, it’s a winner all round.

 This aggressively-named 
router may be expensive, 
but it’s one of the best 
that money can buy. 
Sporting four aerials, the 
Nighthawk boasts four 

separate signals for a total speed of 2.5 
gigabits per second. And with dual-band 
802.11ac Wi-Fi, AirPrint support and an 
excellent app, it’s one powerful router.

 This is a seriously 
powerful dock. With more 
ports than you can shake 
an Apple Pencil at (13, to 
be precise), thermal vents 
to keep your MacBook 

cool, plus an elegantly simple design, it’s 
useful as well as beautiful. You can add up 
to three displays, two audio devices, six 
USB 3.0 devices and much, much more.

 Light, speedy and 
astonishingly small, 
the Samsung T1 is the 
definition of portable SSD 
storage. As well as having 
an attractive design, it is 

among the best-performing drives of its 
kind that we’ve tested, features AES-256 
hardware-based encryption, and is more 
affordable now than when we reviewed it.

 Our MF297 group test 
winner got the nod for its 
beautifully compact form 
and superb menu bar 
tool, which lets you eject 
individual drives as you 

please (something its rivals failed to offer). 
It’s not the most laden with ports, but has 
everything that most people will need, 
and comes in at a great price point.

 A beautifully made bag 
with a surprising amount 
of space inside. You’ll love 
the little touches, such as 
its big chunky zips and 
flashes of colour. It’s easy 

to turn the Knomo James into a smart 
office bag by removing the backpack 
straps, and Knomo provides each bag with 
a tracking ID in case yours goes AWOL.

BEST BUYS… curated picks of third-party kit 

NEW!
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 WIRELESS SPEAKER

 ON-EAR HEADPHONES

 IP CAMERA

 DESKTOP SPEAKER

 IN-EAR HEADPHONES

 iPHONE STAND

 PORTABLE BLUETOOTH SPEAKER

 PORTABLE BATTERY PACK

 APPLE WATCH STAND

Bowers & Wilkins 
Zeppelin Wireless £499
bowers-wilkins.co.uk

Plantronics Backbeat 
Pro £125
plantronics.com

Netgear Arlo
From £180
netgear.co.uk

Roth OLi POWA-5
£200
rothaudio.co.uk

RHA MA 750i
£90
rha-audio.com

Just Mobile AluBolt
£41
just-mobile.com

Kef Muo
£299
kef.com

Apple iPhone 6s Smart 
Battery Case £79
apple.com/uk

Nomad Stand for 
Apple Watch £50
hellonomad.com

 This airship-inspired 
speaker is certainly 
striking, but it’s more than 
just a looker, with crisp, 
clear treble and refined 
bass output over previous 

Zeppelin models. Support for Bluetooth, 
Spotify Connect and AirPlay makes for 
plenty of connectivity, and dynamic EQ 
ensures controlled bass at all volumes.

 Wireless headphones 
are often blighted by 
meagre battery life, but 
not so with these cans, 
which run for more than 
25 hours. They offer 

active noise-cancelling, brilliant wireless 
range, superb comfort and a huge range 
of intuitive touch controls, making these 
the wireless headphones to beat.

 This home security 
system’s cameras are 
totally wireless, enabling 
you to mount them where 
you want; night vision, 
weatherproofing and a 

130° field of vision makes them ideal 
outdoor eyes. Video quality is excellent, 
the cameras look smart, and your footage 
is stored in Netgear’s free cloud storage.

 Just one listen to these 
desktop speakers will tell 
you they’re in a class of 
their own. Their firm bass 
and detailed, rich sound 
packs a punch thanks to 

80W output, and they feature Bluetooth 
streaming and a wide range of analogue 
and digital inputs. Hi-fi quality audio for 
£200? Sounds great to us!

 These in-ear buds 
impress on nearly every 
level. They come with 
easy-to-use inline controls 
and a steel-reinforced 
cable, while faultless low 

and mid range reproduction and a crafted, 
premium feel make them earphones of 
distinction. They are a world away from 
Apple’s cheap earbuds.

 Charge your iPhone in 
style with this simple yet 
elegant stand. From the 
curved backstop to the 
rounded aluminium base, 
it oozes Apple-esque 

design chops and will fit right in among 
your other Apple kit. The Lightning 
connector can be tilted to help mount 
your iPhone on it, which is a nice touch.

 Hi-fi king Kef brings its 
audio know-how to the 
portable speaker world 
and blows away the 
competition. Firm bass, 
a rich, detailed sound 

and sturdy build combine to form one 
impressive package, while you won’t be let 
down by the solid battery life. It’s one of 
the best portable speakers you can buy.

 Despite that silly-looking 
hump on its back, the 
official battery case for 
the iPhone 6 and 6s is 
impressive. It’s easy to fit, 
the buttons feel great, 

and the soft inner lining protects against 
scratches. It isn’t the largest capacity case, 
yet it has more than enough juice for busy 
days, and the bump is surprisingly comfy.

 Nomad’s stand is an 
absolutely gorgeous 
Apple Watch charging 
dock – carved from a 
single piece of curved 
aluminium, it looks like 

it could have been designed by Apple. 
Its weighty base keeps everything in place 
and the cable management is so tidy that 
it looks like there’s no cable there at all.

BEST BUYS… curated picks of third-party kit 

NEW!
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It’s crucial to your Mac and iOS devices, 
but are you using it to the max?

ALSO INSIDE…
 Make more of gestures on your Mac
 Complete guide to the new Apple TV
 40 ways Apple changed the world!
 Make your own AirPlay receiver

GET MORE FROM  

iCLOUD



I JUST CALLED TO SAY…
 In the January issue you gave two 

ways to create a ringtone. On page 33, 
you say “right-click the song again and 
this time choose ‘Create AAC Version’” 
– there’s no such option for me. I can 
create an MP3 version but that doesn’t 
work. On page 49, you say “Open 
GarageBand’s Media Browser using 
the icon of a camera and a musical note 
at the top-right corner” – not on my 
version! This is the first time I’ve tried 
to follow your steps and failed.
by  R O S S  H A S T I E

ALAN SAYS… In the first method, we’ve 
overlooked a caveat for when iTunes’ 
import settings have been changed from 

their default AAC. You’ll need to adjust 
an item in iTunes’ preferences for the 
‘Create AAC Version’ command to 
appear in the contextual menu. Choose 
iTunes > Preferences, click the General 
tab, then click Import Settings. In the 
pop-up menu at the top of the next 
dialog, switch back to AAC Encoder.

GET IN TRIM
 I recently had to replace a hard drive 

in a 2011 13-inch MacBook Pro. I 
enabled TRIM in El Capitan using a 
Terminal command. My mate has 
argued that this is unnecessary. 
What’s your view?
by  S T E P H E N  L O W E

Get in touch CONTACTS

 Contact us

 Email your queries  
and your questions to 
letters@macformat.com

CHRISTIAN SAYS… Many of the latest 
SSDs actually have support for TRIM 
built into their controller. So, in theory, 
your friend may be right that you don’t 
need to enable OS X’s software version. 
But, support varies and implementations 
of TRIM can be buggy. We recommend 
doing what the manufacturer explicitly 
recommends for your particular model.

PARTING SHOT
 I purchased a 3TB Time Capsule for 

Time Machine backups. I also want to 
use its disk to store other data files. 
I intended to create a partition on the 
drive for separate storage, which would 
also restrict the size of the Time 
Machine backup. 
However, I’ve been 
unable to do this. 
Any ideas?
by  P E T E R  

S H E P P A R D

ALAN SAYS… 
Doing that isn’t 
something Apple 
supports, of course. 
A simpler solution, if 
you don’t mind modest 
extra expenditure, is to 
add a bus-powered USB 
drive to the Time 
Capsule. (If its USB port has a printer 
attached, both can be connected 
through an inexpensive powered USB 
hub.) You would retain oodles of space 
for Time Machine, and have as much 
capacity as you see fit to buy on the 
external disk to use for files.

If more than one person needs to 
store stuff, consider switching from one 
password that allows anyone access to 
the disks, to user accounts that separate 
files like OS X’s Users folder does – see 
‘Secure a connected hard disk’ in the 
AirPort Utility’s documentation.
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WORKFLOW & PHOTOS
 Fifteen months ago I wrote to you bemoaning 

Apple’s decision to introduce Photos and end 
Aperture support. Now Photos is well established 
I thought it might be helpful to share what I have 
done to replace Aperture.

My decision not to be spooked into immediate 
migration to Adobe’s Lightroom and Photoshop 
apps has turned out to be a good one; it allowed 

time for third-party developers to deliver Photos add-ons that supplement its 
rather basic management and editing features, providing a combined solution 
with most of the features that an Aperture user would expect. Affinity Photo 
seems good, but I decided to use Nikon Capture NX-D as it’s free to Nikon users 
and renders excellent JPEGs from RAW files, though it’s a bit ‘clunky’ to use.

If you are more than a snapper and less than a pro cameraman, it’s best to 
avoid any Managed Library where your photo files are stored within a database 
that is proprietary to Adobe, Apple or Serif – using a Referenced Library allows 
user access and easy migration from one app to another. Staying away from 
Managed Libraries allows choice and easy migration.
by  G E O R G E  W I L T O N

ALEX SAYS… Indeed, we were underwhelmed by Photos’ editing tools, but we’ve 
quickly come to like extensions for it and OS X in general. Regarding libraries, 
there’s a downside, for some people, of referencing external files from Photos’ 
library in that the app won’t automatically upload them to iCloud Photo Library.

 LETTER OF THE MONTH!

Have your say on all things Apple!



PHOTO STREAM Shot of the month
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MY PHOTO APPS  

CROPPING
 Geoff made sure that the 

seafront cuts through the sea 
and sky centrally. This gives 
good balance to the shot.

VIGNETTE
 To focus our attention and 

add mood, the heavy vignette 
contrasts with the strong 
sunshine on the buildings.

ATMOSPHERE 
 The vignette also helps 

accentuate the sea swell, 
adding a sense of drama 

to the overall scene.

WHY IT WORKS… 

Bright Day 
in Brighton

by  G E O F F  B U R N E T T

EQUIPMENT iPhone 6s Plus

 After some very grey days 
over the Christmas period, 

the weather forecast looked 
promising, so I decided 

that I needed a breath of  
sea air – and what better 

place than Brighton for an 
out-of-season seaside stroll? 
I love this view looking west 

from the Palace Pier. 
The contrast between the 
rain clouds, the rough sea 

and the sunlight on the 
hotels along the seafront 

creates a stunning image. 
British Airways’ i360 viewing 

platform, currently under 
construction, is a striking 

addition to the western 
end of the esplanade.  

GET INVOLVED!

 The iPhone is the world’s most popular 
camera, but it takes a bit of work to get 
a truly excellent shot. Why not show 
us your creations? Simply email us at 
photos@macformat.com and your work 
could be showcased on these pages!

PIXELMATOR 
£3.99/£22.99
 I use this popular 

app on iOS and Mac to apply a 
simple vignette effect to enhance 
the blues and greys in my photos.  
I think it makes the contrast in this 
particular image look stunning.

PHOTOS  
FREE
 I use Apple’s own 

Photos app in OS X to organise and 
store my photos in iCloud Photo 
Library. I like its clean interface 
and love having all my photos 
available on all my devices.

AFFINITY 
PHOTO 
£39.99

 I recently purchased this app 
(a MacFormat recommendation), 
but I’ve not yet delved into its 
capabilities. Maybe MacFormat’s 
tutorial series on it can help me?



Your pictures PHOTO STREAM

Stormy sky, Lyme Regis 
 Victor Carmelo Sciberras 

used Snapseed and Tonality 
Pro to get this moody look.

Ragleth Hill, Shropshire  
 Simon Whaley shot this on his 

iPhone 5s. It was featured on 
a BBC weather report too!

Dolomites, Italy
 Alan Coleman snapped this panorama during an Italian holiday in 2015. It’s unedited and was shot on an iPhone 6.

3 Perfect the vignette
Select the group again and adjust its 

opacity to your liking. Select the rounded 
rectangle’s layer and tweak its position, 
if required. In the toolbar, turn off ‘Single 
radius’ to adjust each corner individually.

2 Blend the layers
Select and group the shape layers 

(ç+G). Name the group ‘Vignette’ and 
set its blend mode to Multiply. Select the 
rounded rectangle layer, click fx below, and 
set gaussian blur between 100 and 150px.

1 Make a vignette
We’ve opened an image of Brighton in 

Affinity Photo. Whatever your image, draw 
a black rectangle over the top of it. Then, 
on top of that, draw a white rounded 
rectangle with a corner radius of 100%.

Get the look...
Learn how to get fantastic iPhone shots like the pros 

Great shots that make it into our image gallery  

 Photo album
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TIME MACHINE

The modern MacBook Pro is the epitomy of style and power in a laptop. It’s the kind of thing 
that will be displayed in the technology museums of the future, so why not give it a feeling 
of timeless charm? ColorWare’s answer is the MacBook Pro Marble, which uses a unique art 
application technique to make it appear to be chiselled from a solid block of marble rather than 
aluminium. The dark blue/black marbling pattern contrasts with the pale gray surface to give it 
a sculptural feel, and it’s topped off by a 24ct gold Apple logo for the true Apple connoisseur.
 $7,500 (about £5,150)  WEBSITE colorware.com  DIMENSIONS 1.8x35.9x24.7cm 
 SPECS 2.8GHz Intel Core i7, 16GB RAM, 1TB hard drive, Intel Iris Pro, Bluetooth 4.0

 The Marble MacBook Pro
A touch of Ancient Greece comes to Cupertino

Classic Apple kit reinvented for the modern age

Wxxxx xxxx xx xxxxxx xx xxxx xx 
xxxx xxx xxxx xxxxx xx xxxxx xx 
xxxxx xxxxxxxx xxxx xxxxxx

NEXT ISSUE ON SALE  Tuesday 15 March 2016

We’re used to the sculpted feel 
of Apple products, hence their 
prestige. But a ‘block’ of marble?
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